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Introduction

MapleSim Overview

MapleSimTM is a modeling environment for creating and simulating complex multidomain
physical systems. It allows you to build component diagrams that represent physical systems
in a graphical form. Using both symbolic and numeric approaches, MapleSim automatically
generates model equations from a component diagram and runs high-fidelity simulations.

Build Complex Multidomain Models

You can use MapleSim to build models that integrate components from various engineering
fields into a complete system. MapleSim features a library of over 300 modeling components,
including electrical, hydraulic, mechanical, and thermal devices; sensors and sources; and
signal blocks. You can also create custom components to suit your modeling and simulation
needs.

Advanced Symbolic and Numeric Capabilities

MapleSim uses the advanced symbolic and numeric capabilities of MapleTM to generate
the mathematical models that simulate the behavior of a physical system. You can, therefore,
apply simplification techniques to equations to create concise and numerically efficient
models.

Pre-built Analysis Tools and Templates

MapleSim provides various pre-built templates in the form of Maple worksheets for viewing
model equations and performing advanced analysis tasks, such as parameter optimization.
To analyze your model and present your simulation results in an interactive format, you
can use Maple features such as embedded components, plotting tools, and document creation
tools. You can also translate your models into C code and work with them in other applica-
tions and tools, including applications that allow you to perform real-time simulation.

Interactive 3-D Visualization Tools

The MapleSim 3-D visualization environment allows you to build and animate 3-D graph-
ical representations of your multibody mechanical system models. You can use this envir-
onment to validate the 3-D configuration of your model and visually analyze the behavior
of your system under different conditions and at different simulation start times.

Related Products

MapleSim 2015 requires Maple 2015.1.
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MaplesoftTM also offers a suite of toolboxes, add-ons, and other applications that extend
the capabilities of Maple and MapleSim for engineering design projects. For a complete

list of products, visit http://www.maplesoft.com/products.

Related Resources

Resource Description

System requirements and installation instructions for MapleSim.
The MapleSim Installation Guide is available in the Install.html
file on your MapleSim installation DVD.

MapleSim Installation
Guide

Provides the following information:

* MapleSim User's Guide: conceptual information about
MapleSim, an overview of MapleSim features, and tutorials
to help you get started.

MapleSim Help System |, Using MapleSim: help topics for model building, simulation,

and analysis tasks.

* MapleSim Component Library: descriptions of the modeling
components available in MapleSim.

Model examples from various engineering domains. These models
MapleSim Examples are available in the Examples palette in the Libraries tab on the
left side of the MapleSim window.

MapleSim User's Guide  |Model and Tutorial examples used in the User's Guide. These
Examples models are available in the Examples > User's Guide Examples
palette in the Libraries tab on the left side of the MapleSim
window and are listed by chapter, in the order that they appear
in the User's Guide.

Training webinars, product demonstrations, videos, sample
applications, and more.

MapleSim Online
Resources For more information, visit
http://www.maplesoft.com/products/maplesim.
A collection of sample models, custom components, and analysis
templates that you can download and use in your MapleSim
) projects.
MapleSim Model Gallery

For more information, visit

http://www.maplesoft.com/products/maplesim/modelgallery/.

For additional resources, visit http://www.maplesoft.com/site_resources.
Getting Help
To request customer support or technical support, visit http://www.maplesoft.com/support.


http://www.maplesoft.com/products
http://www.maplesoft.com/products/maplesim
http://www.maplesoft.com/products/maplesim/modelgallery/
http://www.maplesoft.com/site_resources
http://www.maplesoft.com/support

Introduction ¢ xv

Customer Feedback

Maplesoft welcomes your feedback. For comments related to the MapleSim product docu-

mentation, contact doc@maplesoft.com.
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1 Getting Started with MapleSim

In this chapter:

» Physical Modeling in MapleSim (page 1)

e The MapleSim Window (page 6)

* Basic Tutorial: Modeling an RLC Circuit and DC Motor (page 7)

1.1 Physical Modeling in MapleSim

Physical modeling, or physics-based modeling, incorporates mathematics and physical laws
to describe the behavior of an engineering component or a system of interconnected com-
ponents. Since most engineering systems have associated dynamics, the behavior is typically
defined with ordinary differential equations (ODEs).

To help you develop models quickly and easily, MapleSim provides the following features:

Topological or “Acausal” System Representation

The signal-flow approach used by traditional modeling tools requires system inputs and
outputs to be defined explicitly. In contrast, MapleSim allows you to use a topological
representation to connect interrelated components without having to consider how signals
flow between them.

Mathematical Model Formulation and Simplification

A topological representation maps readily to its mathematical representation and the sym-
bolic capability of MapleSim automates the generation of system equations.

When MapleSim formulates the system equations, several mathematical simplification tools
are applied to remove any redundant equations and multiplication by zero or one. The sim-
plification tools then combine and reduce the expressions to get a minimal set of equations
required to represent a system without losing fidelity.

Advanced Differential Algebraic Equation Solvers

Algebraic constraints are introduced in the topological approach to model definition. Prob-
lems that combine ODEs with these algebraic constraints are called Differential Algebraic
Equations (DAEs). Depending on the nature of these constraints, the complexity of the DAE
problem can vary. An index of the DAEs provides a measure of the complexity of the
problem. Complexity increases with the index of the DAEs.

The development of generalized solvers for complex DAE:s is the subject of much research
in the symbolic computation field. With Maple as its computation engine, MapleSim uses



2 1 Getting Started with MapleSim

advanced DAE solvers that incorporate leading-edge symbolic and numeric techniques for
solving high-index DAEs.

Acausal and Causal Modeling

Real engineered assemblies, such as motors and powertrains, consist of a network of inter-
acting physical components. They are commonly modeled in software by block diagrams.
The lines connecting two blocks indicate that they are coupled by physical laws. When
simulated by software, block diagrams can either be causal or acausal.

Causal Modeling

Many simulation tools are restricted to causal (or signal-flow) modeling. In these tools, a
unidirectional signal, which is essentially a time-varying number, flows into a block. The
block then performs a well-defined mathematical operation on the signal and the result
flows out of the other side. This approach is useful for modeling systems that are defined
purely by signals that flow in a single direction, such as control systems and digital filters.

— f0 [

Figure 1.1: Causal Model Block Diagram

This approach is analogous to an assignment, where a calculation is performed on a known
variable or set of variables on the right hand side and the result is assigned to another variable
on the left:

y:=f(x)
Acausal Modeling

Modeling how real physical components interact requires a different approach. In acausal
modeling, a signal from two connected blocks travels in both directions. The programming
analogy would be a simple equality statement:

y=f(x)

The signal includes information about which physical quantities (for example, energy, current,
torque, heat and mass flows) must be conserved. The blocks contain information about
which physical laws (represented by equations) they must obey and, hence, which physical
quantities must be conserved.
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f(x)

Figure 1.2: Acausal Model Block Diagram

MapleSim allows you to use both approaches. You can simulate a physical system (with
acausal modeling) together with the associated logic or control loop (with causal modeling)
in a manner that suits either task best.

Through and Across Variables

When using the acausal modeling approach, it is useful to identify the through and across
variables of the component you are modeling. In general terms, an across variable represents
the driving force in a system and a through variable represents the flow of a conserved
quantity. The through variable also establishes the flow direction for the sign convention
of the conserved quantity.

“through” 2 | | b th h"
&.@—. Component —O-i

“across”

Figure 1.3: Simple Through and Across Variable Model

For an example of sign convention and how arrow direction represents a force acting on
the model, under the Libraries tab, browse to the Examples > User's Guide Examples >
Chapter 1 menu, and then open the Constant Acceleration, Sign Convention and Arrow
Convention examples.

In the following example, in an electrical circuit, the through variable, i, is the current and
the across variable, V, is the voltage drop:

I a V" vh L

o~
| |

Figure 1.4: Simple Through and Across Variable Electrical Model
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The following table lists some examples of through and across variables for other domains:

Table 1.1: Through and Across Variable Domain Types

Domain Through Across
Electrical Current (A4) Voltage (V)
Magnetic Magnetic Flux (Wb) MMF (4)
Mechanical (translational)  |Force (V) Velocity [ m J
N
Mechanical (rotational) Torque (N.m) Angular Velocity (id ]
s

. s N

Hydraulic Flow [ — ) Pressure [—2 ]
s m

Heat flow Heat flow (W) Temperature (K)

As a simple example, the form of the governing equation for a resistor is
V=R-i

This equation, in conjunction with Kirchhoff’s conservation of current law, allows a complete
representation of a circuit.

R-ib=Vb—Vaand ib-/-ia:O

To extend this example, the following schematic diagram describes an RLC circuit, an
electrical circuit consisting of a resistor, inductor, and a capacitor connected in series:

. R=240 , L=160mH
._| +
v () C =200 uF

—_

Figure 1.5: RLC Circuit

If you wanted to model this circuit manually, it can be represented with the following
characteristic equations for the resistor, inductor, and capacitor respectively:

R'iR =V, -V
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d .
L= =)
, d
i =C Ve

By applying Kirchhoff's current law, the following conservation equations are at points a,
b, and c:

W_%:O
%—&:0
i—%=0

These equations, along with a definition of the input voltage (defined as a transient going
from O to 1 volt, 1 second after the simulation starts)

0.0 0.0<t<1.0
V =
a 1.0 t>1.0

provide enough information to define the model and solve for the voltages and currents
through the circuit.

In MapleSim, all of these calculations are performed automatically; you only need to draw
the circuit and provide the component parameters. These principles can be applied equally
to all engineering domains in MapleSim and allow you to connect components in one domain
with components in others easily.

In the Basic Tutorial: Modeling an RLC Circuit and DC Motor (page 7) section of this
chapter, you will model the RLC circuit described above and explore the capabilities of
MapleSim to mix causal models with acausal models. The following figure shows how the
RLC circuit diagram appears when it is built in MapleSim.

W
I

+
—h\." ==

-

Figure 1.6: RLC MapleSim Circuit
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For an another example of how a model can be represented using causal and acausal com-
ponents, under the Libraries tab, browse to the Examples > User's Guide Examples >
Chapter 1 menu, and then open the Double Mass Spring Damper example.

1.2 The MapleSim Window

The MapleSim window contains the following panes and components:

Main Toolbar Navigation Toolbar Model Workspace Toolbar Model Workspace
B Maplesim | - untitied1 [==]=]
File Edit Viep Tools Help
BN 5¢ Bl = & P 0@
Libraries lE‘ wles ” Main Inspector | Settings
Search: . SR R ¥ Simulation F
kexm\Oo | (P d-) 28& 4 10 s |-
a Solver Variable v
- Tyne
| P Favorites " Solver CKAS (semisiff) |~
| > Signal Blacks J . 0.000010
| P Electrical | . 0.000010
[ 10 Mechanica | ©
Plot Points [200
[ - Muttibody | S
¥ Aavanced Simulation
[ I Hydraviic | . 0 — T
[ Thermal |
Use None v
| P Magnetic | Snapshot
| I Tires |
‘_bExalees :-J 3 [ Baumgarte
* " Jacotfan  |Symbolic M
E Projection
Projegtion 50
Iteraffons
Even 100
- lteragions
o % - Nomal. v = [SRPPRPTSRTORS
Palettes Pane Console Console Toolbar Parameters Pane
Figure 1.7: MapleSim Window
Table 1.2: MapleSim Window Components
Component Description
Contains tools for running a simulation, attaching MapleSim
Main Toolbar analysis templates to your model, and performing other common

tasks.

Navigation Toolbar

Contains tools for browsing your model and subsystems
hierarchically, changing the model view, and viewing corresponding
Modelica® code.

Model Workspace Toolbar

Contains tools for laying out and selecting objects, and adding
elements such as annotations and probes.
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Component Description

The area in which you build and edit a model in a block diagram

Model Workspace .
view.

Contains expandable menus with tools that you can use to build a
model and manage your MapleSim project. This pane contains two
tabs:

» Libraries: contains palettes with sample models and
domain-specific components that you can add to models.

Palettes Pane . .
* Definitions: contains palettes of the subsystems and custom

components in your model.

* Project: contains palettes with tools to help you browse and
build a model, and manage parameter sets, probes, and documents
that you attach to a model.

Use buttons on the Console Toolbar to display the following panes:

» Help: displays the Help topic associated with a modeling
component.

* Message Console: displays progress messages indicating the
Console status of the MapleSim engine during a simulation and allows

you to clear the console using Clear Console ().

* Debugging: displays diagnostic messages as you build your
model identifying the subsystem in which the errors are located.

Contains controls for selecting and controlling the types of messages

C le Toolb
onsole foolbar shown in the console ( )'

Contains the following tabs:

* Inspector: allows you to view and edit modeling component
properties, such as names and parameter values, and specify
simulation options and probe values.

Parameters Pane  Settings: allows you to specify simulation options, such as, the
duration of the simulation and optional parameter values for the
solver, simulation engine, and 3-D Workspace.

The contents of this pane change depending on your selection in
the Model Workspace.

1.3 Basic Tutorial: Modeling an RLC Circuit and DC
Motor

This tutorial introduces you to the modeling components and basic tools in MapleSim. It
illustrates the ability to mix causal models with acausal models.
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In this tutorial, you will perform the following tasks:
Build an RLC circuit model.
Set parameter values to specify component properties.
Add probes to identify values of interest for the simulation.

1.

2.

3.

4. Simulate the RLC circuit model.

5. Modify the RLC circuit diagram to create a simple DC motor model.
6.

Simulate the DC motor model using different parameters.

For an example of the RLC Circuit model, under the Libraries tab, browse to the Examples
> User's Guide Examples > Chapter 1 menu, and then open the RLC Circuit example.
The model you build is identical to the RLC Circuit model.

Building an RLC Circuit Model

To build the RLC circuit, you add components in the Model Workspace and connect them
in a system to form a diagram. In this example, the RLC circuit model contains ground,
resistor, inductor, capacitor, and signal voltage source components from the Electrical
component library. It also contains a step input source, which is a signal generator that
drives the input voltage level in the circuit.

To build an RLC circuit:

1. In the Libraries tab at the left of the Model Workspace, click the triangle beside Elec-
trical to expand the palette. In the same way, expand the Analog menu, and then expand
the Passive submenu.
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W Electrical

W Analog

= Comman

P Transmission Lines

P Gyrators

P Cperational Amplifiers
W Passive

%ﬁ—é—
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Translaticnal
EMF

2. From the Electrical > Analog > Passive menu, drag the Ground component to the
Model Workspace.

W Electrical

W Analog

= Comman

P Transmission Lines

P Gyrators

P Cperational Amplifiers
W Passive

%ﬁ—é—

Rotational  Ground
EMF

K

Translational
EMF

o o o

oo I||—n

o o o

3. Add the remaining electrical components to the Model Workspace.

* From the Electrical > Analog > Passive> Resistors menu, add the Resistor compon-
ent.
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* From the Electrical > Analog > Passive > Inductors menu, add the Inductor com-
ponent.

* From the Electrical > Analog > Passive > Capacitors menu, add the Capacitor
component.

* From the Electrical > Analog > Sources > Voltage menu, add the Signal Voltage
component.

4. Drag the components in the arrangement shown below.

=

5. To rotate the Signal Voltage component clockwise, right-click (Control-click for
Macintosh®) the Signal Voltage component in the Model Workspace and select Rotate
Clockwise.

6. To flip the Signal Voltage component horizontally, right-click (Control-click for
Macintosh) the component again and select Flip Horizontal. Make sure that the positive
(blue) port is at the top.

7. To rotate the Capacitor component clockwise, right-click (Control-click for Macintosh)
the Capacitor icon in the Model Workspace and select Rotate Clockwise.

You can now connect the modeling components to define interactions in your system.

8. Hover your mouse pointer over the Ground component port. The port is highlighted in

green.
+1
! |

i i

9. Click the Ground input port to start the connection line.

10. Hover your mouse pointer over the negative port of the Signal Voltage component.
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X

11. Click the port once. The Ground component is connected to the Signal Voltage com-
ponent.

12. Connect the remaining components in the arrangement shown below.

|||—-

13. You can now add a source to your model. Expand the Signal Blocks palette, expand the
Sources menu and then expand the Real submenu.

14. From the palette, drag the Step source and place it to the left of the Signal Voltage
component in the Model Workspace. The step source has a specific signal flow, repres-
ented by the arrows on the connections. This flow causes the circuit to respond to the
input signal.

15. Connect the Step source to the Signal Voltage component. The complete RLC circuit
model is shown below.

D

e |—a—

-

Specifying Component Properties

To specify component properties, you can set parameter values for components in your
model.
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To specifying component properties:

1.

In the Model Workspace, click the Resistor component. The Inspector tab at the right
of the Model Workspace displays the name and parameter values of the resistor.

. In the R field, enter 24, and press Enter. The resistance changes to 24Q..

MName |E;

Type Resistor

¥ Parameters
E 24 L] hd

. Specify the following parameter values for the other components. You can specify units

for a parameter by selecting a value from the drop-down menu found beside the parameter
value field.

For the Inductor, specify an inductance of 160 mH.
For the Capacitor, specify a capacitance of 200 F.

For the Step source, specify a T value of 0.1.

Adding a Probe

To specify data values for a simulation, you can attach probes to lines or ports to the model.

In

this example, you will measure the voltage of the RLC circuit.

To add a probe:

1.
2.

In the Model Workspace Toolbar, click Attach Probe ( .2).

Hover your mouse pointer over the line that connects the Inductor and Capacitor
components. The line is highlighted.

. Click the line once. The probe appears in the Model Workspace.
. Drag the probe to an empty location on the Model Workspace, and then click the

workspace to position the probe.

. Select the probe. The probe properties appear under the Inspector tab to the right of the

Model Workspace.

. Under the Inspector tab, select the Voltage check box to include the voltage quantity

in the simulation graph.

. To display a custom name for this quantity in the Model Workspace, enter Voltage as

shown below and press Enter.



1.3 Basic Tutorial: Modeling an RLC Circuit and DC Motor « 13

Probe 1} @
Frobel
¥ Voltage Vohtage

Current i

The probe with the custom name is added to the connection line.

Probel

» Woltage

i

AN RENERENE)

For another example of how to use a probe value in a simulation, under the Libraries tab,
browse to the Examples > User's Guide Examples > Chapter 1 menu, and then open the
Sensors and Probes example.

Simulating the RLC Circuit Model

Before simulating your model, you can specify the simulation duration run time.

To simulate the RLC circuit:

1. Click the Settings tab at the top of the Parameters Pane and in the Simulation section,

set the simulation duration time (tg) to 0.5.

2. In the Advanced Simulation section, clear the Compiler check box.

3. Click Run Simulation (p ) in the Main Toolbar. MapleSim generates the system
equations and simulates the response to the step input.

When the simulation is complete, the voltage response is plotted in a graph.
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Figure 1.8: Voltage Response Plot

4. Save the model as RLC_Circuitl.msim. The probes and modified parameter values are
saved as part of the model.

Building a Simple DC Motor Model

You will now add an electromotive force (EMF) component and a mechanical inertia
component to the RLC circuit model to create a DC motor model. In this example, you will
add components to the RLC circuit model using the search feature.

To build a simple DC motor:

1. In the Libraries tab, type EMF in the Search field located above the palettes. A drop-
down list displays matches for your search results.
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Search:

EMF

Rotational EMF
H Translational EMF

. Select Rotational EMF from the drop-down list. The Rotational EMF component ap-

pears in the square beside the search field.

Search:
Rotational EMF
>
Raotational
EMF

. Drag the Rotational EMF component to the modeling workspace and place it to the

right of the Capacitor component.
In the Search field, search for Inertia.

Add the Inertia component to the Model Workspace and place it to the right of the
Rotational EMF component.

. Connect the components as shown below.

Figure 1.9: Rotational EMF

Note: To connect the positive blue port of the Rotational EMF component, click the port
once, drag your mouse pointer to the line connecting the capacitor and inductor, and then
click the line.

7.
8.

In the Model Workspace, click the Rotational EMF component.

Click the Inspector tab and in the Parameters section, set the value of the transformation

coefficient (k) to 10 %

. Click the Step component and change the value of the parameter, Ty, to 1.



16 + 1 Getting Started with MapleSim

Simulating the DC Motor Model

To simulate the DC motor:
1. In the Model Workspace, delete Probel.
2. In the Model Workspace Toolbar, click Attach Probe ( 2).

3. Hover your mouse pointer over the line that connects the Rotational EMF and Inertia
components.

4. Click the line, and then click on an empty area of the workspace to position the probe.

5. Select the probe, and in the Inspector tab, select the Speed and Torque check boxes
and clear the Angle check box. The probe, with an arrow indicating the direction of the
conserved quantity flow, is added to the model. The direction of the conserved quantity
flow (Torque) can be reversed by selecting the probe and then clicking on Reverse Probe
(@) in the Inspector tab.

6. Rename the probe Output.
7. Click a blank area in the Model Workspace.

o]

. In the Settings tab, set the simulation duration time (tg) to 5.

9. Click Run Simulation () in the Main Toolbar. The following graphs appear.

Probe Plots = (i
f «N- Qe U mm
Output.Speed Output.Torque
0.10 T T
/
0.08 £ 03 ||
B [ E |
20.06 { g ‘
v ‘ 202 !
=} || g \
;2:1).[)4 f E \
]l ~ol y
0.02 \
| N
0 J 0 AN
0 1 2 3 4 5 0 1 2 3 4 5
t t

Figure 1.10: Plots of DC Motor Torque and Speed

10. Save the model as DC_Motor1.msim.



2 Building a Model

In this chapter:

The MapleSim Component Library (page 17)

Browsing a Model (page 18)

Defining How Components Interact in a System (page 23)
Specifying Component Properties (page 24)

Creating and Managing Subsystems (page 27)

Global and Subsystem Parameters (page 40)

Attaching Files to a Model (page 54)

Creating and Managing Custom Libraries (page 54)
Annotating a Model (page 57)

Entering Text in 2-D Math Notation (page 59)

Creating a Data Set for an Interpolation Table Component (page 61)
Best Practices: Building a Model (page 62)

2.1 The MapleSim Component Library

The MapleSim component library contains over 500 components that you can use to build
models. All of these components are organized in palettes according to their respective do-
mains: electrical, magnetic, hydraulic, 1-D mechanical, multibody, signal blocks, and
thermal. Most of these components are based on the Modelica Standard Library 3.2.1.

Table 2.1: MapleSim Component Library

Library Description
Signal Blocks Components to manipulate or generate input and output signals.
. Components to model electrical analog circuits, single-phase

Electrical . . .
and multiphase systems, and electric machines.

1-D Mechanical Components to model 1-D translational and rotational systems.

Multibody Compgnents to modf:l multlbg@y mechanical systems,
including force, motion, and joint components.

Hydraulic Component; to model hydraulic systems such as fluid power
systems, cylinders, and actuators.

Thermal Components to model heat flow and heat transfer.

Magnetic Components to model magnetic circuits.

17
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The library also contains sample models that you can view and simulate, for example,
complete electrical circuits and filters. For more information about the MapleSim library
structure and modeling components, see the MapleSim Component Library in the
MapleSim Help system.

To extend the default library, you can create a custom modeling component from a mathem-
atical model and add it to a custom library. For more information, see Creating Custom
Modeling Components (page 69).

Viewing Help Topics for Components

In the Help pane below the Model Workspace, you can view the Help topic for each

component from the MapleSim Component Library. To display the Help pane, click Com-
ponent Help (_ 2) at the bottom of the MapleSim window. You can then select a component
that you have added to the Model Workspace to view its Help topic. Alternatively, to view
Help topics in a separate Help system window, you can perform one of the following tasks:

» Right-click (Control-click for Macintosh) a modeling component in any of the palettes
and select Help from the context menu.

* Search for the help pages for components in the MapleSim Help system.

Updating Models Created in MapleSim 7 or Earlier

In MapleSim 7 or earlier, components from the Modelica Standard Library 3.1 were included
in the MapleSim Component Library. In MapleSim 2015, the Modelica Standard Library
3.1 was replaced with the Modelica Standard Library 3.2.1.

If you created a model in MapleSim 7 or earlier, you can open it in MapleSim 2015 or later.
The model will be updated automatically to use equivalent components from the Modelica
Standard Library 3.2.1. For more information, see Using MapleSim > Updating Models

Created in a Previous Release of MapleSim in the MapleSim Help system.

Note: Models that contain components from the Modelica Standard Library 3.2.1 cannot
be used in MapleSim 7 or earlier.

2.2 Browsing a Model

Using the Model Tree palette or model navigation controls, you can browse your model to
view hierarchical levels of components in the Model Workspace. You can browse to the
top level for an overall view of your system. The top level is the highest level of your
model: it represents the complete system, which can include individual modeling components
and subsystem blocks that represent groups of components. You can also browse to sublevels
in your model to view the contents of individual subsystems or components.
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Model Tree

The Model Tree palette is found under the Project tab of the Palettes Pane. Use the Model
Tree palette to browse through and optionally search for elements in your model. Nodes in
the model tree can represent components, ports, attachments, parameter blocks, or probes,
depending on the model tree view. To change the model tree view, select a view from the
list below the Find text box. The following figure shows the Components view for the 5
DoF Robot multibody example model.

W Model Tree

Find: D

iComponents - |

Main

¥ Base (Body)
-Effector (Link4)
-Linkage?2 (Link1)
-Linkage3 (Link2)
-Linkage4 (Link3)
i parameters (Parameters)
~R2 (Ramp)

~R3 (Ramp)

~R4 (Ramp)

~R6& (Revolute)
~R7 (Ramp)

~R8 (Revolute)
~R15 (Revolute)
~R16 (Revolute)
~51 (5ine)
~Servol (Servo)
~Servo? (Servo)
~Servo3 (Servo)
~Servod (Servo)
~Servo5 (Servo)
~T1 (Path Trace)

~E-8-E-E-

R RR R Nl R NN Rk Rl

Figure 2.1: Components view in the Model Tree

The following are of the model tree views you can select from.

» Attachments: This view shows all the components and subsystems that have a document
attached to them. Examples of attachments include worksheets, spreadsheets, and CAD
drawings. Expand a component node to see its attachment. Double-click the attachment
to open the attachment in the appropriate program. Enter a term in Find to search for
either documents or component names that match your term.

» Component Types: This view organizes the model tree view according to the type of
component or subsystem. Component and subsystem nodes are identified by their type
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followed by their name. Enter a term in Find to search for component types that match
your term (the component's name is ignored in the search).

» Components: This view organizes the model tree view according to the Name of each
component or subsystem. Component and subsystem nodes are identified by their name
followed by their type (see Figure 2.1). Enter a term in Find to search for component
and subsystem names that match your term (the component type is ignored in the search).
This is the default model tree view.

* Parameters: This view shows all the components that have parameter definitions (along
with the parameters). Parameter definitions can come from parameter tables, parameter
blocks, Modelica Records, or To Variable components. Enter a term in Find to search
for parameters and component names that match your term. For more information about
the parameters view (including how to find all references to a parameter), see Using
MapleSim > Building a Model > Managing Large Models > Parameters View in the
MapleSim Help system.

* Probes: This view shows all the probes in your model. The full path to the probe is given
in brackets after the name of the probe. Enter a term in Find to search for probes with
names that match your term.

To view the parameters associated with a component or subsystem, navigate the model tree
to the component node and then select the node. This highlights the element in the Model
Workspace, changes the Model Workspace view to display the element, and populates
the Inspector tab with the configurable parameters for that element. See Figure 2.2 for an
illustration of component selection.
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Figure 2.2: Component selection using the Model Tree

If you select more than one component from the model tree, the Inspector tab displays all
the common configurable parameters for the components. If you change a parameter in the
Inspector tab, this updates the parameter for all of the selected components.

To explore a component or subsystem, you can either double-click the node in the model
tree or expand the node and then select one of its children. The Model Workspace view
changes to the appropriate level to explore the component or subsystem.
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Figure 2.3: Exploring a subsystem

For more information on the Model Tree palette and how to manage complex models, see
the Using MapleSim > Building a Model > Navigating and Searching with the Model
Tree section of the MapleSim Help system.

Model Navigation Controls

Alternatively, you can use the model navigation controls located above the Model Work-
space Toolbar to browse between modeling components, subsystems, and hierarchical
levels in a diagram displayed in the Model Workspace.

Main ™ Effector ™ ' =
.

0 R & -

Figure 2.4: Model Navigational Controls
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From the drop-down menu, select the name of the subsystem or modeling component that

you want to view in the Model Workspace. You can click Main (Main ®) to browse to
the top level of your model. You can also browse directly to subsystems in your model. For
example, by clicking Effector in the example shown above, you can view the Link4 subsys-
tem contents in the Model Workspace.

2.3 Defining How Components Interact in a System

To define interactions between modeling components, you connect them in a system. In the
Model Workspace, you can draw a connection line between two connection ports.

You can also draw a connection line between a port and another connection line.

—]

MapleSim permits connections between compatible domains only. By default, each line
type appears in a domain-specific color.

Table 2.2: Domain-Specific Connection Line Colors

Domain Line Color
Mechanical 1-D rotational Black
Mechanical 1-D translational Green
Mechanical multibody Black
Electrical analog Blue
Electrical multiphase Blue
Magnetic Orange
Digital logic Purple
Boolean signal Pink
Causal signal Navy blue
Integer signal Orange
Thermal Red
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The connection ports for each domain are also displayed in specific colors and shapes. For
more information about connection ports, see the MapleSim Component Library > Con-
nectors Overview in the MapleSim Help system.

Components can have either scalar or vector connection ports. A scalar port has only one
quantity associated with it while a vector port can have more than one quantity associated
with it. Connections can be made between two scalar ports or between two vector ports
having the same dimension. To make a connection between a vector port and a scalar port,
you will need to use an intervening component that can convert a vector input/output to a
scalar output/input. For more information, see Using MapleSim > Building a Model >
Connecting Vector and Scalar Components in the MapleSim Help system.

2.4 Specifying Component Properties

To specify component properties, you can set parameter values for components in your
model. When you select a component in the Model Workspace, the configurable parameter
values for that component appear in the Inspector tab located on the right side of the
MapleSim window.

Note: Not all components provide editable parameter values.

You enter parameter values in 2-D math notation, which is a formatting option that allows
you to add mathematical text such as superscripts, subscripts, and Greek characters. For
more information, see Entering Text in 2-D Math Notation (page 59).

Note: Most parameters in the MapleSim Component Library have default values. However,
for some parameters, these default values are simply placeholders that may not represent
realistic values for use in a simulation. These placeholder values use a blue font to distinguish
them from other parameter values. You should replace these values with values that are
more suitable for your simulation. For more information, see Using MapleSim > Building
a Model > Specifying Parameters in the MapleSim Help system.

Specifying Parameter Units

You can use the drop-down menus beside parameter fields with dimensions to specify units
for parameter values. For example, the image below displays the configurable parameter
fields for a Mass component. You can optionally specify the mass in kg, /b,,, g, or slug,

and the length in m, cm, mm, ft, or in.

MName Aass of the sliding mass
Type Mass

¥ Parameters
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When you simulate a model, MapleSim automatically converts all parameter units to the
International System of Units (SI). You can, therefore, select more than one system of units
for parameter values throughout a model.

If you want to convert the units of a signal, use the Unit Conversion Block component
from the Signal Converters menu in the Signal Blocks palette. This component allows
you to perform conversions in dimensions such as time, temperature, velocity, pressure,
and volume. In the following example, a Unit Conversion Block component is connected
between a translational Position Sensor and Feedback component to convert the units of
an output signal.

Feedback
S
T o

Step source FID zantraller

H

Unit Conversion Block Fosition Sengar

Figure 2.5: Specifying Units using the Unit Conversion Block

If you include an electrical, 1-D mechanical, hydraulic, or thermal sensor in your model,
you can also select the units in which to generate an output signal.

Specifying Initial Conditions

You can set parameter values to specify initial conditions for components from all domains
in MapleSim. When you select a component that contains state variables in the Model
Workspace, the available initial condition fields appear in the Inspector tab, along with
the other configurable parameter values for that component.
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For example, the image below displays the initial velocity, position, and acceleration fields
that you can set for a Mass component.
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Figure 2.6: Initial Conditions

Specifying How Initial Conditions are Enforced

You can determine how the initial conditions that you specified for a particular component

are enforced. The options are ignore (=), guess ('), and enforce (i;}). You can select
these options for initial condition parameters individually by clicking the buttons beside
the applicable initial condition fields.

If you select the ignore option, the parameter value that you enter in the initial condition
field is ignored and the solver uses a default value for the initial condition, typically zero.
This option is the default setting for all of the initial condition fields.

If you select the guess option, the solver treats the parameter value you entered in the initial
condition field as a best guess value. In other words, the best guess value is a starting point
for determining the initial configuration of the system for which there is a solution to the
set of equations that describe the system. The solver initially computes a solution to the
system of equations using this best guess value; however, if no solution is found, the solver
computes a solution to the system of equations using an initial condition value that is close
to the best guess value.

If you select the enforce option, the solver uses the parameter value that you enter in the
initial condition field as a start value for the simulation. Similar to the guess option, the
solver searches for a solution to the system of equations using the parameter value you
entered in the initial condition field. However, unlike the guess option, if there is no solution,
no other value is substituted, and an error message appears.
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For more information about selecting these options, see Best Practices: Enforcing Initial
Conditions (page 68).

For an example of how initial conditions are enforced, under the Libraries tab, browse to
the Examples > User's Guide Examples > Chapter 2 menu, and then open the Relative
Positions example.

2.5 Creating and Managing Subsystems

A subsystem (or compound component) is a set of modeling components that are grouped
in a single block component. A simple DC motor subsystem is shown below.

T =

oc Motoq

Figure 2.7: Subsystem Group

You can create a subsystem to group components that form a complete system, for example,
a tire or DC motor. You can also create a subsystem to improve the layout of a diagram in
the Model Workspace, add multiple copies of a system to a model, analyze a component
group in Maple or to quickly assign parameters and variables. You can organize your
model hierarchically by creating subsystems within other subsystems.

After you create a subsystem you will be able to assign parameters and variables to all
components in that subsystem using the Advanced Parameter Settings and Advanced
Variable Settings tools in the Inspector tab.

Inspector | Settings

Name | DC Motor

Type DC Motor

Advanced Parameter Settings

Advanced Variable Settings

For best practices on creating subsystems in MapleSim, see Best Practices: Laying Out and
Creating Subsystems (page 62).

Example: Creating a Subsystem

In the following example, you will group the electrical components of a DC motor model
into a subsystem.
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To create a subsystem

1.

Under the Libraries tab on the left side of the MapleSim window, expand the Examples
> User's Guide Examples > Chapter 2 menu, and then open the Simple DC Motor
example.

. Using the Selection Tool ( k ) located above the Model Workspace, draw a box around

the electrical components.
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Figure 2.8: Creating a Subsystem

. From the Edit menu, select Create Subsystem (or right-click the boxed area and select

Create Subsystem).

. In the dialog box, enter DC Motor.
. Click OK. A white block, which represents the DC motor, appears in the Model

Workspace.
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DC Motor

In this example, you created a standalone subsystem, which can be edited and manipulated
independently of other subsystems in your model. If you want to add multiple copies of the
same subsystem to your model and edit those subsystems as a group, you can create a sub-
system definition. For more information, see Adding Multiple Copies of a Subsystem to a
Model (page 29).
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Viewing the Contents of a Subsystem

To view the contents of a subsystem, double-click the subsystem icon in the Model
Workspace. The detailed view of a subsystem appears.

|||—|

In this view, a broken line indicates the subsystem boundary. You can edit the connection
lines and components within the boundary, add and connect components outside of the
boundary, and add subsystem ports to connect the subsystem to other components. If you
want to resize the boundary, click the broken line and drag one of the sizing handles displayed
around the box.

To browse to the top level of the model or to other subsystems, use the controls in the
Navigation Toolbar.

Main = DC Motar > v

Adding Multiple Copies of a Subsystem to a Model

If you plan to add multiple copies of a subsystem to a model and want all of the copies to

have the same configuration, you can create a subsystem definition. A subsystem definition
is the base subsystem that defines the attributes and configuration that you want a series of
subsystems to share.
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For example, if you want to add three DC motor subsystems that all have identical compon-
ents and resistance values in your model, you would perform the following tasks:

1. Build a DC motor subsystem with the desired configuration in the Model Workspace.

2. Use that subsystem configuration to create a subsystem definition and add it to the
Definitions tab.

3. Add copies of the DC motor subsystem to your model using the subsystem definition as
a source.

To add copies of the DC motor subsystem to your model, you can drag the DC Motor sub-
system definition icon from the Definitions tab and place it in the Model Workspace. The
copies that you add to the Model Workspace will then share a configuration that is
identical to the subsystem definition in the Definitions tab; the copies in the Model
Workspace are called shared subsystems because they share and refer to the configuration
specified in their corresponding subsystem definition.

Definitions SimpleDC_Mator €3 ||
Search: [:] IE‘ [ RS ||
" < T\ [O
W Components
\ ot B
DC Maotor r
=" DC Motor,
ot ot < Shared
. Subsystem
=" DC Motor, /
Wt il
[
=" DC Motor,

Figure 2.9: Creating Multiple Subsystems

Shared subsystems that are copied from the same subsystem definition are linked, which
means that changes you make to one shared subsystem will be reflected in all of the other
shared subsystems that were created from the same subsystem definition. The changes are
also reflected in the subsystem definition entry in the Definitions tab. A shared subsystem
is indicated on the model workspace by the icon [_].

Using the example shown above, if you change the resistance parameter of the Resistor
component in the DC Motor, shared subsystem from 240 to 100, the resistance value of
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the Resistor component in the DC Motor; and DC Motorj shared subsystems and the DC
Motor subsystem definition in the Definitions tab will also be changed to 104Q..

For more information, see Editing Subsystem Definitions and Shared Subsystems (page 32).

Example: Adding Subsystem Definitions and Shared Subsystems to a Model

In the following example, you will create a DC Motor subsystem definition and add multiple
shared subsystems to your model.

Adding a Subsystem Definition to the Definitions Tab

To add a subsystem definition

1. In the Model Workspace, right-click (Control-click for Macintosh) the standalone DC
motor subsystem that you created in Example: Creating a Subsystem (page 27).

2. From the context menu, select Convert to Shared Subsystem.
3. Enter DC Motor as the name for the subsystem definition and click OK.

4. Under the Definitions tab on the left side of the Model Workspace, expand the Com-
ponents palette.

Definitions | Project

Search:

W Components

t

DC Motor

Figure 2.10: Subsystem Definition

The subsystem definition is added to the Components palette and the subsystem in the
Model Workspace is converted into a shared subsystem called DC Motor,. This shared

subsystem is linked to the DC Motor subsystem definition.
5. Save this model as DCMotorSubsystem.msim. You will be building on this model in

Example: Editing Shared Subsystems that are Linked to the Same Subsystem
Definition (page 32).

You can now use this subsystem definition to add multiple DC motor shared subsystems
to your MapleSim model.
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Tip: If you want to use a subsystem definition in another model, add the subsystem definition
to a custom library. For more information, see Creating and Managing Custom
Libraries (page 54).

Adding Multiple DC Motor Shared Subsystems to a Model

To add multiple DC Motor shared subsystems to a model, drag the DC Motor subsystem
definition icon from the Definitions tab and place it in the Model Workspace.
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Figure 2.11: Adding Multiple Subsystems to a Model

When you create a new standalone subsystem or add shared subsystems to a model, a unique
subscript number is appended to the subsystem name displayed in the Model Workspace.
As shown in the image above, subscript numbers are appended to the names of each DC
Motor shared subsystem. These numbers can help you to identify multiple subsystem copies
in your model.

Editing Subsystem Definitions and Shared Subsystems

If you edit a shared subsystem in the Model Workspace, your changes will be reflected in
the subsystem definition that is linked to the shared subsystem, as well as other shared
subsystems that were copied from the same subsystem definition.

Example: Editing Shared Subsystems that are Linked to the Same Subsystem
Definition

In this example, you will create a model that contains two DC Motor shared subsystems,
and then edit the resistance values and icons for the shared subsystems. These shared sub-
systems are linked to the DC Motor shared subsystem definition that was created in Example:
Adding Subsystem Definitions and Shared Subsystems to a Model (page 31). You will
verify that when you change one of the component values and the icon for one DC Motor
shared subsystem, the other DC Motor shared subsystems in your model--as well as any
new DC Motor shared subsystems that you add in the future--will contain the changes.
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Note: Before doing this example, you should have already gone through and stored the
results from Example: Adding Subsystem Definitions and Shared Subsystems to a
Model (page 31).

To use shared subsystems:

1. In MapleSim, open the DCMotorSubsystem.msim file that you created in Example:
Adding Subsystem Definitions and Shared Subsystems to a Model (page 31).

2. Under the Definitions tab, expand the Components palette, and then drag a second DC
Motor shared subsystem on to the workspace, placing it below the existing DC Motor
shared subsystem.

3. Under the Libraries tab, expand the 1-D Mechanical > Rotational > Common menu,
and then drag a second Inertia component on to the workspace, placing it below the
existing Inertia component.

4. Make the following connections between the newly added components and the existing
components in the model.
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5. In the Model Workspace, double-click the DC Motor, shared subsystem. The detailed
view of the shared subsystem appears.
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Figure 2.12: DC Motor Subsystem

Note that a heading with the subsystem definition name (DC Motor) followed by the shared
subsystem name (DC Motor,) appears at the top of the Model Workspace. In the detailed

view of all shared subsystems, this heading also appears to help you identify multiple sub-
system copies in your model. Also, when you select a shared subsystem, its subsystem
definition name appears in the Type field in the Inspector tab.

Inspeckor | Settings | Plaks

Name |DC Motor

Type DC Motor

6. Select the Resistor component (R;) and, in the Inspector tab, click Parameters. Change
the resistance value to 50€.

Inspector | Settings | Piats
Name R,

Type Resistor
¥ Parameters
R 50 Q b

7. In the Navigation Toolbar, click Icon ().

8. Using the Rectangle Tool ([]) in the Model Workspace Toolbar, click and drag your
mouse pointer to draw a shape in the box.
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» uf b1o

9. In the Navigation Toolbar, click Diagram (*2)).

10. Click Main in the Navigation Toolbar to browse to the top level of the model. Both of
the DC Motor shared subsystems now display the square that you drew.
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11. In the Definitions tab on the left side of the MapleSim window, expand the Components
palette. As shown in the image below, your changes are also reflected in the DC Motor
entry in this palette.

W Components

| DC Motor |

If you double-click the DC Motor subsystems in the Model Workspace and select their
Resistor components, you will see that both of the shared subsystems now have a resistance
value of 500.

12. From the Definitions tab, drag a new copy of the DC Motor subsystem and place it
anywhere in the Model Workspace. Verify that the new copy displays the square that
you drew and its resistance value is also 5092, and then delete it from the workspace.
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13. Save this model as DCMotorSharedSubsystem.msim. You will be building on this
model in Example: Removing the Link Between a Shared Subsystem and its Subsystem
Definition (page 36).

Example: Removing the Link Between a Shared Subsystem and its Subsystem
Definition

If your model contains multiple shared subsystems that are linked and you want to edit one
copy only, you can remove the link between a shared subsystem and its subsystem definition,
and edit that subsystem without affecting others in the Model Workspace.

Note: Before doing this example, you should have already gone through and stored the
results from Example: Editing Shared Subsystems that are Linked to the Same Subsystem
Definition (page 32) and saved the results from that example.

To remove shared subsystem link:

1. Open the DCMotorSharedSubsystem.msim model that you created in Example: Editing
Shared Subsystems that are Linked to the Same Subsystem Definition (page 32).

2. In the Model Workspace, right-click (Control-click for Macintosh) the DC Motor,
shared subsystem.

3. Select Convert to Standalone Subsystem. The DC Motor, subsystem is no longer

linked to the DC Motor subsystem definition in the Definitions tab; it is now called
copy of DC Motor,.

4. Double-click the DC Motor; shared subsystem.
5. Click Icon ().

6. Using the Rectangle Tool (), click and drag your mouse pointer to draw a shape in
the box in the Model Workspace.

7. Click Diagram (=2)), and then click Main to browse to the top level of the model. Your
change is shown in the DC Motor, shared subsystem in the Model Workspace and the
DC Motor subsystem definition in the Definitions tab. Note that your change is not
shown in the copy of DC Motor, subsystem that is no longer linked to the DC Motor
subsystem definition.

Tip: When you convert a shared subsystem to a standalone subsystem, it is a good practice
to assign the standalone subsystem a meaningful name that clearly distinguishes it from
existing shared subsystems and subsystem definitions.
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Working with Standalone Subsystems

Standalone subsystems are subsystems that are not linked to a subsystem definition. You
can create a standalone subsystem in two ways: by creating a new subsystem as shown in
Example: Creating a Subsystem (page 27) or by converting a shared subsystem to a stan-
dalone subsystem as shown in Example: Removing the Link Between a Shared Subsystem
and its Subsystem Definition (page 36). Standalone subsystems can be edited independently
without affecting other subsystems in the Model Workspace.

To identify a subsystem as a standalone subsystem, select a subsystem in the Model
Workspace and examine the Inspector tab. If that subsystem is a standalone subsystem,
the Type field reads Standalone Subsystem.

Inspector | Settings

Name |DCMa!ar1

Type Standalone Subsystem

Advanced Parameter Settings

Advanced Variable Settings

Standalone subsystems will not show the shared subsystem icon ([_]) on the Model
Workspace. Also, if you double-click a standalone subsystem to browse to its detailed
view, no heading is shown for the subsystem in the Model Workspace.

When you copy and paste a standalone subsystem in the Model Workspace, you can op-
tionally convert that subsystem into a shared subsystem and create a new subsystem defin-
ition. For more information, see Example: Copying and Pasting a Standalone

Subsystem (page 38).

Example: Resolving Warning Messages in the Debugging Console

When you convert a shared subsystem into a standalone subsystem, the subsystem is high-
lighted in the Model Workspace and a warning message appears, informing you that the
link to the subsystem definition has been removed.

Note: This example is an extension of Example: Removing the Link Between a Shared
Subsystem and its Subsystem Definition (page 36).

To resolve a warning message

1. Click Diagnostic Information () at the bottom of the MapleSim window to display
the debugging console. The following warning message appears in the console.



38 « 2 Building a Model

Description Location

6 The stand-alone subsystem "copy of DC Motorl" is identical to the shared subswstem "D Motor", Main

2. To work with the copy of DC Motor; subsystem as a standalone subsystem, right-click

(Control-click for Macintosh) the warning message and select Ignore duplication
warnings for “copy for DC Motor1” to hide the warning message from the debugging
console.

Tip: If you want to view warning messages that you hid from the debugging console, click
Reset Ignored Warnings ((® ) below the console. All of the warning messages that you
previously hid will appear in the debugging console again.

Alternatively, if you want to link the copy of DC Motor; standalone subsystem to the DC
Motor subsystem definition again, you can right-click (Control-click for Macintosh) the
warning message and select Update “copy of DC Motor1” to use the shared subsystem
“DC Motor”.

Example: Copying and Pasting a Standalone Subsystem

Note: This example is an extension of Example: Removing the Link Between a Shared
Subsystem and its Subsystem Definition (page 36).

To copy and paste a standalone subsystem:

1. In the Model Workspace, copy and paste the copy of DC Motor, standalone subsystem.
A dialog box appears. (See Figure 2.13.)

2. Select Convert the above stand-alone subsystem to a shared subsystem (Recommen-
ded). A new subsystem definition called DC Motor 1 is added to the Definitions tab.
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Maple5im | 23 |

copy of DC Motor 1

The component listed above is defined as a stand-alone subsystem,
Pasting this subsystem wil create a new stand-alone subsystem with
identical content, Modifications to a stand-alone subsystem does not
affect other subsystems.

& shared subsystem references a subsystem definition. Modifying the
shared subsystem affects all subsystems sharing the definition.

You can convert between a stand-alone and a shared subsystem at
any time.

= Convert the above stand-alone subsystem to a shared
=~ subsystemn (Recommended)

= Replicate the above stand-alone subsystem as a new
-~ stand-alone subsystem

QK ] ’ Cancel

Figure 2.13: Copy Subsystem Dialog

In the Model Workspace, the copy of DC Motor; standalone subsystem has been converted
to a shared subsystem called copy of DC Motor; and another copy of that shared subsystem
called copy of DC Motor, has been added to the Model Workspace. Both the copy of DC
Motor; and copy of DC Motor, shared subsystems are linked to the new DC Motor 1
subsystem definition. Therefore, if you edit either copy of DC Motor; or copy of DC
Motor, in the Model Workspace, your changes will not be reflected in subsystems that
are linked to the original DC Motor subsystem definition.

Note: Alternatively, you can select Replicate the above stand-alone subsystem as a new
stand-alone subsystem to add another standalone subsystem that can be edited independently
without affecting the other subsystems in the Model Workspace.
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2.6 Global and Subsystem Parameters

MapleSim lets you define global and subsystem parameter values, and assign them to
components using the Add or Change Parameters editor, parameter blocks, parameter
sets, and the Advanced Parameter Settings and Advanced Variable Settings in the In-
spector tab.

Global Parameters

If your model contains multiple components that share a common parameter value, you can
create a global parameter. A global parameter allows you to define a common parameter
value in one location and then assign that common value to multiple components in your
model.

The following example describes how to define and assign a global parameter. To view a
more detailed example, see Tutorial 1: Modeling a DC Motor with a Gearbox (page 151)
in Chapter 6 of this guide.

Example: Defining and Assigning a Global Parameter

If your model contains multiple Resistor components that have a common resistance value,
you can define a global parameter for the resistance value in the parameter editor view.

To define and assign a global parameter:

1. In the Libraries tab, expand the Electrical palette, expand the Analog menu, expand
the Passive menu, and then expand the Resistors menu.

2. From the palette, drag three copies of the Resistor component into the Model Workspace.

3. In the Navigation Toolbar, click Parameters (F#)), or click the workspace and from the
Inspector tab, click Add or Change Parameters. The Main subsystem default settings
screen appears. You will use this screen to define the global parameter and assign it to
the Resistor components in your model.

Main subsystem default settings

Name Type Default Value Default Units Description
Subsystem Composition
R, component
MName Type Value Units Description

R Resistance Q ¥ | Resistance a temperature T_ref
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Ry component
Name Type Value Units Description
R Resistance Q ~ Resistance a temperature T_ref
Ry component
Mame Type Value Units Description
R Resistance Q ¥ Resistance a temperature T_ref

4. Click the first field under the Name column in the Main subsystem default settings
table.

5. Enter GlobalResistance as the global parameter name and press Enter.
6. Select Resistance[[ Q ]] and specify a default value of 2.

7. Enter Global resistance variable as the description and press Enter.

Main subsystem default settings
Name Type Default Value Default Units Description

GlobalResistance Resistance [0 ] w2 o] v Global resistance variable

The global parameter for the resistance value is now defined. You can now assign the

common GlobalResistance parameter value to the individual Resistor components that

you added to the Model Workspace.

8. In the R; component table and R, component table, enter GlobalResistance as the
resistance value.

R, component
Name Type Value Units Description
R Resistance GlobalResisiance o Resistance at temperature T_ref
R, component
Name Type Value Units Description
R Resistance GlobaiResistance a Resistance at temperature T_ref
Ry component
Name Type Value Units Description
R Resistance Q ¥ Resistance a temperature T_ref

The resistance value of the parameter GlobalResistance (2, as defined in the Main subsys-
tem default settings table) has now been assigned to the resistance parameters of the Ry

and R, components.

The R, and R, components will now inherit any changes made to the GlobalResistance

parameter value in the Main subsystem default settings table. For example, if you change
the default value of the GlobalResistance parameter to 5 in the Main subsystem default
settings table, the resistance parameters of the R; and R, components will also be changed
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to 5. Any change to the GlobalResistance parameter value will not apply to the R; compon-
ent because it has not been assigned GlobalResistance as a parameter value.

Subsystem Parameters

You can create a subsystem parameter if you want to create a common parameter value to
share with multiple components in a subsystem. Similar to global parameters, a subsystem
parameter is a common value that you define in the parameter editor view and assign to
components.

There are two ways to assign subsystem parameters; one is by clicking Parameters (%))
and the other is by using the Advanced Parameter Settings tool in the Inspector tab.
Parameters can only be assigned to components in the subsystem in which they are defined.
If you click a subsystem in the Model Workspace, click Parameters (%)) or Advanced
Parameter Settings, and define a parameter in the parameter editor view, the parameter
that you define is assigned to components in the subsystem that you selected and any nested
subsystems.

To view an example, see Tutorial 3: Modeling a Nonlinear Damper (page 161) in Chapter
6 of this guide.

Note: If you create a parameter within a subsystem and assign its value to a component at
the top level, the component at the top level will not inherit the parameter value.

Example: Assigning a Subsystem Parameter to a Shared Subsystem

If you assign a subsystem parameter to a shared subsystem in your model, the default sub-
system parameter will also be assigned to other shared subsystems that are linked to it.
However, after the default subsystem parameter is assigned, you can edit the subsystem
parameter value for each shared subsystem separately without affecting other parameter
values in the model.

To assign a subsystem parameter to a shared subsystem

1. In the Examples palette, expand the Physical Domains > Multibody menu, and then
open the Double Pendulum model. This model contains two shared subsystems, L; and

L,, which are linked to a subsystem definition called L.
2. Double-click the L; shared subsystem.

3. Click Parameters ([-%)).

4. In the L subsystem default settings table, click the empty field at the bottom of the
table.

5. Type ¢ as the parameter name, keep the default value as 1, and press Enter.
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6. Click Diagram (=2/). The new subsystem parameter, ¢, appears in the Inspector tab for
the L; shared subsystem.

7. In the top view of the model, select the L, subsystem and examine the Inspector tab.
The new subsystem parameter is also displayed for the L, shared subsystem.

8. In the Inspector tab, change the value of ¢ to 50.

9. Click the L; shared subsystem in the Model Workspace and examine the Inspector
tab. Note that the value of its parameter, ¢, remains the same.

Creating Parameter Blocks

As an alternative to defining subsystem parameters using the methods described above, you
can create a parameter block to define a set of subsystem parameters and assign them to
components in your model. Parameter blocks allow you to apply parameters in multiple
models at the top level of the Model Workspace.

The following image shows a parameter block that has been added to the Model Workspace.

When you double-click this block, the parameter editor view appears. This view allows you
to define parameter values for the block.

Parameters subsysiem default settings
Name Type Default Value Default Units Descripticn

After defining parameter values, you can assign those values to the component parameters
in your model.

To use parameter values in another model, you can add a parameter block to a custom library.
For more information about custom libraries, see Creating and Managing Custom
Libraries (page 54).

Notes:

» Parameter blocks must be placed in the same subsystem as the components to which you
want to assign the parameter value.

» Parameter blocks at the same hierarchical level in a model cannot have the same parameter
names. For example, two separate parameter blocks in the same subsystem cannot each
contain a parameter called mass.
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Example: Creating and Using a Parameter Block

In this example, you will create a set of parameters that can be shared by multiple components
in your model. By creating a parameter block, you only need to edit parameter values in
one location to compare results when you run multiple simulations.

To create and use a parameter block:

1. In the Libraries tab on the left side of the MapleSim window, expand the Examples
palette, expand the Physical Domains menu, expand the 1-D Mechanical menu, and
then open the PreLoad example.

2. Under the Settings tab, enter 0.012 seconds for ty, the simulation duration time.

3. Click the SM; Mass component on the workspace, and then click the Inspector tab. You
will be using a parameter block to set values for the following parameters: m, L, s(, and
Vo-

4. From the Model Workspace Toolbar, click Add a parameter block ( 2 ), and then
click on a blank area in the Model Workspace.

5. Click the Inspector tab and enter the name SlidingMassParams for the parameter block.

6. Double-click the SlidingMassParams parameter block in the Model Workspace. The
parameter editor view appears.

Parameters subsystem default settings

Mame Type Default Value Default Units Description

7. Click the first field in the table and define a new symbolic parameter called MASS.
8. Press Enter. The remaining fields for this row are activated.

9. From the Type drop-down menu, select Mass [[ kg |].

10. Enter a default value of 5.

11. From the Default Units drop-down menu, select kg.

12. Enter Mass of the sliding mass for the Description field.

13. In the same way, define the following parameters and values in the Parameters subsys-
tem default settings table.
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Name Type Default Value | Default Units Description
LENGTH If[e:?;h 2 m Length of the sliding mass
Velocity o . o
Vo m 1 m Initial velocity of the sliding
= s mass
s
S0 Position | m Initial position of the sliding
[[m]] mass

The parameter editor view appears as follows when the values are defined.

Parameters subsystem default settings

Name
MA4SS

LENGTH

Type
Mass [ig]
Length [ m]

Velocity

Position [ m]

Default Value

ke

BIE

Default Units Description
¥ Mass of the sliding mass

¥ Length of the sliding mass

~ | |Initial welocity of the sliding
mass

- |Initial position of the sliding
mass

14. Click Diagram (7)) and then click Main (Main P ) in the Navigation Toolbar. When
you select the parameter block in the Model Workspace, the defined parameters appear
in the Inspector tab on the right side of the MapleSim window.

ShdingMassParams

Inspector | Settings

Mame | SlidingMassParams

Type Standalone Subsystem

¥ Parameters

M43 3
LENGTH |2
Fo 1
30 1

kO |v

-

E -
5

m v

15. In the Model Workspace, select the SM; mass component in the diagram.

16. In the Inspector tab, assign the following values and press Enter.
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=| Inspector | Settings

MName |53

Type Mass

. | ¥ Parameters
] m o |(MASS |k |

L IENGTH||m |
¥ Initial Conditions

ignore quess enforce

i
¥ 7 ¥ 4] — T
U] U] E

The parameters of this Mass component now inherit the numeric values that you defined
in the parameter block.

17. In the same way, assign the same values to the parameters of the SM, and SM3 mass
components in the model.

18. In the Model Workspace, delete the probe labeled Input.
19. Select the probe labeled Output.
20. In the Inspector tab, clear the check box beside Velocity.

21. To simulate the model, click Run Simulation (p ) in the Main Toolbar. The following
graph appears.



2.6 Global and Subsystem Parameters <« 47

T o=
_Q—
£ S 0aq LT T m
Cutputs
1.5 T
14 /
{
=13
5
B
5
12 {
1.1 {
.'Il
I
1.0
1] 0.002 000 (.06 0008 0000 001z
i

2. In the Model Workspace, click the parameter block.

23. In the Inspector tab, change the mass to 3.5 and the initial velocity to 5. Press Enter.
These changes apply to all of the Mass components to which you assigned the symbolic

parameter values.
24. Simulate the model again. Another simulation graph appears, which you can compare

to your first graph.
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Creating Parameter Sets

The parameters you create for your model can be stored as reusable Parameter Sets. Para-
meter Sets let you save, reuse, and compare different sets of parameters for the same model
displayed in the workspace. At any time you can easily apply and run different simulations,
saving new values for each model. A Parameter Set provides a snapshot of all the parameters

in the Model Workspace

Parameter Sets for your model are listed in the Project tab, under Parameter Sets as shown

in the following figure.

You can use, save, reuse, and compare different sets of parameters for the same model by
right-clicking (Control-click for Macintosh) on a Parameter Set. For more information, see

W Parameter Sets

DC Motor2
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the Using MapleSim > Building a Model > Using Parameter Sets > Saving and Applying
Parameter Sets section in the MapleSim Help system.

Using Advanced Parameter and Variable Settings

At the top level of your model, in the Main subsystem default settings window, you define
the subsystem by adding parameters and setting their default values. An alternative is to
directly assign subsystem parameters, variables, and initial conditions to components in
your subsystem by using the Advanced Parameter Settings and Advanced Variable
Settings tools in the Inspector tab. Advanced Settings lets you override one or more default
values.

Advanced Parameter Settings

Advanced Parameter Settings lets you override the default values for selected subsystem
components. If desired, you can parametrize the override using the parametrization feature

(I®). A component override in one subsystem can be converted to a parameter visible in all
the other subsystems.

In the following model an override was applied to the initial value of R and changed to the
parameter Rcommon.

1 1

L
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Advanced Variable Settings

Advanced Variable Settings lets you specify initial conditions for subsystem components.
When you select Advanced Variable Settings the initial condition fields appear for all
configurable components for that subsystem.

Example: Creating a Parameter Override

To create a parameter override:

1. Under the Libraries tab on the left side of the MapleSim window, expand the Examples
palette, expand the User's Guide Examples > Chapter 2 menu, and then open the
Simple DC Motor example.

2. Using the Selection Tool ( k ) located above the Model Workspace, draw a box around
the electrical components.

£ ! Qutput
g Rkl ‘ | Spesad, TForque
" i
’_ ST | /J'\ _:') 12—1
——|\ jl a S8 ;\ /l__.——_ =
— ' [ T_EMF =T
| SESE] RS
=L
G
1

3. From the Edit menu, select Create Subsystem or right-click (Control-click for Macin-
tosh) the boxed area and select Create Subsystem.

4. Inthe dialog box, enter DC Motor, and then click OK. The DC Motor subsystem appears.

Quiput
2 | Speed, Torque
1 H I
s :
ul bl >—i—ci_—ln
_| =1

[ ﬂ.\:'u:!n:vr1

5. Use the DC Motor subsystem to create the shared subsystem definition and add it to the
Definitions tab.
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6. Add three copies of the DC motor subsystem to your Model Workspace by dragging
the DC Motor subsystem definition icon from the Definitions tab and placing it in the
Model Workspace.

Oomput
Speed, Torque
!

2
—
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=T
T
= DCMDrDr1
=t DC Mator, =P Motor, = DC Motor,

7. Create three additional DC Motor subsystems as shown below.
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5
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8. Click the DC Motor, subsystem, and then click Advanced Parameter Settings under

the Inspector tab. The Advanced Parameter Settings window appears, showing all of
the subsystem components.

Advanced Parameter Settings

\ A
551
8

9. Expand R1 and enter a value of 100 for the Resistance parameter (R).

] Advanced Parameter Settings

v ox

R |@ |9 Ad

10. Click OK. The new parameter appears in the Inspector tab as an override.

Inspector | Settings

Name | DC Moior,

Type DC Motor

¥ Parameter Overrides
R, Component

R 100 || ~ & =

11. To change this override to make it a reusable parameter, click Parametrize (|g), enter
Rcommon as the new parameter name, and then click OK. Reommon appears in the
Inspector tab as a parameter that can now be reused in the other subsystems. Note that
it is no longer an override.

Inspector | Settings

MName |DC Motor,

Type DC Motor

¥ Parameters

Rcommon 100 Q hd
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12. For each of the other subsystems, click the subsystem and enter values of 7502, 50Q, and
250 for Rcommon in DC Motor subsystems 3, 2,and 1 respectively.
13. For each of the subsystems, select the probe, and in the Inspector tab select the Speed

check box and clear all of the other check boxes.
14. Click Run Simulation (p ) in the Main Toolbar. The following graphs appear for each

of the subsystems.
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Specifying Initial Condition Overrides

You can set initial condition values to override existing initial conditions for specific sub-
system components. When you select a component, the available initial condition fields
and any existing overrides appear in the Inspector tab, along with the other configurable

parameter values for that component.

When you select a subsystem and then click Advanced Variable Settings, all subsystem
components appear. You can select a component and specify the initial conditions for that
component. This feature is especially useful for models that contain multiple shared subsys-

tems.
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2.7 Attaching Files to a Model

You can use the Attachments palette in the Project tab to attach files of any format to a
model (for example, spreadsheets or design documents created in external applications).
You can save files attached in the Attachments palette as part of the current model and
refer to them when you work with that model in a future MapleSim session. To save a file,
right-click (Control-click for Macintosh) the category in which you want to save the attach-
ment in the palette and select Attach File.

You can also attach a file to a model from the menu bar by selecting Edit > Attach File...
. Using this method, by default, the file attaches to the Documents category. If you want
to move this attachment, you can click and drag the entry to another category.

The following image shows an Attachments palette that contains files called Damper-
Curve.csv and Data Generation.mw.

W Attachments

=I-Documents

: E—----DamperCurve.csv

: ..Data Generation, mw
E----Eustum Components
E----Data Sets

E----EnD Images

----- Internal

Figure 2.14: Attachments

You can also use the Attachments palette to open MapleSim templates to perform analysis
tasks in Maple, create custom modeling components, and generate data sets for a model.
For more information about performing analysis tasks, see Analyzing and Manipulating a
Model (page 129) in this guide.

2.8 Creating and Managing Custom Libraries

You can create a custom library to save a collection of subsystems and custom modeling
components that you plan to reuse in multiple files or MapleSim sessions. Custom libraries
that you create appear in custom palettes in the Libraries tab on the left side of the
MapleSim window and are saved as .msimlib files on your computer. These custom palettes
will appear in the MapleSim window in future MapleSim sessions.

You can use the subsystems and components from the custom library palette when building
a model, in the same way you add components from other palettes.
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You can also share a custom library with other users. For example, if you store a custom
library on a network drive, other users with access to that location can load your custom
library in their MapleSim session.

Custom library palettes appear above the Examples palette and are indicated with an icon:

- A sample custom palette is shown below.

W Robot 1

JE

Body Servo
P Links

| > Examples on J

For information on creating custom libraries, see Using MapleSim > Building a Model >
Custom Libraries > Creating a Custom Library in the MapleSim Help system.

If you used a third-party tool to create models or model libraries based on the Modelica
3.2.1 programming language, you can import the .mo files for the models or model libraries
into MapleSim as .msimlib files. You can then use the imported models and libraries in
your MapleSim models as you would use any other modeling components. For more inform-
ation, see Using MapleSim > Building a Model > Importing and Opening Modelica
Models and Libraries > Importing Modelica Libraries.

Example: Creating a Custom Library from an Existing Model
In this example, you will create a custom library from an existing MapleSim model.

add a subsystem and an .mw attachment to a custom library to make them available in a
future MapleSim session.

To create a custom library from a model:

1. Under the Libraries tab, expand the Examples palette, expand the Physical Domains
> Multibody menu, and then open the 5 DoF Robot example.

2. This model has six shared subsystems, which are listed in the Components palette of
the the Definitions tab.

3. Save the model.

4. From the Tools menu, select Export to MapleSim Library....
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5. Enter the name Robeot for the library under Package.
Note: The package name that you specify will appear as the custom palette name in the
MapleSim interface.

6. Click OK. You are now in library edit mode (indicated by the watermark on the work-
space and the Library tab in the Parameters pane). A new custom library palette appears
in the Libraries tab on the left side of the MapleSim window. The palette is empty be-
cause we have not defined a hierarchy for its elements.

7. Switch to the Definitions tab, and drag the components to the Hierarchy tab under the
root name (Robot). If desired, organize the elements into subgroups.

W Hierarchy

W Robot

W
4

Body Servo
W Links

Link1 Link2
Link3 Links4

8. Click Reload ( (i) in the Main Toolbar to save your changes and reload the palette for
the custom library in the Library tab with the updates. The custom library palette now
contains all these components.
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W Robot [

]«

Body Servo

i

Link 1 Link 2
= |‘ lﬁ)‘
Link 3 Link 4

2.9 Annotating a Model

You can use the tools in the Model Workspace Toolbar to draw lines, arrows, and shapes.
MapleSim also provides many tools for customizing the colors, line styles, and shape fills.

You can use the text tool (IT) in the Model Workspace Toolbar to add text annotations
to your model. In text annotations, you can enter mathematical text in 2-D math notation
and modify the style, color, and font of the text. For more information about 2-D math
notation, see Entering Text in 2-D Math Notation (page 59).
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Example: Adding Text Annotation to a Model

To add text annotation to a model:

1. Under the Libraries tab, expand the Examples palette, expand the User's Guide Ex-
amples > Chapter 2 menu, and then open the Simple DC Motor example.

2. From the Model Workspace Toolbar, click Text Tool (T)).

3. In the Model Workspace, draw a text box for an annotation below the Step component.

zl\ +

.

When you release your left mouse button, the toolbar above the Model Workspace switches
to the text formatting toolbar.

Math ':\ Tirmes Mew Roman 'f" ':\ 1z V"' B I H =

thia

Enter the following text: This block generates a step signal with a height of 1.
Select the text that you entered and change the font to Arial.

4.

5.

6. Click anywhere outside of the text box.

7. Draw another text box below the Inertia component.
8.

Enter the following text: Inertia with a @, value of 0 rad.

Tip: To enter the omega character (®), click Math on the context bar Text (or press F5)
to switch to the 2-D math mode, type omega, and then press Esc. To enter the subscript,
press Ctrl + Shift + the underscore key (Windows and Linux) or Command + Shift + the
underscore key (Macintosh) followed by 0. Press the right arrow key to move the cursor
from the subscript position. Toggle back to text entry mode by clicking Text on the context
bar, and enter the remaining text.

9. Select the text that you entered and change the font to Arial.

10. Click anywhere outside of the text box to complete the annotation.
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2.10 Entering Text in 2-D Math Notation

In parameter values and annotations, you can enter text in 2-D math notation, which is a
formatting option for adding mathematical elements such as subscripts, superscripts, and
Greek characters. As you enter text in 2-D math notation, you can use the command and
symbol completion feature to display a list of possible Maple commands or mathematical
symbols that you can insert.
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The following table lists common key combinations for 2-D math notation:

Table 2.3: 2-D Math Notation Key Combinations

Task

Key Combination

Example

Switch between text and
2-D math mode
(annotations only)

F5

Command and symbol
completion (parameter
values and annotations

only)

1. Enter the first few characters of a symbol
name, Greek character, or Maple
command.

2. Enter the key combination for your
platform:

* Esc, Macintosh, Windows, and
Linux

» Ctrl + Space, Windows
 Ctrl + Shift + Space, Linux

3. From the menu, select the symbol or
command that you want to insert.

Enter a subscript for a
variable

Ctrl (or Command) + Shift + underscore

)

Enter a superscript

caret (")

Enter a square root
(annotations only)

Enter sqrt and press Ctrl (or Command for
Macintosh) + Space.

Enter a root (annotations
only)

Enter nthroot and press Ctrl (or Command)
+ Space.

Enter a fraction

forward slash (/)

Enter a piecewise, matrix,
or vector row (annotations
only)

Ctrl (or Command) + Shift + R

Enter a table column
(annotations only)

Ctrl (or Command) + Shift + C

For more information, see Using MapleSim > Building a Model > Annotating a Model

> Key Combinations for 2-D Math Notation in the MapleSim Help system.
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2.11 Creating a Data Set for an Interpolation Table
Component

You can create a data set to provide values for an interpolation table component in your
model. For example, you can provide custom values for input signals and electrical Current
Table and Voltage Table sources. To create a data set, you can either attach a Microsoft®
Excel® spreadsheet (.xls or .xlsx) or comma-separated values (.csv) file that contains the
custom values, or you can create a data set in Maple using the Data Generation Template
or Random Data Template provided in the MapleSim templates dialog box.

For more information about interpolation table components, see the MapleSim Component
Library > Signal Blocks > Interpolation Tables > Overview in the MapleSim Help system.

Example: Creating a Data Set in Maple

In this example, you will use the Data Generation Template to create a data set for a
MapleSim 1D Lookup Table component. In this template, you can use any Maple commands
to create a data set; however, for demonstration purposes, you will create a data set using
a computation that has already been defined.

To create a data set in Maple:
1. Open a new MapleSim document.

2. Inthe Libraries tab, expand the Signal Blocks palette, and then expand the Interpolation
Tables menu.

. Add a 1D Lookup Table component to the Model Workspace.
. In the Main Toolbar, click Templates ( & ).
. From the templates list, select Data Generation.

. In the Attachment field, enter My First Data Set and click Create Attachment. The
Data Generation Template opens in Maple.

AN W AW

7. To execute the entire worksheet, click ( HI') at the top of the Maple window.
8. At the bottom of the template, in the Data set name field, enter TestDataSet.
9. To make the data set available in MapleSim, click Attach Data in MapleSim.

10. In MapleSim, under the Project tab, expand the Attachments palette, and then expand
the Data Sets category. The data set file appears in the list. You can now assign this data
set to the interpolation table component in the Model Workspace.

11. In the Model Workspace, select the 1D Lookup Table component.

12. From the data source ficld, select attachment.
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13. In the Inspector tab, from the data drop-down menu, select the TestDataSet.mpld file.
The data set is now assigned to the 1D Lookup Table component.

14. Save the Data Generation Template in Maple and then save your model in MapleSim.

2.12 Best Practices: Building a Model

This section describes best practices to consider when laying out and building a MapleSim
model.

Best Practices: Laying Out and Creating Subsystems

To start building your model, drag components from the palettes to the center of the Model
Workspace. Drag the components into the arrangement that you want in the Model
Workspace and then, if necessary, change their orientation so that the components are facing
in the direction that you want. When you have established the position and orientation of
the components, connect them in the Model Workspace.

When grouping components into subsystems, make sure that you include logical component
groups that fit on one screen at a time. This will allow you to see all of the subsystem
components at a certain level without scrolling.

Create Subsystems for Component Groups That You Plan to Reuse

Create subsystems for component groups that you plan to reuse throughout a diagram or in
multiple files. For example, if you plan to include multiple planar link models in a pendulum
system, you can create a link subsystem so that multiple copies of that component group
could be added. If you wanted to add the link subsystem to another pendulum model, you
can create a custom library to use the subsystem in another file.

Create Subsystems for Component Groups That You Plan to Analyze

Make sure that you create subsystems for component groups that you plan to analyze in
more depth, test, or translate into source code. Several MapleSim templates allow you to
analyze and retrieve equations from particular subsystems. The Code Generation Template
allows you to generate source code from subsystems only.

For more information about performing analysis tasks, see Analyzing and Manipulating a
Model (page 129) in this guide.

Use the Debugging Console to Identify Subsystem Copies and Unconnected
Lines

You can display the debugging pane by clicking Debugging () at the bottom of the
MapleSim window.
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After you run the simulation, the debugging pane displays diagnostic messages that can
help you troubleshoot potential errors as you build a model. When you click Run diagnostic
tests () below the debugging pane (or from the Edit menu, select Check Model),
MapleSim verifies whether your model contains unconnected lines or subsystems that have
identical content but are not linked to a subsystem definition. When either of these issues
are detected, a message that identifies the subsystem in which the issue is located appears
in the debugging console. You can right-click (Control-click for Macintosh) the message
in the debugging pane to display options that can help you to resolve the issue.

Best Practices: Building Electrical Models

Include a Ground Component in Electrical Circuits

In each electrical circuit model, you must add and connect a Ground component to provide
a reference for the voltage signals.

Verify the Connections of Current and Voltage Sources

Simulation results can be affected by the way in which a current or voltage source is con-
nected in your model. If you receive unexpected simulation results, verify the connections
between electrical sources and other components in your model. All of the current sources
in the MapleSim Component Library display an arrow that indicates the direction of the

positive current.

—

Also, all of the voltage sources display a plus sign indicating the location of the positive
voltage and a minus sign indicating the location of the negative voltage.

.té:n

Consider the following Simple DC Motor model. Note that the positive port of the Signal
Voltage source at the left of the diagram is connected to the positive port of the Resistor
component.
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When this model is simulated, MapleSim returns the following results for the torque and

speed quantities.
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On the other hand, if the negative port of the Signal Voltage source is connected to the
positive port of the Resistor component, as shown in the following model.
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MapleSim returns different results for the speed and torque quantities.
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Best Practices: Building 1-D Translational Models

Verify That All Force Arrows Are Pointed in the Same Direction

In MapleSim, all of the 1-D translational mechanical components are defined in a 1-D co-
ordinate system with the positive direction defined as the direction of the gray arrow dis-
played by the component icon.

L RVAYA:!

—_—

Any positive forces acting on the model cause the component to move in the direction of

the arrow, so make sure that all of the arrows displayed by the 1-D translational mechanical
components in your model point in the same direction. As an example, note that all of the
force arrows are pointed to the right in the following model.
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Figure 2.15: Verifying Force Arrows

For an example of sign convention and how arrow direction represents a force acting on
the model, under the Libraries tab, browse to the Examples > User's Guide Examples >
Chapter 2 menu, and then open the Constant Acceleration, Sign Convention and Arrow
Convention examples.

Best Practices: Building Multibody Models

Connect the Inboard Port of a Rigid Body Frame to a Center-of-mass Frame

Make sure that you connect the inboard port of any Rigid Body Frame components in your
model to the center-of-mass frame of a Rigid Body component. This ensures that the local
reference frame used to describe displacements and rotations for the Rigid Body Frame
component match with the center-of-mass reference frame defined on the Rigid Body
component.

In the following planar link example, the Rigid Body Frame inboard ports (that is, the ports
with the ._T icon) are both connected to a Rigid Body component.

Wl by

Figure 2.16: Center of Mass Placement Best Practice
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Best Practices: Building Hydraulic Models

Define Fluid Properties

When building hydraulic models, you must define the properties of the fluid that will be
used by placing the Hydraulic Fluid Properties component at the top level of your model
or at the same level as a hydraulic subsystem. If you place this component at the top level
of your model, all hydraulic components and subsystems in your model will inherit the
fluid properties defined by that component instance; if you place the Hydraulic Fluid
Properties component at the same level as a subsystem, all hydraulic components in that
subsystem and all nested subsystems will inherit the properties defined by that component
mstance.

In the following example, all of the hydraulic components in the model inherit the fluid
properties defined by the Hydraulic Fluid Properties component at the top-right of the
diagram.

ot
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— o e
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o e
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Figure 2.17: Hydraulic Model

For a complete tutorial on how to model hydraulic systems, see Tutorial 8: Modeling
Hydraulic Systems (page 211).
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Best Practices: Enforcing Initial Conditions

In complex models, all of the initial conditions might not be independent of each other. In
general, use the enforce (i) option to strictly enforce as many initial conditions as you
have degrees of freedom in your model. However, you can use the guess option (i) for a
specified initial condition parameter value to help the solver determine the desired starting
configuration for your system faster.



3 Creating Custom Modeling Components

In this chapter:

* Understanding Custom Components (page 69)

* Creating Custom Components with Signal-Flow Behavior (page 72)

* Creating Custom Components with Physical Connections (page 78)

» Working with Custom Components in MapleSim (page 80)

» Example: Creating a Nonlinear Spring-Damper Custom Component (page 83)

3.1 Understanding Custom Components

The Custom Component template is an interactive Maple worksheet that lets you quickly
create your own specialized MapleSim components without writing code, or having to re-
arrange your equations for every new model. Creating custom components extends the
MapleSim component library, enabling you to create custom modeling components based
on the mathematical models that you define. Custom components can use signals, ports
with associated physical domains, or a combination of the two. You can also create libraries
of custom components and create custom components to contain particular subsystems with
specialized functionality.

You can use the Custom Component Template to define system parameters and variables,
set the level of equation optimization, generate the equations, and then further analyze the
resulting equations. The Custom Component templates contain pre-built embedded compon-
ents that lets you extract, manipulate and analyze the symbolic system equations generated
by any MapleSim model. Using various components from the library, you will create
models, set initial conditions and component properties, and assign new values to parameters
and variables.

For a complete tutorial on how to create domain specific custom components, see Tutorial
5: Using the Custom Component Template (page 177) Using the Custom Component
Template.

There are several different Custom Component templates, each of which can be attached
to a model available through the MapleSim Create Attachment templates dialog box, from
the View > Create Attachment menu.

69
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Figure 3.1: MapleSim Templates

Creating a Simple Custom Component

The general process of creating a custom component for a MapleSim model consists of
specifying the component equations for the custom component, component parameters and
system model, specifying the port types and their values, and generating the component.

To create a custom component:
1. Start a new MapleSim model and click Edit > Create Attachment....

2. Select the Custom Component template and then click Create Attachment. The Maple
Custom Component template is loaded.

3. If desired, customize the heading banner with a name, author, and date.

4. In the Equations area, enter the equations for your custom component. Equations,
parameters and initial conditions are all entered here. Press Enter at the end of the line.

eq = | s(t) = sa(t) — sb(t), 0 = Fa(t) + Fb(t), Fa(t)
= piecewise[s(t) <0,K-s(t) + B-%s(t), 0], K =1000,B

= 10]

5. In the Parameters section, assign default values and types to model parameters.
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6. In the Variables section, assign initial values and types for model variables.

7. Inthe Ports section, add ports to the custom components by clicking Add Port as shown
below. You can control the layout of ports.
It is possible to define custom ports. To do so, you must first define the custom port using
the Custom Port template. Then you can use the custom port in this template. For a
complete tutorial on how to use custom ports, see Example: Custom Ports (page 187) in
Chapter 6.

8. Provide the details for the port type, style, name, and port signals.

9. In the Component Generation section, enter a name for the component. This is the
name shown in the Definitions tab in MapleSim for the custom component.

10. Click Generate MapleSim Component to create your component and to bring you back
into the MapleSim environment. The custom component now appears in the Definitions
tab under Components.

W Components

*
.
%

custom

Typical Uses

The Custom Component template is the most general template and is specifically designed
to help you create custom components from algebraic expressions, differential equations,
or systems of differential-algebraic equations. The Custom Component Template is a col-
lection of pre-built controls and procedures associated specific Maple commands to easily
create new MapleSim components. In addition to the Custom Component, the Custom
Discrete State Space and the Custom Discrete Transfer Function templates implement
specified transfer functions, and the Modelica Custom Component allows for the creation
of a custom component via user-provided Modelica code.

Custom Component templates are more than just containers for your equations. You can
also access all of Maple’s functionality to further develop your equations before you generate
your Custom Component for your model. This includes access to Maple’s programming
language, symbolic algebra functionality, and documentation tools to instantly analyze and
verify the behavior of your component.

By using the Custom Component Template you create a custom component in Maple by
performing the following tasks:

» Attach a custom component template to your model.
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* Define and enter your governing equations and properties that determine the behavior of
the component (for example, parameters and port variables).

* Specify ports for your component.

* Define the associated port variable mappings.

* Map variables from your equations to the ports.

* Generate the component and make it available in MapleSim.

* Test and analyze your mathematical model.

The Custom Component Template contains pre-built controls that allow you to perform
these tasks with the same validation as for built-in components, preventing invalid connec-
tions and parameter values.

Using The Custom Component Template

For details on using this template, refer to the help page Using the MapleSim DAE Custom
Component Template.

3.2 Creating Custom Components with Signal-Flow
Behavior

Custom components simplify model construction by reducing the need to connect many
signal-flow components together. This example shows how to create a custom component
for a simple signal flow equation.

Creating a Simple Signal-Flow Custom Component

Create a custom component that implements the following equation

x(t) = y(t) + z(t)
To create a custom component
1. Start a new MapleSim model and Click Edit > Create Attachment....
2. Select the Custom Component template and click Create Attachment.

3. In the Equations section enter the following equation.

eq = [x(t) =y(t) + z(1) ]

Note: The equation here is enclosed in square brackets because eq must be assigned a list
of equations.

Pressing Enter on this line registers the change.
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[xlz) =2(1) + (1) ]

Figure 3.2: Equations Defining a Custom Component

Tip: The equations in the custom component do not have to be rearranged into an explicit
form. For example, you could replace the equation with

2
eq = X(t) +1og(x(1)*) = 1(1) + 2(1)
for which there is no explicit solution for the output X(t). MapleSim solves for x(t) auto-
matically.
4. Click Refresh All to update the tables.

5. In the Ports section, add three new ports by clicking Add Port three times and dragging
them into following positions.

Figure 3.3: Port Mappings

6. Click on the top port on the left-hand side to select it.

7. From the Type drop-down list, select Real Signal. For the Style, select the in radio
button. The port is given the default name real_i.
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Figure 3.4: Variable to Port Mapping

8. Next, associate a variable with the port signal. Select y(t) from the drop-down list as
shown in Figure 3.4.

9. Assign the remaining port mappings using the settings in Table 3.1.
Table 3.1: Port Map

Port Name Port Type Port Component
real i Signal Input Wt
Value
reall i Signal Input Z(1)
Value
real o Signal Output | x(¢)
Value

10. Under the Component Generation section, click Generate MapleSim Component.
The custom component equations are generated and assigned to the model. The custom
component icon appears in MapleSim under the Definitions tab, in the Components

palette.
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Figure 3.5: Generated Custom Component

11. In the following model, drag the custom component into the workspace from the Com-
ponents palette, connect two signal sources to the input ports on the left, and then place
a probe on the right-most port (right-click and select Add Probe) using the components
from Table 3.2.

Probe

canet -~ value

1 customi

"y

Figure 3.6: Completed Custom Component Model
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Table 3.2: Signal Flow Components

Component |Number of| Symbol Library Location Required Settings
Components
Custom [ .. .
* > t tt
Component 1 PO Definitions > Components | Custom settings
i >
Constant 1 | |Signal Blocks>Sources Use default settings

Real

Signal Blocks > Sources >

Sine Source 1 F Real

Use default settings

12. Click Run Simulation (b ) in the Main Toolbar. When the simulation is complete, the
following graph appears.



3.2 Creating Custom Components with Signal-Flow Behavior « 77

-

(i Probe Plots N = [
& «\- Qe o 1 TV, um
Probe l.value ;
2| ﬂ |”|
i f\ f\ f\
1.5
o
0.5
1T 1 Y I
LU
0 2 4 6 B 10
t

Advantages of Acausal Mapping

Even though the custom component ports are specified as Signal Inputs and Signal Outputs,
MapleSim is truly acausal; signals can be inputs or outputs regardless of the pin type. For
example, if X(t) and z(t) were specified, and a probe was placed on y(t), MapleSim
would automatically rearrange the specified equation into Y(t) = x(t) + z(t).

The concept of signal inputs and outputs are necessary for the code generation capabilities
of MapleSim, since the code is 'causalized', MapleSim expects inputs and provides outputs.
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Using Differential Equations in Custom Components

Instead of using library components for you model, you can also use differential equations
to define your custom component. For example, Figure 3.7 shows the equations that describe
the motion of two coupled mass-spring-dampers subjected to a driving force.

mi- :1 x1(t) =-KIxI(t) deid 1) - K2 (xI(t) - x2(1)) —B,.[ d xI(r)
r

dr

eq =

4 o) m2 e xa() = K2 (x2(1) - d o d |
_FL[”J‘M‘ dr‘ x2(t)=-K2 (x2(t) - xI(1)) - [dr_u(r] dr.d(r]]+F(f) :

params = [KI=1,BI=1, K2=1 B2=1,mlI=1,m2=1]:
initialconditions == [x1(0) =0,x2(0) =0,D(xZ)(0) =0,D(x2)(0)=0]:

Figure 3.7: Double Mass-Spring-Damper Equations

Figure 3.8 shows how the parameters are mapped to component ports:

Figure 3.8: Port Mapping for Double Mass-Spring-Damper

3.3 Creating Custom Components with Physical
Connections

When you create custom components based on physical connections, each connection port
has two variables associated with it: the across variable and the through variable. The
through variable represents a flow of a conserved quantity (such as heat, mass, current,
force or torque) and the across variable represents the driving force in a system (temperature
difference, pressure difference, voltage drop, velocity or relative angular velocity).
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Table 3.3: Characteristics of Through and Across Variables

Characteristics of Through Variables

Characteristics of Across Variables

Conserved quantity (like heat or mass)

Has a direction of flow

Satisfies the relationship input = output +

accumulation

Uniform across a domain

Drives the flow of the conserved quantity

Is a scalar

Defined as the difference between two points within

a physical domain

Table 3.4 shows the mathematical relationships defining the connection between various
across and through variables.

Table 3.4: Through and Across Variable Mathematical Relationship

Domain Governing Equation Through Variable | Across Variable
Ohm’s Law - v I v
Electrical Domain R
Hagen—Poiseuille equation dm D4 b dm ,
Hydraulic Domain dt 128Lpu dt
Fourier's law
Thermal Domain dt dt

Deriving the System Equations for a Resistor

Table 3.5 shows a model of a simple resistor with several variables and one parameter.

Table 3.5: Resistor Variables and Parameters

Variable Parameter Description
i(t) Current
v(t) Voltage difference
vLeft(t) Voltage on the left port
vRight(t) Voltage on the right port
R Resistance

Ohm’s Law defines the relationship between the voltage and the current as

V(t) =V

right(t) — Vleft( t)
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Figure 3.9 shows the equations mapped to the custom component ports.

Vieft(t) Vright(t)
©_g P

Figure 3.9: Resistor Port Mapping

The current i(t) on the right port has a negative sign, representing flow out of the resistor.
The current on the left port is positive, representing flow into the resistor. The resistance
(R) is defined as a parameter available in the Parameter Inspector.

3.4 Working with Custom Components in MapleSim

In MapleSim, you can work with a custom component in the same way as you would work
with a subsystem. You can perform the following tasks:

* Add Text and Pictures to a Custom Component

» Save a Custom Component as Part of the Current Model

* Add a Custom Component to a Custom Library

» Edit a Custom Component

* Open Custom Component Examples

Add Text and Pictures to a Custom Component

To customize the appearance of a custom component, you can change the default custom
component icon. Select the custom component in the Model Workspace, click Icon ()
in the Navigation Toolbar, and use the drawing and annotation tools to add text and illus-
trations, and to import a custom picture.

To adding a picture to a Custom Component

1. Create a custom component and drag it onto the MapleSim workspace.

2. Right-click the custom component and select Open Component. The component opens
in the workspace showing the port connections.



3.4 Working with Custom Components in MapleSim « 81

E B| 5 7 ” Main ®  custom

kemsOo REDS D —- .\E '/"\Z'/' VA=Y

3. Inthe navigation toolbar, click Icon (). The default image appears inside the component
boundary.

=</[2] k5 72 | Main » custom,

g T N\ D O {_ . v/:"' ¢ i v“‘n(ﬂ-Ev;:u( V)I

> ’ ¢
0%

4. Click on the image and then click on the Drawing Fill drop-down menu ("Ld) 1. ')").
A list of images appears displaying the Image Browse selection at the bottom.




82 « 3 Creating Custom Modeling Components

[~ Imzge  Browse...

5. Click Browse.... The Load Image window appears.
6. Browse to and select an icon image and then click OK.

7. In the navigation toolbar, click Main to browse to the top level of your model. Your
custom component (and all other instances of the same component) will reflect the new
icon.

Save a Custom Component as Part of the Current Model

When you save a model, the custom component is saved as part of the model. If you run
the Prune Model tool on your model, however, an unused custom component definition
will be removed. To protect the custom component from potentially being cleaned up by
the Prune Model feature, do one of the following:

* Move the custom component from the Components palette of the Definitions tab to the
Hierarchy palette.

» Use the custom component in your model: drag the custom component from the Com-
ponents palette to the Model Workspace.

For more information, see Using MapleSim > Building a Model > Pruning a Model in
the MapleSim Help System.
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Add a Custom Component to a Custom Library

If you want to use a custom component in a file other than the current model, add the com-
ponent to a custom library. For more information, see Creating and Managing Custom
Libraries (page 54).

Edit a Custom Component

If you want to edit a custom component that you have generated, make your changes in the
corresponding Maple worksheet and regenerate the component.

To edit a custom component

1. In the MapleSim Model Workspace, double-click the custom component that you want
to edit. The corresponding Custom Component Template opens in Maple.

2. In the Maple worksheet, edit the equations, properties, or port values.

3. At the bottom of the worksheet, click Generate MapleSim Component. Your changes
are generated in the custom component displayed in MapleSim.

4. Save your changes in the .mw file and the .msim file to which you added the custom
component.

3.5 Example: Creating a Nonlinear Spring-Damper
Custom Component

In this example, you will use the Custom Component Template to create a nonlinear spring-
damper custom component. The equations defined in this example are based on the
Translational Spring Damper component in MapleSim. In this case, the stiffness and
damping coefficients are replaced with input functions to the component.

To obtain the governing relationships, you can start with a free-body diagram. The diagram
for the spring-damper system is shown in the following figure.
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Figure 3.10: Nonlinear Spring-Damper Custom Component

The end points, a and b, can be defined as the ports for the component; the equations are
derived relative to these ports. Therefore, the general equation of motion,

d-is (t) +cs

dt “rel re(t):F(t)

where d is the damping coefficient, c is the stiffness of the spring, and s,,; is the relative
displacement between the two ports s, and s;, can be written as

8,,(1) =5, (1) —s,(1)

Also, an examination of the net force on the system shows that F(t) = Fb( t), where

F (t) +Fb(t) =0

a

All of the above relationships are required to define the system behavior.

Opening the Custom Component Template

The Custom Component template is part of the MapleSim templates accessed from the
Main Toolbar.

To open the Custom Component Template:
1. In MapleSim, open the model to which you want to add the custom component.

2. Click Templates ( #) in the Main Toolbar.



3.5 Example: Creating a Nonlinear Spring-Damper Custom Component < 85

3. In the Select Template list, select Custom Component.
4. In the Attachment field, enter Nonlinear Spring-Damper as the name for the template
and click Create Attachment. The Custom Component Template opens in Maple.

Defining the Component Name and Equations

You can now specify the name that will appear for the component in the MapleSim interface
and define the equations.

To define the custom component:
1. Inthe Equations section, define the nonlinear system by entering the following equations.
>eq = [d(t)* (diff(s_rel(t), t)) + c(t) *s_rel(t) = F(t),

s_rel(t) = s_b(t) — s_a(t), v_rel(t) = diff(s_rel(t), t),

F(t) = F_b(t),F_a(t) + F_b(t) =0];
Note that the equations are entered in a Maple list. The constants, d (damping) and ¢ (stiff-
ness) are replaced by the functions d(¢) and c(¥) to define them as input states to the system.
2. With your cursor on the equation, press Enter.

3. In the Variables section, click Refresh All to see an updated list of variables.

You can now assign these input and output variables to ports that you will include in your
generated custom component.

Defining Component Ports

In the Ports section of the template, you assign input and output variables to ports that will
appear in the generated component, and specify the layout of these ports.

To define the ports:

1. Click Add Port four times. Four squares, which represent the ports that you will lay out
and define, appear in the diagram.
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2. Drag the ports to position them with one on each side and two on the top of the diagram.

. Select the port on the left side of the diagram.
. From the Type drop-down menu, select Translational.

. For the style of the port, select b. The port's default name is tflange b.

AN L AW

. First, define the signal position. Ensure Position is selected in the list under Signal. From
the drop-down list under Signal, select s_b(t).

7. Next, define the signal force. Select Force in the list under Signal. From the drop-down
list under Signal, select F_b(t). The left port is now defined as a translational flange and
associated with the position variable s_b(t) and force variable F_b(t).

8. Select the port on the right side of the diagram.
9. From the Type drop-down menu, select Translational.
10. For the style of the port, select a. The port's default name is tflange a.

11. First, define the signal position. Ensure Position is selected in the list under Signal. From
the drop-down list under Signal, select s_a(t).

12. Next, define the signal force. Select Force in the list under Signal. From the drop-down
list under Signal, select F_a(t). The left port is now defined as a translational flange and
associated with the position variable s_a(t) and force variable F_a(t).

13. Select the port at the top left of the diagram.
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14. From the Type drop-down menu, select Real Signal. The port's default name is real_i,
change it to cin.

15. Under Signal, select ¢(t) from the drop-down menu. This port is now defined as a signal
input and associated with the stiffness variable e(t).

16. Select the port at the top right of the diagram.

17. From the Type drop-down menu, select Real Signal. The port's default name is real_i,
change it to din.

18. Under Signal, select d(t) from the drop-down menu. This port is now defined as a signal
input and associated with the damping variable d(t).

[ Add Port ] [ Delete Port ] [ Clear Al Ports ] Icon Size: Smal @ O ) ) Large [¥] Snap to Grid
Type: :Real Signal -: 1

=
Dimension: Style: @) in ) out cin din
Signal: |d(t] | Assign

d | . tflange b tflange a
[
value =d(t)
Tcon: :Use default v:

The ports will be displayed in this arrangement when you generate the custom component
in MapleSim.
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Checking Dimensions

This step is optional.

1. Open the Dimensional Analysis section and click the Check Dimensions button. Algeb-
raic expressions in the system equations that are dimensionally inconsistent are displayed
in the math-container.

2. To correct the dimensions, go to the Variables section of the template and then assign
the following dimensions for the system variables in the Type column:

* For c(t), enter Force/Distance.
+ For d(t), enter Force/Velocity.
» For F(t), enter Force.

» Fors rel(t), enter Length.

» For v_rel(t), enter Velocity.

3. Click the Refresh All button. The algebraic expressions Force/Distance and
Force/Velocity are converted to the corresponding Modelica types, TranslationalSpring-
Constant and TranslationalDampingConstant, respectively (you could have entered
these directly).

4. Return to the Dimensional Analysis section and click Check Dimensions. The result
should be the two equations shown below.

cinlt) = clt)

v |U’.T l""'—'|rrptcT

din(t) = d(1)

This is a benign inconsistency indicating that the real input signals cin(t) and din(t) actually
have implied units.

Generating the Custom Component

In the Component Generation section, specify the name of the custom component as
NonlinearSpringDamper.

To generate the custom component, click Generate MapleSim Component. The generated
custom component appears in MapleSim in the Components palette of the Definitions tab.
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| W Companents

‘ -
T

MonlinearSpringDamper

You can add the custom component to a model by dragging it into the Model Workspace.

Tutorial 3: Modeling a Nonlinear Damper (page 161) in Chapter 6 uses this custom com-
ponent in a model.
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4 Simulating and Visualizing a Model

In this chapter:

* How MapleSim Simulates a Model (page 91)

o Simulating a Model (page 93)

o Simulation Progress Messages (page 100)

* Managing Simulation Results and Snapshots (page 101)

» Customizing Plot Window Configurations (page 102)
 Visualizing a Multibody Model (page 108)

* Best Practices: Simulating and Visualizing a Model (page 128)

4.1 How MapleSim Simulates a Model

Modelica Description

The equations for many components in the MapleSim library are described using the Mod-
elica physical modeling language. On the other hand, the equations for multibody components
are generated by a special-purpose engine, which uses advanced mathematical techniques
to ensure that the equations are as concise and efficient as possible, and then converted to

Modelica.

For more information about Modelica, visit http://www.modelica.org

Model Description

Each component in your model contains a system of equations that describes its behavior;
these systems of equations can consist of purely algebraic equations or differential equations.
Also, a component may define any number of events, which can change the component
behavior during a simulation by enabling or disabling part of the equations in the system
or changing state values. Connections between two or more components generate additional
equations that describe how these components interact.

System Equations

The topology equations (how the components interact) as well as the terminal (component)
equations are then collected into one large system and parameter values are also substituted
in. Now, the MapleSim simulation engine has a potentially large system of hybrid differential
algebraic equations. This means that the system has differential equations with algebraic
constraints, as well as discrete events.

91
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Simplified Equations

A process called index reduction reduces the algebraic constraints as much as possible. At
the core of this phase is an algorithm that constructs an index-1 DAE system, modified with
other symbolic simplification techniques, to reduce the number of equations and variables.
Many of these techniques deal with handling of hybrid systems.

You can set initial values for some of the variables by specifying parameter values for certain
components in the Inspector tab on the right side of the MapleSim window. If the specified
initial conditions are not consistent, an error will be detected during the simulation.

Integration and Event Handling

When all of these preprocessing steps are complete, the integration and event handling
process begins. Based on the solver type you chose, a sophisticated DAE solver numerically
integrates the system of equations. For the variable solver, algebraic constraints are constantly
monitored to avoid constraint drift, which would otherwise affect the solution accuracy.
For fixed solver type. algebraic constraints are monitored at each fixed time step.

During integration, inequality conditions that are part of the model are monitored and an
event is triggered when one or more of these conditions change. Whenever such an event
is encountered, the numeric solver stops and the simulation engine computes a new config-
uration of the system of equations based on the event conditions. This step also involves
recomputing initial conditions for the new system configuration. The solver is then restarted
and continues to numerically solve the system until another event is triggered or the simu-
lation end time is reached.

Note: Event handling occurs for both variable and fixed step solvers. The difference is that
for fixed step solvers, events are only processed at fixed time steps, whereas with a variable
solver, the solver will adjust the time step so that events are processed at exactly the time
they occur during the integration.

Simulation Results

In the last step of the simulation process, the results are generated and displayed using
graphs showing the quantities of interest and, optionally for multibody mechanical systems,
a 3-D animation.
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The simulation process is summarized in the following chart:

Modelica
Description

v

Model
Description

v

System
Equations

v

Simplified
Equations

v

[ Initialization |

v

Integration
and
Event Handling

v

Simulation
Results

Figure 4.1: Simulation Process

Note that the information in this section is a simplified description of the simulation process.
For more information on the DAE solvers used by the simulation engine, see the
dsolve,numeric topic in the Maple Help system.

4.2 Simulating a Model

To view the behavior or response of physical properties (for example, current or voltage),
add probes to connection lines, ports, or components in your 2-D or 3-D model. In
MapleSim, probes allow you to identify the variables of interest that are associated with
connection ports.
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If you add a probe to measure a through variable, an arrow appears to indicate the direction
of the positive flow in the Model Workspace.
Probe1

Speed, Torque

' ' ST —
¥ =) et

™y

Iz

You can specify the simulation duration, the type of solver to use, and other parameter
values for the solver, simulation engine, and 3-D Workspace. After running a simulation,
a graph appears for each specified quantity.

You can change the original probe or parameter values and run another simulation to compare
the results.

For an example of sign convention and how arrow direction represents a force acting on
the model, under the Libraries tab, browse to the Examples > User's Guide Examples >
Chapter 4 menu, and then open the Constant Acceleration, Sign Convention and Arrow
Convention examples.

Simulation and Advanced Simulation Settings

The parameters used for your simulation are found under the Settings tab in the Parameters
pane. From here you can access the Simulation and Advanced Simulation settings sections.

For a description of the Multibody and 3-D Visualization settings see 3-D Visualization
and Multibody Settings (page 108).

Simulation Settings

In the Simulation section you can specify the simulation duration time, the number of plot
points, the solver, and other parameters specific to the solver. See Table 4.1 for a listing
and description of the parameters available in the Simulation settings section.
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Table 4.1: Simulation Settings

Parameter Default Description

The duration time of the simulation. You can specify any
positive value, including floating-point values.

10s Note: The duration time is not the same as the end time of
your simulation. The end time for the simulation is given
by ¢4 + t,, where ¢ is the start time for the simulation (see
Table 4.2).

The type of solver to use for the simulation.

* Variable: use a variable time step to maintain error
tolerances.

Solver Type Variable « Fixed: use a fixed time step and disregard integration

€rror.

Note: The fixed step solvers are identical to those used by
MapleSim's exported code.

DAE solver used during the simulation. The following
choices are available when Solver Type is set to Variable.

* CK45 (semi-stiff): use a semi-stiff DAE solver (ck45
method).

* RKF45 (non-stiff): use a non-stiff DAE solver (rkf45
method).

* Rosenbrock (stiff): use a stiff DAE solver (Rosenbrock

. method).
Variable: CK45

(semi-stiff)  |[If your model is complex, you may want to use a stiff DAE
Solver solver to reduce the time required to simulate a model.

The following choices are available when Solver Type is

Fixed: Euler set to Fixed.
* Euler: use a forward Euler solver.

* Implicit Euler: use an implicit Euler solver (suitable for
stiff systems).

+ RK2: use a second-order Runge-Kutta solver.
* RKS3: use a third-order Runge-Kutta solver.
* RK4: use a fourth-order Runge-Kutta solver.

The limit on the absolute error tolerance for a successful
_s integration step if you are using a variable solver to run the
abs 1-10 simulation. You can specify a floating-point value for this
option.
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Parameter Default Description
The limit on the relative error tolerance for a successful
¢ _s integration step if you are using a variable solver to run the
rel 1-10 simulation. You can specify a floating-point value for this
option.

Uniform size of the sampling periods if you are using a
Step size 0.0010 fixed-step solver to run the simulation. You can specify a
floating-point value for this option.

Minimum number of points to be plotted in a simulation.
The data points are distributed evenly according to the
simulation duration value. You can specify a positive
integer. Additional points can be added for events (see Plot
Events in Table 4.2).

The simulation engine uses a 'Plot points' value which is a
maximum of:

+ the 'Plot points' setting or

Plot Points 200 * '3D Sample Rate' [fps] * simulation duration (if ‘3-D
Animation’ is enabled), or

+ '3D Sample Rate' [fps] * '3-D Playback Time' (if ‘3-D
Animation’ is enabled and '3-D Playback Time' is
specified)

Note: This option allows you to specify the number of points
for display purposes only. The actual number of points used
during the simulation may differ from the number of points
in the simulation graph.

Advanced Simulation Settings

In the Advanced Simulation section you can specify the simulation start time, a state

snapshot to use, compilation options, and other settings. Some of these settings are specific
to the solver type (variable or fixed) selected in the Simulation settings. See Table 4.2 for
a listing and description of the parameters available in the Advanced Simulation settings.
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Table 4.2: Advanced Simulation Settings

Parameter

Default

Solver
Type

Description

All

The simulation start time. You can specify any
floating-point value, including negative values.

Note: The simulation start time affects the end time of
your simulation, but not the duration time for the
simulation, #4. The end time for the simulation is given

by td + ts'

Use Snapshot

None

All

A snapshot captures the state of your simulation at a
specific time. If you use a snapshot in your simulation,
you can override the initial conditions used in your
model and replace them with the state your model was
in at the time of the snapshot.

See Managing Simulation Results and
Snapshots (page 101) for more information on snapshots.

Baumgarte

All

Apply Baumgarte constraint stabilization to your model.
Select to enter values for the derivative gain (alpha) and
the proportional gain (beta) that are appropriate for your
model.

Jacobian

Symbolic

All

Choose between a symbolic or numeric approximation
to the system Jacobian. A symbolic formulation results
in faster and more accurate simulations but can take
longer to formulate.

Note: A numeric formulation can only be used with stiff
solvers (Rosenbrock or Implicit Euler).

Projection

All

Apply constraint projection to your model. Select to
project back the solution found at each step of the
simulation to the constraint manifold. The projection
ends when either the maximum number of Projection
Iterations is reached or the defection falls below the
Projection Tolerance.

Projection
Iterations

50

All

The maximum number of constraint projection iterations.

Note: This parameter is only available when Projection
is selected.

Projection
Tolerance

0.000010

Fixed

The tolerance value at which the projection iterations
are terminated. You can specify any positive
floating-point value.
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Solver

Parameter | Default Description
Type
Select to have constraint projection occur during event
iterations, but with slower integration results. Not
Event . . . . o
L 7 Fixed [selecting, may cause the simulation to fail if the event
Projection . . .
changes the solution to the point of not allowing the
application of constraint projection at the next step.
Event The maximum number of event iterations allowed before
lterations 100 All the integrator throws an error. You can specify any
positive integer value.
Event The width of the event hysteresis band. You can specify
. 1.0107 Fixed |afloating-point value greater than or equal to zero. If
Hysteresis . -
set to zero, this parameter is disabled.
When selected, error control is applied to all algebraic
Index 1 Error Variable variables. By default, error control is only applied to
Control algebraic variables that trigger events, are plotted, or are
outputs of functions.
Controls the relative error on algebraic variables
Index 1 10 Variable compared to differential variables. For example, a value
Tolerance ' of 10 means that algebraic variables can have 10 times
the error of differential variables.
. The width of the event hysteresis for all event triggers
Initial 10 . . . .
Hvsteresis 1.0 10 Variable |at the start of the simulation. You can specify a
Y floating-point value greater than or equal to zero.
Specifies the method of variable scaling to apply to the
system. The available choices are:
* None: do not apply scaling
Scaling None Variable |* Minimum: use the minimum nominal value
* Maximum: use the maximum nominal value
» Geometric: use the geometric mean of the nominal
values
This option specifies whether or not to use heuristics to
Minimize . reduce the number of events encountered during your
Variable | . . . . .
Events simulation. When selected, the mapping of piecewise
transitions into events does not occur.
When selected, the simulation generates diagnostics
describing constraint iterations, constraint residual, event
iterations, and step size, and plots them after the
Solver . L . . .
. . All simulation is complete in a Solver Diagnostics plot
Diagnostics

configuration in the Simulation Results tab. For systems
with the projection option cleared, this incurs additional
computational cost.
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Parameter | Default Solver Description

Type

Specifies whether or not to include extra plot points at

Plot Events Variable . . . .
v ’ event points during the simulation.

Specifies whether a native C compiler is used during the
simulation. When this option is selected, Maple
procedures generated by the simulation engine are
translated to C code, which is compiled by an external

Compiler 7 Variable .
C compiler.

If your model is complex, you may want to select this
option to reduce the time required to run a simulation.

Optimize the code during compilation. If this parameter
7 All is not selected, compile time will be reduced but your
simulation will take longer to run.

Compile
Optimized

Editing Probe Values

In the Project tab, open the Model Tree palette, and then select Probes from the list. This
lists all of the probes that you have added to the current MapleSim model.

W Model Tree
Find: D
Probes -

Probe1 (Main)
Probe2 (Main.Monlinear Damper 1)

If a probe is attached at the top level of your model, Main appears in parentheses beside
the probe name; otherwise, the subsystem for the attached probe appears beside the probe
name. In the image shown above, two probes have been attached to a model: Probel is at
the top level of the model and Probe2 is in a subsystem called Main.Nonlinear Damper1
(that is, the Nonlinear Damper1 subsystem in Main).

You can click the entries in this palette to browse to a probe in the Model Workspace, and
view and edit the probe values in the Inspector tab. You can also right-click (Control-click
for Macintosh) entries in this palette and manipulate probes using context menus.

For more information, see Using MapleSim > Simulating a Model > Using Probes >
Editing Probe Values in the MapleSim Help system.

Storing Parameter Sets to Compare Simulation Results

You can store a group of parameter values that are assigned to a model in a parameter set.
You can then run a simulation using one parameter set, replace those parameter values with
another parameter set, and run another simulation to compare the results.
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For more information, see the Using MapleSim > Building a Model > Using Parameter
Sets > Saving and Applying Parameter Sets section in the MapleSim Help system.

4.3 Simulation Progress Messages

During a simulation, you can view progress messages in the Console pane located below
the Model Workspace. These messages indicate the status of the MapleSim engine as it
generates a mathematical model; these messages can help you to debug simulation errors.
Messages for each step of the simulation are placed in their own section (for example,
Generating Equations or Computing Initial Values). When a new step starts, the preceding
section is automatically collapsed. To see the messages for a section, expand the section by
clicking on the gray arrow for that section. Alternatively, use the arrow keys to navigate
the Console pane:

* Press the Right Arrow key to expand a section.
* Press the Left Arrow key to collapse a section.
* Press the Down Arrow key to move to the following section.

* Press the Up Arrow key to move to the preceding section.

k 4 NonlinearDamperwithLinearSpring Simulation Started Mar 11, 2015 1:41:08 PM
> Generating Equations

> Processing Equations

> Computing Initial Values

> Preparing For Integration

> Integrate

k4 Summary

Found Model Libraries (63ms)

Finished generating equations (484ms)
Finished processing equations (47ms)
Finished computing initial values (47ms)
Finished preparing for integration (156ms)

Finished integrating (15ms)

Simulation completed E

Figure 4.2: Simulation Results Progress Messages

Optionally, before running a simulation, you can specify the amount of detail in progress
messages by clicking Message Console () at the bottom of the MapleSim window and
selecting a level from the drop-down menu.

Verbose -
| |

Marmal

Verboze

To clear the messages from the console, click Clear Console ([ X).
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4.4 Managing Simulation Results and Snapshots

The Stored Results palette in the Simulation Results tab allows you to view, save, and
export results generated from multiple simulations. In addition, for each of your stored
results, you can save and export snapshots that record all of the state variables for your
model at a particular time during the simulation.

Storing Results

Whenever you simulate a model, the results are saved as Latest Results in the Stored
Results palette. This entry contains all the graphs, progress messages, and (if applicable)
the 3-D animation generated from your simulation. However, each new simulation overwrites
the results stored in the Latest Results entry.

To store a simulation result under a new name, right-click (Control-click for Macintosh)
on the Latest Results entry, select Save from the context menu, and then provide a name
for the stored result. You can save simulation results to compare and refer to multiple graphs
generated during the current MapleSim session.

W Stored Results

=I-}r\ 2DRigidSliderCrank-AnimationExam
e o Latest Results
te SecondRun

If you save the stored result and then save your model, when you open the model in a future
MapleSim session, the stored result will be available in the Stored Results palette. However,
Latest Results is not saved when you close and reopen the model.

Saving and Using Snapshots

You can save the state information by taking a snapshot of your simulation at a particular
time and saving the snapshot as part of a stored result. Saving a snapshot allows you to use
the state information in subsequent simulations. Manage snapshots, including creating new
snapshots and selecting a snapshot to use in the next simulation, through the Advanced
Simulation settings (see Table 4.2).
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¥ Advanced Simulation

1'5 0 5 -
5 Use Runl: Maximum current { 1.30000) |«
Snapshot
&G K O

Figure 4.3: Snapshots in the Advanced Simulation Settings

When you use a snapshot in this way, the information recorded in the snapshot provides
the initial conditions for subsequent simulations.

When no snapshot is selected for use in simulation, the Run Simulation icon in the toolbar

is I* . When a snapshot is selected for use in simulation, the Run Simulation icon changes
to p. When a snapshot is used in a simulation, that information is available in the tooltip
of the resulting entry in the Stored Results palette.

v LateEResults || ‘ —- ” ‘

Sep 24, 2014 2:16:06 PM

93.0KE

Start time: 0.0

Simulation Duration: 5.0

Used Snapshet Runl : Maximum current

Figure 4.4: The Stored Results Palette and Snapshots

For more information, refer to the Using MapleSim > Simulating a Model > Managing
Simulation Results > Managing Simulation Snapshets section of the MapleSim Help
system.

4.5 Customizing Plot Window Configurations

By default, probed quantities are plotted in separate simulation graphs in a plot window
called Probe Plots. In each graph, the quantity values are plotted along the y-axis versus

the simulation time values along the X-axis.

You can optionally create custom plot window configurations. You might want to create a
custom plot window if, for example, you want to compare multiple quantities in the same
graph, plot one quantity versus another, or view a simulation graph for a specific quantity
without editing other probe values. You can even compare quantities from two different
models. You can further customize a plot window by for instance customizing plot titles
and specifying the number of columns to appear in the plot window.
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For details on creating a plot window, refer to Generating a New Plot Window Configur-
ation. For more information on plot windows, refer to the Using MapleSim > Simulating
a Model > Working with Plot Window Configurations section of the MapleSim Help
System.

When you create a new plot window, it will be populated with data without having to run
the simulation again.

Tip: When you save and reopen a model with stored results, the plots may initially show
the message No data available. You can load the plots by right-clicking on an entry in the
Stored Results palette and selecting Show Probe Plots.

If you want to work with your simulation data in another application, you can export your
results to a Microsoft Excel (.xls) or comma-separated value (.csv) file. For details, refer
to Exporting Simulation Graph Data.

In the following examples, you will create custom plot window configurations.

Example: Plotting Multiple Quantities in Individual Graphs

In this example, you will view the Probe Plots and then create a plot window configuration
in which you will add a second variable to each custom plot.

To view the Probe Plots:

1. Under the Libraries tab, browse to the Examples > Physical Domains > Multibody
menu, and then click the Double Pendulum example.

2. Click Run Simulation (B ) in the Main Toolbar. The Visualization Window opens
with the Simulation Results tab selected. The the 3-D Playback Window and the Probe
Plots are in the Simulation Results tab. See Figure 4.5.
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Figure 4.5: Simulation Graphs

To create a custom plot window configuration:

1.

In the Plot Windows palette, double-click on the following plots to hide them from view:
Outputl.w, Output2.a, Output2.phi, Output2.w. The plots window should now show just
two plots, Outputl.a and Outputl.phi.

. Click the Duplicate the Plot Window button ().

. Enter the name Acceleration and Angle Comparison in the Duplicate Plot Window

dialog box. Click OK. A new plot window with the name Acceleration and Angle
Comparison is created containing the currently visible plots.
Tip: To return the Probe Plots to its original view, right-click on Probe Plots in the Plot

Windows palette and select Show All Plots.

. In the plots window, select the plot Outputl.a from the Acceleration and Angle

Comparison plot window.

. In the Variables palette, under Qutput2, select a.

+
. Click Add Selected Variable to Selected Plot (). The plot now shows two curves,

Outputl.a and Output2.a.
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7. In the plots window, select the plot Outputl.phi from the Acceleration and Angle
Comparison plot window.

8. In the Variables palette, under Output2, select phi.

+
9. Click Add Selected Variable to Selected Plot (). The plot now shows both curves.

10. In the Plot Windows palette, under Acceleration and Angle Comparison, right-click
on Outputl.a (the name of the first plot), and select Rename.

11. Enter the name Acceleration (a). This changes the title of the plot.

12. In the Plot Windows palette, under Acceleration and Angle Comparison, right-click
on Outputl.phi (the name of the second plot), and select Rename.

13. Enter the name Angle (phi).

The resulting plots are shown in Figure 4.6.
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Figure 4.6: Custom Plot Window

Example: Plotting One Quantity versus Another

In this example, you will create a custom plot window to plot the X and Y position of each
of the links of a double pendulum.
To plot one quantity versus another in a custom plot window:

1. Under the Libraries tab, browse to the Examples > Physical Domains > Multibody
menu, and then click the Double Pendulum example.

2. In the Model Workspace toolbar, click Attach Probe ( 4).
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. Click the right port of the L; shared subsystem.
. Click on an empty area of the Model Workspace to position the probe.
. Inthe Inspector tab, label this probe FirstLink, and then select Length[1] and Length[2].

AN L A~ W

. Add another probe that measures the Length[1] and Length[2] quantities to the right
port of the L, shared subsystem, and label this probe SecondLink.

7. Click Run Simulation (b ) in the Main Toolbar. The Visualization Window opens,
displaying the Probe Plots in the Simulation Results tab.

8. We want the plots window to only show two plots, FirstLink.r_0[2] and Second-
Link.r_0[2], which will be the basis for creating a new plot window configuration. In
the Plot Windows palette, double-click on the names of the other plots to hide them
from view.

\/
9. Click the Duplicate the Plot Window button ( M ).

10. Enter the name X versus Y. in the Duplicate Plot Window dialog box. Click OK. A new
plot window with the name X versus Y is created containing the currently visible plots.
Tip: To return the Probe Plots to its original view, right-click on Probe Plots in the Plot
Windows palette and select Show All Plots.

11. In the Plot Windows palette, under X versus Y, right-click on FirstLink.r_0[2] (the
name of the first plot), and select Rename.

12. Enter the name Top Link. This changes the title of the plot.

13. Similarly, change the name of the plot SecondLink.r_0[2] to Bottom Link.

14. In the plots window, select the plot Top Link from the X versus Y plot window.
15. In the Variables palette, select FirstLink: r_0[1].

X
16. Click Place Selected Variable on x-Axis (|=—)).
17. In the plots window, select the plot Bottom Link from the X versus Y plot window.
18. In the Variables palette, select SecondLink: r_0[1].

X
19. Click Place Selected Variable on x-Axis (|==!|).

20. In the Plotting Toolbar, use the slider to change the number of plot columns to 1.
The resulting plots are shown in Figure 4.7.
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Figure 4.7: Plot One Quantity Versus Another

The plots above show the motion of the end point of each link in the pendulum. The bottom
link follows a more disorderly path because of the interaction with the top link.
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4.6 Visualizing a Multibody Model

In MapleSim, the 3-D visualization environment allows you to build and analyze 3-D
graphical representations of multibody systems. As you build a model and change its para-
meters, you can validate the 3-D configuration of the model and visually analyze your
simulation results. You can build 3-D models by dragging and connecting objects in the 3-
D Workspace, and you can visualize your simulation results by playing animations that
depict the movement of the objects.

As you build a block diagram in the Model Workspace, the corresponding changes are
automatically reflected in the 3-D representation in the 3-D Workspace. Similarly, when
you build a model in the 3-D Workspace, the corresponding changes are automatically re-
flected in the block diagram in the Model Workspace. Changes that you make in either of
the workspaces are shown in both the Model Workspace and 3-D Workspace as you edit
your model.

In the 3-D Workspace, you can view your model from any direction. Also, you can attach
3-D shapes to parts of your model to create a realistic-looking system representation. These
shapes can either be imported from an external CAD file or selected from the Multibody
> Visualization palette in the Libraries tab.

After simulating your model, you can animate your 3-D model in the 3-D Playback Window.
You can control playback options to focus on specific components and their motions, for
instance by specifying camera tracking options to center an object in the 3-D Playback
Window during an animation. You can also attach trace lines to show where components
move during an animation.

CAD geometry and visualization shapes are drawn transparent in the 3-D Workspace and
non-transparent in the 3-D Playback Window.

For more information about adding 3-D shapes and using the 3-D Workspace, see the Using
MapleSim > Visualizing a Model section of the MapleSim Help system.

3-D Visualization and Multibody Settings

The parameters used for 3-D visualization of multibody mechanical components are found
under the Settings tab in the Multibody and 3-D Visualization sections.
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3-D Visualization Settings

You can specify the following 3-D Visualization values for models containing multibody

mechanical components:

Table 4.3: 3-D Visualization Parameter Values

Parameter

Default

Description

3-D Animation

Specifies whether a 3-D animation is generated after running
a simulation. When this option is cleared, no 3-D animation
is generated.

If your model is complex and if you do not plan on animating
your model, you may want to clear this option to reduce the
time required to run a simulation.

3-D Playback
Time

Specifies the playback duration of the 3-D animation in
seconds. This value differs from the t4q value, which in
comparison specifies the simulation duration represented in
your simulation graphs. You can specify a floating-point value
for this option when the 3-D Animation field is selected.

You can specify a value in this field to increase or decrease
the speed at which an animation is played. For example, if the
tq value is set to 0.5 seconds, you can set the 3-D Playback
Time value to 10 seconds to slow down the animation; an
animation of the 0.5 second simulation would then be played
back over a span of 10 seconds in real time.

If no value is specified in this field, the 3-D Playback Time
value is the same as the value entered in the t4 field: an
animation of a 10 second simulation, for example, would be
played back over a span of 10 seconds in real time. The
number of frames represented in an animation is determined
by the value specified in the Plot Points field, and the 3-D
Playback Time value multiplied by the 3-D Sampling Rate
value.

3-D Sampling
Rate

40

Number of frames per second to include in the 3-D animation
playback. You can increase this value to create an animation
with smoother playback. You can specify a positive integer
for this option when the 3-D Animation field is set to true.

The default value is 40 fps for new models.

Enable
Translational
Snapping

When selected, components are positioned at the closest
location in 3-D space based on the translation snap delta value.

Translation Snap
Delta

1.0

Specifies the translation snap delta spacing.
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Parameter Default |Description
Enable Rotational When selected, components are positioned at the closest
Snapping location in 3-D space based on the rotation snap delta value.
gc;ﬁl;lon Snap 0.785398163 |Specifies the rotational snap delta spacing.

. . Specifies the size of the grid drawn in the perspective view.
Perspective Grid 10.0 The grid extends this distance in both directions on the
Extent .

horizontal plane.
Grid Spacing 1.0 Specifies the space between grid lines.
Implicit geometry consists of spheres and cylinders
. representing multibody components in the 3-D Workspace.
Base Radius 0-1 Cylinders are drawn using Base Radius, while spheres (for
Rigid Bodies and Joints) are drawn using Base Radius * 2.
. When enabled, a smooth transition occurs when switching
Enable View . . .
Change = between 3-D orthographic and perspective views and when
Animi tions using Fit Scene, Fit Selected, or Fit Animation in the 3-D
Workspace and 3-D Playback Window.
Multibody Settings

You can specify the following parameter values for models containing multibody mechan-

ical components:

Table 4.4: Multibody Parameter Values

Parameter Default |Description
e g [0,-1,0] |Direction of gravity.
The acceleration due to gravity at the surface of the Earth.
9.81
o The default units are in %
The 3-D Workspace

The 3-D Workspace is the area in which you build and view 3-D models in the MapleSim

window. It is found in the 3-D Construct tab of the Visualization Window.

To open 3-D Workspace:

* From the View menu, select Show 3-D Construct Window... The Visualization Window
opens showing the 3-D Workspace. Alternatively, from the MapleSim main toolbar, click

Show 3-D Construct Window (£% ).
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Visualization Window
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Figure 4.8: 3-D Workspace

Table 4.5: 3-D Workspace Controls

Component Description

The area in which you build and view a 3-D model. The arrows at
the origin indicate the directions of the world axes and are
designated by color:

X -red

.

3-D Workspace H‘\N‘ / Y - green

Z - blue

You can use the grid as a reference to determine the relative sizes
and positions of elements in your 3-D model.

Contains tools for hiding and displaying components in the 3-D
3-D Toolbar Workspace, toggling between different modes, selecting camera
navigation tools, and changing the 3-D model view.

Part of the 3-D toolbar, these are controls for building and
assembling a 3-D model, and connecting 3-D objects.

Construct Mode Controls

You can hover your mouse pointer over any of the buttons on the toolbar to view its tooltip.

Viewing and Browsing 3-D Models

In the 3-D Workspace, you can view and browse a 3-D model from the perspective view
or one of the orthographic views using the 3-D View Controls tool.
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Figure 4.9: 3-D View Controls

The perspective view allows you to examine and browse a model from all angles in 3-D
space. It allows you to see 3-D spatial relationships between elements in your model. In the
perspective view, objects that are closer to the camera appear larger than those that are further
away from the camera.

In the following image, a double pendulum model is shown from the perspective view.

Figure 4.10: Perspective View Double Pendulum

You can also view your 3-D model from front, top, and side orthographic views. Orthographic
views use parallel projection as opposed to perspective projection, so your 3-D model appears
as a flattened object because no depth information is shown. Orthographic views are
sometimes referred to as "true length" views because they display undistorted lines and
distances in the view plane that is orthogonal to the camera direction; these views are useful
for analyzing spatial relationships or clearances between objects.

In the following image, the double pendulum model is shown from the top orthographic
view.
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—R————

Figure 4.11: Orthographic View Double Pendulum

You can browse a model and change the model view while an animation is static or playing.
In all of the views, you can pan and zoom into or out from your model. In the perspective
view, you can also move the camera to view your model from above or below, and from
any direction around your model.

Tip: Before panning, zooming, or moving the camera around a large 3-D model, hover your
mouse pointer over the object that you want to focus on. MapleSim adjusts the navigation
controls according to the object on which you place the mouse pointer.

Adding Shapes to a 3-D Model

Adding Implicit Geometry

By default, basic spheres and cylinders called implicit geometry appear in the 3-D Workspace
to represent physical components in your model. For example, consider the following double
pendulum model, which contains two revolute joints and two subsystems that represent
planar links.

Probe1 QProbeE
! phi,w, i i, w, 3
et . " \.‘
L o

In the 3-D Workspace, the implicit geometry of the fully assembled pendulum model appears
as follows.
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Figure 4.12: Implicit Geometry Double Pendulum

In this example, the spheres represent the revolute joints and rigid bodies, and the cylinders
represent the planar links.

Implicit geometry that is not connected to other implicit geometry is drawn in a light gray
color; implicit geometry that is assembled is drawn in a dark gray color, with the exception
of joint objects, which are drawn in red.

Note: Components that you exclude from a simulation in the Model Workspace do not
appear in the 3-D Workspace.

Adding Attached Shapes

If you want to create a more realistic representation of your model, you can add shapes and
lines called attached shapes to your model. To do so, you first add and connect attached
shape components from the Multibody >Visualization palette to your block diagram in
the Model Workspace.

When you simulate your model, the attached shapes appear in the 3-D Workspace, in addi-
tion to the implicit geometry. In the following image, attached shapes have been added to
represent the pendulum stem and bob pictorially. Also, a trace line—the curved line in the
image—can be set to depict the locus of points that will be traced by a particular part of the
model during a simulation.

Figure 4.13: Attached Shapes
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You can customize the color, size, scale, and other visual aspects of the attached shapes by
setting parameter values for individual components in the Settings tab before simulating
the model.

If you want to view only the implicit geometry in the 3-D Workspace, you can hide the
attached shapes by clicking Show/hide attached shapes (# ) in the 3-D Toolbar. If you
want to view the attached shapes only, you can hide the implicit geometry by clicking

Show/hide implicit geometry ().

For more information about attached shape components, see the MapleSim Component
Library > Multibody > Visualization > Overview in the MapleSim Help system.

Note: If your model contains Flexible Beam components, deflection of the beam will not
be depicted in the implicit geometry of your 3-D model.

Example: Adding Attached Shapes to a Double Pendulum Model

In the following example, you will add cylinder shapes to represent the pendulum stem and
a sphere component to represent the pendulum bob. You will also add a Path Trace com-
ponent to display the path on which the revolute joint will move during an animation.

To add attached shapes

1. Under the Libraries tab, browse to the Examples > Physical Domains > Multibody
menu, and then click the Double Pendulum example.

2. Expand the Multibody palette and then expand the Visualization menu.

3. Add two Cylindrical Geometry components below the planar link subsystems in the
Model Workspace.

4. Connect the components as shown below.

Qutputi QOutput2
F 1 phi, w, a | phi, w, a
4 } :
. - L] '] L]
] Q o Q o
R) L '7L‘ R iy '75
— - — -
c c

5. From the same menu, add a Spherical Geometry component and place it to the right of
the L, shared subsystem.
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6. Right-click (Control-click for Macintosh) the Spherical Geometry component and select
Flip Horizontal.

7. Add a Path Trace component and place it between the two Cylindrical Geometry
components.

8. Connect the components as shown below.

Output1 QOutqu
F ! phi, w, a E phi, w, a
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9. Select the first Cylindrical Geometry component (C; in the previous figure) in the
Model Workspace.

10. In the Inspector tab on the right side of the MapleSim window, change the radius of the
cylinder to 0.2.

11. To select a color for the cylinder, click the box beside the color field and click one of
the color swatches.

12. Select the second Cylindrical Geometry component (C, in the previous figure) in the
Model Workspace.

13. Change the radius of this cylinder to 0.2 and change the color.

14. Select the Spherical Geometry component (S; in the previous figure).
15. Change the radius of the sphere to 0.8 and change the color.

16. To simulate the model, click Run Simulation (b ) in the Main Toolbar.

When the simulation is complete, the Visualization Window opens with the Simulation
Results tab selected. The 3-D Playback Window displays your model with the attached
shapes.
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17. To animate the model, click Play (F¥) in the 3-D Playback Window.

For another example of how to use the Path Trace component, under the Libraries tab,
browse to the Examples > User's Guide Examples > Chapter 4 menu, and then open the
Lorenz Attractor example.

Building a Model in the 3-D Workspace

You can build MapleSim models by adding and connecting objects in the 3-D Workspace.
To add multibody components to a 3-D model, put the 3-D Workspace beside the main
MapleSim window, then drag the desired components from the Multibody palette, the Fa-
vorites palette, a custom library that you created, or from the search pane in the Libraries
tab to the 3-D Workspace.

In the 3-D Workspace, you can add, connect, and lay out 3-D objects, and set initial condi-
tions for joints and other multibody components by using graphical controls in the 3-D
Workspace.

Any changes that you make to your 3-D model are automatically shown in the block diagram
representation in the Model Workspace and vice versa. For example, if you add and connect
a Flexible Beam component in the3-D Workspace, the block diagram representation of
the Flexible Beam with the added connection lines appear in the Model Workspace at the
same time.

Notes:

* Subsystems cannot be created in the 3-D Workspace. They must be created in the
Model Workspace.

» Components from the multibody Forces and Moments, Sensors, and Visualization
component libraries cannot be dragged into the 3-D Workspace. You must add these
components in the Model Workspace.

Moving Objects in the 3-D Workspace

In the 3-D Workspace, you can position individual objects or groups of objects by clicking
and dragging the 3-D manipulators.

To display the 3-D manipulator for a single unconnected object, click the object once in the
3-D Workspace. You can then click and drag the blue arrow of the 3-D manipulator to
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move the object along the Z axis, the green arrow to move the object along the Y axis, and
the red arrow to move the object along the X axis. You can also click and drag the sphere
at the center of the 3-D manipulator to move the object in all directions.

For a group of connected objects, the configuration of your model determines where the 3-
D manipulators are located.

 Ifyour 3-D model contains a Fixed Frame component, click the square that represents
the Fixed Frame component to display the 3-D manipulator.

* If your model does not contain a Fixed Frame component, click the object that defines
the initial conditions for your system to display the 3-D manipulator. For example, if
your model contains a Rigid Body component with its initial condition parameters set
to Strictly Enforce, that Rigid Body component displays the 3-D manipulator. When a
model is moved in the 3-D Workspace, the initial conditions are updated for all of the
other Rigid Body components that depend on the Rigid Body component that has its
initial conditions set to Strictly Enforce.

* If your model does not contain a Fixed Frame component or a Rigid Body component
with its initial conditions set to Strictly Enforce, click any of the objects in your 3-D
model to display the 3-D manipulator. When you move the group of objects, the initial
conditions of all of the multibody components in your model are set to Treat as Guess.

Note: To display 3-D manipulators, the multibody components in your model must contain
numeric parameter values. If custom parameter values defined in a parameter block, global
parameter, or subsystem parameter are assigned to a multibody component, no 3-D manip-
ulator will appear when you click that component in the 3-D Workspace.

Assembling a 3-D Model

A 3-D model must be assembled before you can animate it. Assembling a 3-D model refers
to synchronizing the model that appears in the 3-D Workspace with the initial configuration
of your model defined by the assigned parameter values and initial condition guess values.
The synchronization process occurs automatically when you simulate your model. Altern-
atively, click Update 3-D View () in the 3-D Toolbar to assemble the model. In the 3-
D Workspace, assembled implicit geometry is drawn in a dark gray color, with the exception
of joint objects, which are drawn in red.

Note: You can only assemble 3-D models with a valid configuration and valid connection
lines. For example, if you attempt to assemble a 3-D model with missing connection lines,
an error message appears in the console pane and no animation is generated.

For more information, see Assembling a 3-D Model in the MapleSim Help system.
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Using the Unenforce Constraints Button to Manipulate Joints in the 3-D
Workspace

You can select a joint object in the 3-D Workspace and click Unenforce Kinematic

Constraints (':.'1-") to specify that the kinematic constraints of the joint are not enforced in
the 3-D Workspace as you build your model. Joints with unenforced kinematic constraints
appear in pink in the 3-D Workspace and their initial conditions are not shown in the 3-D
Workspace as you build your model.

You may want to use Unenforce Kinematic Constraints (':.'!) if, for example, you are
creating a closed-loop model in the 3-D Workspace and you need a joint to remain in a
specific position as you are building and laying out your 3-D model.

Notes:

» The unenforce constraints button does not affect the actual initial conditions specified
for your joint components in the Inspector tab; it affects the initial conditions depicted
in the 3-D Workspace for display purposes only.

+ Initial conditions for other joints with enforced kinematic constraints will be shown in
the 3-D Workspace, but will not affect related joints with unenforced kinematic con-
straints.

For example, consider a double pendulum 3-D model that contains a revolute joint with
unenforced kinematic constraints and a second revolute joint with enforced kinematic con-
straints. If you change the initial angle of the joint with enforced kinematic constraints, the
joint with the unenforced kinematic constraints will remain in its original position while
the joint with enforced kinematic constraints will be shown at the new initial angle. To
display all of the new initial conditions in the 3-D Workspace, you must assemble your

model by running a simulation or clicking Update 3-D View ( % ).

Displaying Attached Shapes as You Build a 3-D Model

When you connect Cylindrical Geometry, Tapered Cylinder Geometry, Box Geometry,
or Spherical Geometry components to your block diagram in the Model Workspace, the
corresponding attached shapes appear in both the 3-D Workspace and the 3-D Playback
Window. The attached shape appears in the 3-D Workspace after you connect all of its
ports to compatible ports of multibody components in the Model Workspace.

Working with CAD Geometry

CAD geometry can also be shown in both the 3-D Workspace and the 3-D Playback
Window. When you add a CAD Geometry component anywhere in the Model Workspace,
the corresponding CAD image appears in the 3-D Workspace regardless of whether the
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CAD Geometry component is connected to other components in your model. If a CAD
Geometry component is not connected to other components, it will be drawn at the origin
of the 3-D grid; if a CAD Geometry component is connected to another component, it will
be drawn at the origin of the coordinate frame of the modeling component to which it is
attached.

You can define the translational and rotational offset for CAD images either before or after
connecting the corresponding CAD Geometry component to your model. To define these
offsets, select the CAD Geometry component in the Model Workspace and specify para-
meter values in the Inspector tab.

Example: Building and Animating a Double Pendulum Model in the 3-D
Workspace

In this example, you will build and animate a double pendulum model. You will perform
the following tasks:

To build and animate a double pendulum:

1. Add and move objects in the 3-D Workspace.

2. Connect the 3-D objects.

3. Set initial conditions for the joints in your model.

4. Animate the 3-D model.

Adding and Moving Objects in the 3-D Workspace

To add or move an object:

1. Open a new MapleSim document.

2. From the MapleSim main toolbar, click Show 3-D Construct Window (£# ), and arrange
that window beside the main MapleSim window.

3. Under the Libraries tab, expand the Multibody palette, and then expand the Bodies
and Frames menu.

4. From the palette, drag a Fixed Frame component into the 3-D Workspace. A gray
square, which represents the Fixed Frame component, is added to the 3-D Workspace
and its 3-D manipulator appears.
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You can use this manipulator to position objects in the 3-D Workspace.

5. Position the Fixed Frame object at the origin of the grid by clicking and dragging the
3-D manipulator arrow controls.

6. From the Multibody > Joints and Motions menu, drag a Revolute component into the
3-D Workspace and place it to the right of the Fixed Frame.

— e
7. From the Multibody > Bodies and Frames menu, drag a Rigid Body Frame component

into the 3-D Workspace and place it to the right of the Revolute component.

-
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8. From the same menu, drag a Rigid Body component into the 3-D Workspace and place
it to the right of the Rigid Body Frame.

Tip: To zoom into and out from the 3-D Workspace, hover your mouse pointer over the
object that you want to focus on and rotate your mouse wheel. When zooming with the
mouse wheel, the location under the pointer remains in place, allowing you to zoom in on
that location. To pan your model, hold the Shift key and drag your mouse pointer in the 3-
D Workspace.
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9. From the same menu, drag another Rigid Body Frame component into the 3-D Work-
space and place it to the right of the Rigid Body. The components for the first pendulum
link have been added.

—
o
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10. Repeat steps 6 to 9 to add components for a second pendulum link to the right of the last
Rigid Body Frame component that you added.

Connecting 3-D Objects

You will now connect the objects that you added in the previous task.
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To connect objects:
1. Click Connect ports (-&-).
2. Hover your mouse pointer over the Fixed Frame object. A green dot appears.

S .

RHR /

-
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FF1 frame_b

3. Click the green dot once to start the connection line.

4. Hover your mouse pointer over the first Revolute joint object. The gray panel at the
bottom of the 3-D Workspace displays the names of the Revolute joint frames.

' R1frame b R1frame a
-

5. Click the Revolute joint object once. A context menu displays the names of the frames
to which you can connect the line.
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6. Select R1.frame_a. The objects are connected in the 3-D Workspace.

o

/
d

Note that the joint component is drawn in red when it is connected.
7. Click Connect ports () to start the next connection line.

8. Click the sphere that represents the Revolute joint. A context menu displays the frames
of the Revolute joint, as well as the Fixed Frame to which it is connected.

- FF1frame_bR1frame bR1frame a

9. From the context menu, select R1.frame_b.
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10. Drag your mouse pointer to the end of the cylinder that represents the Rigid Body Frame
and click the green dot.

frame_b of the first revolute joint, Ry, is now connected to frame_a of the first rigid body
frame, RBF.

11. Click Connect ports to start a new connection line.

12. Hover your mouse pointer over the other end of the cylinder that represents the RBF;
component and click the cylinder once.

13. Drag your mouse pointer to the sphere that represents the first Rigid Body component,
RB;, and click it once. RB; is now connected to RBF;.

14. In the same way, connect frame_a of RB; to frame_a of the second Rigid Body Frame,
RBF,.

Note: Click the connect button to start each connection line.

e
e

e

—_

15. Connect frame_b of the second Rigid Body Frame to frame_a of the second Revolute
joint.

16. Connect frame_b of the second Revolute joint to frame_a of the third Rigid Body
Frame.
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17. Connect third Rigid Body Frame to the second Rigid Body, and then connect the second
Rigid Body to the fourth Rigid Body Frame. The complete 3-D model appears below.

-

~
-
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/ 3

In the 2-D model workspace, you will see that all of the components are added and connected
accordingly.

Tip: As you are building a 3-D model, it is a good practice to switch to the block diagram
view periodically to check whether the block diagram is laid out the way you want.

Setting Initial Conditions for the Joint Components

You can set initial conditions for joint components by using graphical controls in the 3-D
Workspace.

Note: Joint components that have been assigned custom parameter values defined in a
parameter block, global parameter, or subsystem parameter will not allow the use of
graphical controls for setting initial conditions. In these cases, use the fields in the Inspector
tab to set the initial conditions.

To set initial conditions:

1. In the 3-D Workspace, to set the initial angle of the first revolute joint, click the sphere
that represents the first revolute joint in the 3-D Workspace. The red sphere, which
represents the joint component, is removed temporarily from the 3-D Workspace and
the manipulator for the joint appears.
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2. Hover your mouse pointer over the manipulator. The manipulator appears in yellow.

3. Click and drag your mouse pointer around the manipulator to display the meter that
represents the initial angle value that you want to set for the revolute joint. A pie graph-
shaped meter appears in orange.

T

When you drag your mouse pointer, you can adjust the initial angle value for the degree of
freedom represented by the graphic. The angle value increases if you drag the mouse
pointer up or to the right, and decreases if you drag the mouse pointer down or to the left.

4. Release your mouse button when the meter is at the approximate initial condition value
that you want. In the Inspector tab, the 8, parameter displays the value that you selected

and the implicit geometry is set to that value in the 3-D Workspace.
Tips:
 Alternatively, you can set initial conditions for your model by entering a value for the 0

parameter in the Inspector tab. Initial conditions that you specify in the Inspector tab
will be shown in the 3-D model.

» To specify precise initial angle conditions, turn on snapping by selecting Enable Rota-
tional Snapping under 3-D Visualization in the Settings tab.

Animating the 3-D Model

You will now simulate your 3-D model to generate the animation that can be viewed in the
playback window.

To animate the 3-D model:

1. Simulate your model by clicking Run Simulation (p ) in the Main Toolbar. When the
simulation is complete, the Visualization Window opens, containing both simulation
plots and the 3-D Playback Window.

2. Select the 3-D Playback Window. ( If the playback window is not visible, double-click
3-D Playback Window in the Plot Windows palette in the left pane of the Visualization
Window to view it.)

3. To play the animation, click Play (J) in the Playback Toolbar.
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Exporting a Movie of the 3-D Model

The Export Movie feature allows you to export a recorded simulation as an .mpeg file to
users who may not have MapleSim. For more information, see Using MapleSim > Visual-
izing a 3-D Model > Exporting a Simulation as a Movie in the MapleSim Help system.

4.7 Best Practices: Simulating and Visualizing a Model

This section describes best practices to consider when simulating and visualizing a model.

Use an External C Compiler to Run Simulations With Longer Durations

When you set the compiler parameter to true in the Settings tab/Solver, Maple procedures
generated by the simulation engine are translated to C code and then compiled by an external
C compiler. As a result, the time required to run a simulation can be reduced. In general,
when you use a C compiler to simulate a model, the compilation process will be faster in
simulations with longer durations.

Compare Results Generated By Sections of Your Model

For debugging purposes, you may want to view simulation results for a specific section or

subsystem in your model. By selecting a section in your model and clicking Disable (@)
above the Model Workspace or pressing Ctrl + E (Command + E for Macintosh), you
can exclude part of your model from the next simulation that you run. When you simulate
your model, results will appear only for the model sections that you did not exclude. This
feature allows you to view simulation results generated by specific sections in your model
and compare results without having to delete components from the Model Workspace or
build multiple models.

For more information, see Using MapleSim > Simulating a Model > Excluding Objects
From a Simulation in the MapleSim Help system.



5 Analyzing and Manipulating a Model

In this chapter:

* Overview (page 129)

* Retrieving Equations and Properties from a Model (page 132)

* Analyzing Linear Systems (page 133)

» Optimizing Parameters (page 135)

* Generating and Exporting C Code from a Model (page 137)

* Generating a Custom Component from External C Code/Library (page 145)
» Working with Maple Embedded Components (page 149)

» Working with a Maple Standard Worksheet (page 149)

5.1 Overview

MapleSim is fully integrated with the Maple environment. You can use Maple commands,
templates, custom components, embedded components, plotting tools, and many other
technical features to analyze and manipulate the dynamic behavior of a MapleSim model
or subsystem. For example, you can use Maple to retrieve and work with model subsystems
and equations, test input and output values, translate your model into C code, and perform
many other advanced analysis tasks. You can then attach a file of any format in the Attach-
ments palette and save it as part of a MapleSim model.

To start working with your MapleSim model in Maple, you can use the templates available
in the Create Attachment window by clicking Template ( # ) in the Main Toolbar. These
templates are Maple worksheets with pre-built tools for model building and analysis tasks:
you first create a MapleSim model and open it in one of the available templates to perform
an analysis task in Maple.

MapleSim Templates
The following MapleSim templates are available from the Main Toolbar:

Table 5.1: MapleSim Templates

Template Name UI Display Name Task

Translate your model into C code. For more
C Code Generation Code Generation |information, see Generating and Exporting C
Code from a Model (page 137)

129



130 « 5 Analyzing and Manipulating a Model

Template Name UI Display Name Task
Create a custom modeling component based on
Custom Component Template | Custom Component a mathematical model. For more information,

see Creating Custom Modeling
Components (page 69).

Custom Port Template

Custom Port

Create a custom port for a custom component.
For more information, see Creating Custom
Modeling Components (page 69).

Discrete State Space Custom
Component

Custom Discrete
State Space

Define and generate custom components for a
MapleSim model from a discrete state space
description.

Discrete Transfer Functions
Custom Component

Custom Discrete
Transfer Function

Define and generate custom components for a
MapleSim model from a discrete transfer
function.

Data Generation Template

Data Generation

Define and generate a data set to be used in
MapleSim, for example, a data set for an
interpolation table component. For more
information, see Creating a Data Set for an
Interpolation Table Component (page 61).

Equation Extraction Template

Equations

Retrieve equations from linear or nonlinear
models. For more information, see Tutorial 6:
Using the External C Code/DLL Custom
Component Template (page 197)

Excel Connectivity Template

Excel Connectivity

Import MapleSim parameter sets from, or
export MapleSim parameter sets to, an Excel
spreadsheet.

External C Code/DLL
Definition

External C/Library
Block

Define and generate a MapleSim custom
component from external C Code/DLL.

Linear System Analysis
Template

Linear System
Analysis

View and analyze the equations of a linear
system. For more information, see Analyzing
Linear Systems (page 133)

Linearization

Linearization

Create a linear system object from a MapleSim
continuous subsystem.

Custom Component Template:

Modelica Custom

Define and generate a MapleSim custom

Modelica Code Definition Component component from Modelica code.
Monte-Carlo Simulation Monte Carlo Define a random distribution for a parameter
Template Simulation and run a simulation using the distribution.
Multibody Analysis Template |Multibody Analysis ]sileitt;l‘tflve ¢ fﬁu;fnﬁiilzgifl:ﬁs ;E;;g? thatis
Analyze and edit the parameters of a model and
Parameter Optimization S view possible simulation results in a graph. For
Optimization

Template

more information, see Optimizing
Parameters (page 135)
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Template Name UI Display Name Task

Define and generate a set of random data points
Random Data Template Random Data to be used in MapleSim, for example, a data
set for an interpolation table component.

Sensitivity Analysis Sensitivity Analysis | Perform parameter sensitivity analysis.

Create a worksheet by opening a MapleSim
Model in an embedded component. For more
information, see Working with a Maple
Standard Worksheet (page 149)

Worksheet Worksheet

Alternatively, to edit and analyze a model, you can use the MapleSim application program-
ming interface (API) in a Maple worksheet, beginning with the LinkModel command, to
link to an existing MapleSim model. For more information about the MapleSim API, refer
to the MapleSim help page.

Both methods of performing analysis tasks allow you to use commands from any Maple
packages, including MapleSim and DynamicSystems, to work with your model program-
matically.

Note: After using a MapleSim template, save the .mw file and then save the .msim file to
which the .mw file is attached.

Tip: The pre-built analysis tools available in each template are Maple embedded components,
which allow you to interact with Maple code through graphical interactive components.
The code associated with each embedded component uses commands from Maple packages,
including MapleSim and DynamicSystems.

To view the code associated with an embedded component, right-click (Control-click for
Macintosh) any of the tools in the Maple worksheet, select Component Properties, and
click Edit. For more information about embedded components, see the EmbeddedCom-
ponents topic in the Maple help system.

Working with MapleSim Equations and Properties in a Maple Worksheet

When viewing and working with MapleSim equations or properties in a Maple template,
corresponding parameters, variables, connectors, subscripts and superscripts are mapped
and represented differently.

Mapping MapleSim Programmatic Names to Maple

The programmatic names of certain parameters, variables, and connectors displayed in the
Maple worksheet differ from the names displayed for the corresponding elements in the
MapleSim interface. For example, if an Inertia component is included in a model, the
parameter for the initial value of the angular velocity appears as w,in the MapleSim interface

and w_start in a Maple worksheet. For more information about the mappings of parameter,
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variable, and connector names, see the MapleSim Component Library in the MapleSim
help system.

Representing MapleSim Subscripts and Superscripts in Maple

Subscripts and superscripts in the MapleSim interface are represented differently in a Maple
worksheet. Subscripts in the MapleSim interface appear with an underscore character in a
Maple worksheet. For example, a connector called flange, in the MapleSim interface appears
as flange_a in a Maple worksheet. Also, superscripts are formatted as regular characters in

a Maple worksheet. For example, a variable called a* in the MapleSim interface would be
displayed as a2 in a Maple worksheet.

Using Subsystems

The basic structure for exporting models is the subsystem. A template allows you to select
a complete subsystem for which you want to analyze and manipulate. By converting your
model or part of your model into a subsystem you can more easily identify the set of mod-
eling components that you want to explore, define the set of inputs and outputs for the
subsystem, or identify the components that you want to export as a block component. For
best practices on creating subsystems in MapleSim, see Best Practices: Laying Out and
Creating Subsystems (page 62).

For an example of a basic structure for exporting models, under the Libraries tab, browse
to the Examples > User's Guide Examples > Chapter 5 menu, and then open the Preparing
a Model for Export example.

Note: When generating code for a subsystem, any included ports must be real input or real
output ports. When generating code for the top-level system, the system is considered to
have no inputs, but all probed values are treated as outputs.

Tip: If you want to use your complete model, group all of the components at the top level
of your model into a single subsystem.

5.2 Retrieving Equations and Properties from a Model

You can use the Equation Analysis Template to retrieve, define and analyze equations
and properties such as parameters and variables in your model. You can also set initial
equations, set the level of equation optimization and generate custom equations. By using
Maple commands you can perform detailed equation analysis, assign model equations to a
variable or parameter, and define additional system variables and parameters. The features
within this template are useful in generating reusable equations when there is more than
one subsystem.

For a complete tutorial on how to use the Equation Analysis Template, see Tutorial 7:
Using the Equations Template (page 202).
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To retrieve equations and properties

1. In MapleSim, open the model for which you want to retrieve equations or properties.
2. Click Templates ( # ) in the Main Toolbar. The Create Attachment window appears.
3. From the list, select Equations.

4. In the Attachment field, enter a name for the template and click Create Attachment.
Your model opens in the Equation Extraction Analysis Template in Maple.

5. Using the navigation tools above the model diagram, select the subsystem for which you
want to view equations. If you want to retrieve equations from the complete system,
click Main.

6. Click Load Selected Subsystem. The model equations are extracted and the system
parameters and variables are loaded. The system equations appear in the View Core
Equations area and are automatically stored in the variable DAEs.

You can now manipulate the equations using any Maple packages, for example, Dynamic-
Systems and MapleSim. For more information about these packages, see the DynamicSys-
tems and MapleSim topics in the Maple help system.

5.3 Analyzing Linear Systems

You can use the Linear System Analysis Template to retrieve, view, and analyze the
equations of a linear system, test system input and output values, and view possible simulation
results in a Bode, Nyquist, or root locus plot.

Note: Linear analysis cannot be performed on the entire system. To perform linear analysis
using the tools in the Analysis and Simulation section of the template, you must select a
subsystem.

To analyze a linear system model from MapleSim:

1. In MapleSim, open the linear system model that you want to analyze.

2. Click Templates ( # ) in the Main Toolbar. The Create Attachment window appears.
3. From the list, select Linear System Analysis.

4. In the Attachment field, enter a name for the template and click Create Attachment.
Your model is opened in the Linear System Analysis Template in Maple.

5. Using the navigation tools above the model diagram, select the subsystem for which you
want to view equations.

6. Click Load Selected Subsystem.
7. If an error dialog appears, click OK to close the dialog.
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The error informs you that no output is defined for the system. You will specify the
output for the system in the next step.

8. In the Causalize Ports section, specify the system input and output signals.

* To specify an input signal: Enter input in either the Flow Variable or Across
Variable column for a port. Alternatively, you can also enter enter 0 to have the
variable be an input with a value of zero.

* To specify an output signal: Enter output in either the Flow Variable or Across
Variable column for a port.

9. Click Load Selected Subsystem.

The linear system object is created and the equations for the system are displayed in the
View Equations section.

Parameter and Variable Manipulation (optional)

You can assign new names for the variables and parameters in your system in the Parameter
and Variable Manipulation section.

To assign a new name for a variable or parameter:

1. Enter the new name in the New Name column for the variable or parameter you want
to reassign.

2. Click Reassign Equations.

The new name is used in the equations for the system in the View Equations section.

If you want to revert to the original names, click Reset Substitutions in the DAE Variables
section.

Select Save new names for variables and parameters in the model to use the new names
for the variables and parameters in other templates associated with this model.

Analysis and Simulation

You can use the tools in the Analysis and Simulation section to analyze your linear system
and to view the effects of different inputs on the outputs of your system.

For analysis, you can use the following tools:
* Bode plot
* Nyquist plot

* root locus plot.
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In the Simulation section you can choose an input signal to apply to the system and then
see the effects on the output.

Create Component

After you have analyzed and configured your system, you can create a custom component
based on the system and attach it to your MapleSim model.

To create a custom component from your system:
1. Enter the name for your component in the Model Name text box.
2. Enter a description for your component in the Description text box.

3. Click Create.

Your custom component can be found in the Components palette of the Definitions tab of
your MapleSim model. In addition, the Linear Systems Analysis template used to create
the custom component is attached to your MapleSim model and can be found under the
Project tab, in the Attachments > Custom Components palette.

Note: If a linear system representation is already listed in the Attachments palette with the
same name, the existing file will be overwritten.

5.4 Optimizing Parameters

You can use the Parameter Optimization Template to test the model parameters, view
simulation plots, and assign parameters to a Maple procedure to perform parameter sweeps
and other advanced optimization tasks.

You can also use commands from the Global Optimization Toolbox to perform parameter
optimization tasks. This product is not included with MapleSim. For more information,
visit the Maplesoft Global Optimization Toolbox web site at

http://www.maplesoft.com/products/toolboxes/globaloptimization/.

To optimize parameters

1. In MapleSim, open the linear system model that you want to analyze.

2. Click Templates ( # ) in the Main Toolbar. The Create Attachment window appears.
3. From the list, select Optimization.
4

. In the Attachment field, enter a name for the template and click Create Attachment.
Your model is opened in the Parameter Optimization template in Maple.

5. Using the navigation tools above the model diagram, select the subsystem that you want
to analyze. Your subsystem appears in the Model Workspace.


http://www.maplesoft.com/products/toolboxes/globaloptimization/
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6. In the Parameter Investigation section of the template, click Load System. The model
simulation settings are imported.

7. In the Parameter Values section, select the parameter that you want to test from the
first choose... list.

RLR - | 9 2.400e+01 Range: ‘1.000e+00 | to |1.000e+02 ‘
[crc =) U Range: ‘0.000&+00 |to |1.000e—03 ‘
ILL - | {J 1.600e-01 Range: ‘—1.000e+00 |to |1.000e+00 ‘

[choase... = U l:l Range: ‘ | to |
choose... - | |j l:l Range: ‘ | to | ‘
:dwoose... v: U l:l Range: ‘ | to | ‘

[ Update Parameters in MapleSim Model ] Pages: 1of1

Note: When a parameter is selected, its assigned value is shown in the field next to the
slider.

RLR - { 2.400e+01 Range: |1.000e+00 |t0 |l.000e+02 |

8. In the Range fields beside the slider and parameter value field, specify the range of the
slider. By default, the range is 0 to 10 unless the selected parameter value is outside of
this range.

9. Using the process described above, select other parameters that you want to test.

When you have defined all of the parameters, you can move the sliders to test different
values and view possible simulation results in the model by clicking Update Parameters
in MapleSim Model and running your simulation in MapleSim. You can also generate
procedures by assigning the parameters you defined to a Maple procedure to perform further
analysis tasks in the Parameter Optimization section of the template.

When a procedure is generated you will be able to use that procedure, when called, to run
a simulation with the specified parameter values. The procedure returns the simulation result
as a Matrix of y+1/ values, one column for time and then one column for each probed
quantity. This procedure can also be used for parameter sweeps and optimizations.

For more information about Maple procedures, see the Procedures help topic in the Maple
help system.
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5.5 Generating and Exporting C Code from a Model

If you want to use or test your model in an application that supports the C programming
language, you can use the Code Generation Template to translate your model or a subsys-
tem in your model into C code. Access to the basic C code, and the ability to compile and
run it, is available in Maple. Extensions of this code are available for a variety of software
tools as additional Connector toolboxes.

For a general high-level overview of the MapleSim code export process, refer to Generating
Code for Export.

With the Code Generation template, you can define inputs and outputs for the system, set
the level of code optimization, generate the source code, and choose the format of the res-
ulting component and library code. You can use any Maple commands to perform task
analysis, assign model equations to a variable, group inputs and outputs, and define addi-
tional input and output ports for variables.

Note: C code generation now handles all systems modeled in MapleSim, including hybrid
systems with defined signal input (Reallnput) and signal output (RealOutput) ports.

Whenever you export code or generate equations you often only see a subset of the paramet-
ers for that model. The following parameters cannot be exported:

* Multibody parameters cannot be directly exported. Only user-generated parameters that
the multibody parameters are assigned using Inspector tab are able to be exported.

» Dependent parameters cannot be exported. If the parameter A is a function of b (A=b,
A=sin(b), A=1+3/b, etc.), then A will not be able to be exported. It will be directly sub-
stituted for in the equations as a function of b. You will be able to export b.

» Parameters that change the number of equations cannot be exported.

» Parameters for discrete values cannot be exported.

The process of generating C code from a MapleSim model consists of the following steps:
* Preparing the MapleSim model

 Attaching the code generation template

* Loading the subsystem

» Customizing, defining, and assigning parameter values to specific ports
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 Selecting the code generation options

* Generating and saving the C code

Preparing the Model for Export in MapleSim

The basic structure for exporting models is the subsystem where you define the input and
output signals from the generated code. By creating a subsystem you also improve the
visual layout of a system in the Model Workspace. The following figure shows a subsystem
with a defined input (blue arrow) and a defined output (white arrow). When generating code
for a subsystem, all ports must be defined as real input or real output ports.

C=1r
a— |

—
e

1

When generating code for the top-level system, there are no inputs, but all probed values
are considered as outputs, as shown in the following figure.

SI Probe 1
I » S value
tartTime=0.1

8 Ime- 5 RIC

Tip: If you want to generate code for your complete model, group all of the components at
the top level of your model into a single subsystem.

In addition to inputs and outputs, generated code can have user-modifiable parameters
defined for it. By default, not all parameters are selected to be modifiable in the exported
code. In general, the fewer the parameters left modifiable, the less time it will take to gen-
erate and run the exported code. By default, only parameters defined in the exported subsys-
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tem are selected to be modifiable in the generated code. In the above example, generating
code for the RLC subsystem, only the parameters R, L and C will default to being modifiable
in the exported code.

Inspector | Settings

Main

¥ Parameters

Note: Since not all parameters are modifiable in the generated code, parameters that change
the structure of the equations, by adding or removing variables from the system, are auto-
matically removed from the list of parameters that can be exported. This is true even if the
parameters are defined in the exported subsystem.

Initialization

All discrete events initialize to the same values as the corresponding MapleSim model. For
example, if a clutch is initialized as 'locked' in the MapleSim model, then the generated
code assumes that the clutch starts in the 'locked' configuration. The same is true for con-
tinuous variables and their derivatives.

Since exported code obtains its initial conditions from an initialized MapleSim model, that
code can only be exported for subsystems that are part of a model that can be simulated.

Note: If you are unable to run or initialize your model in MapleSim, you will not be able
to export code for that model or any of its subsystems.

Attaching the Code Generation Template

To attach your model into the template, click Templates ( # ) in the Main Toolbar and
select Code Generation. In the Attachment field, enter a name for the template, and then
click Create Attachment. Your model opens in the C Code Generation template in Maple.

Loading the Subsystem

This part of the template identifies the subsystems that you want to generate and export
code for. After selecting a subsystem, click Load Selected Subsystem. All defined input
and output ports are loaded.
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Customizing, Defining, and Assigning Parameter Values to Specific
Ports

The Port and Parameter Management interface lets you customize, define and assign para-
meter values to specific ports. Subsystem components to which you assign the parameter
inherit a parameter value defined at the subsystem level.

Inputs:

Input Variables Change Row
: |

Input Variables. Contains the model input variables.
Change Row. Select the equations with the specified row.

Outputs:
Toaggle Export Column

Output Variables Export  Change Row
| x|

[ Add an additional output port for subsystem state variables

Toggle Export Column. Allows you to either select or remove all of the parameters for
export.

Output Variables. Contains the model output variables.
Export. Enter "X" to select which variables you want to leave in the symbolic form.
Change Row. Select the equations with the specified row.

Add an additional out port. Select this option to add an additional port for the selected
subsystem state variable.
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Parameters:

Toggle Export Column

Parameters Value Export  Change Row
1 JCicC 0.4e-3 il
2 |[EMF1_fixed_phid 0.
3 |[EMF1_k 0.1e2 E
4 JiiL 76
5 RiR 14.1 N
& [R1T ref 300,15 i

Parameters. Contains the model parameters.

Value. Displays the value for the system parameter.

Export. Enter "X" to select which parameters you want to export in the symbolic form.
Change Row. Select the equations with the specified row.

After the subsystem is loaded you can group individual input and output variable elements
into a vector array and add additional input and output ports for customized parameter values.
Input ports can include variable derivatives and output ports can include subsystem state
variables.

Note: If the parameters are not marked for export they will be numerically substituted.

Selecting the Code Generation Options
The Generation Options settings specify the advanced options for the code generation process.

Solver Options

In this section you can specify the type of solver.

Fixed step solver; @ Euler () RE2Z  (DRK3 (D) RKE4 (D) Implicit Euler

Optimization Options

Set the level of code optimization to specify whether equations are left in their implicit form
or converted to an ordinary differential equation (ODE) system during the code generation
process. This option specifies the degree of simplification applied to the model equations
during the code generation process and eliminates redundant variables and equations in the
system.
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Level of code optimization (0=Mone, 3=Full): 0 U

Select one of the following options:

None (0): no optimization is performed; the default equations will be used in the generated
code.

Partial (1, 2): removes redundant equations from the system.

Full (3): performs index reduction to reduce the system to an ODE system or a differential
algebraic equation (DAE) system of index 1, and removes redundant equations.

Constraint Handling Options

The Constraint Handling Options specify whether the constraints are satisfied in a DAE
system by using constraint projection in the generated file. Use this option to improve the
accuracy of a DAE system that has constraints. If the constraint is not satisfied, the system
result may deviate from the actual solution and could lead to an increase in error at an expo-
nential rate.

Maximum number of projection ikerations:
Error tolerance:

| Apply projection during ewvent ikerations

Set the Maximum number of projection iterations to specify the maximum number of
times that a projection is permitted to iterate to obtain a more accurate solution.

Set the Error tolerance to specify the desirable error tolerance to achieve after the projection.

Select Apply projection during event iterations to interpolate iterations to obtain a more
accurate solution.

Constraint projection is performed using the constraint projection routine in the External
Model Interface as described on The MathWorks™ web site to control the drift in the result
of the DAE system.

Event Handling Options

The Event Handling Options section specifies whether the events are satisfied in a DAE
system by using event projection in the generated file. Use this option to improve the accuracy
of'a DAE system with events. If the constraint is not satisfied, the system result may deviate
from the actual solution and could lead to an increase in error at an exponential rate.
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Mazimunn number of event ikerations:
width of event hysteresis band:

Set the Maximum number of event iterations to specify the maximum number of times
that a projection is permitted to iterate to obtain a more accurate solution.

Set the Width of event hysteresis band to specify the desirable error tolerance to achieve
after the projection.

Baumgarte Constraint Stabilization

The Baumgarte constraint stabilization method stabilizes the position constraint equations
by combining the position, velocity, and acceleration constraints into a single expression.

By integrating the linear equation in terms of the acceleration, the Baumgarte parameters,
alpha and beta, act to stabilize the constraints at the position level.

Baumgarte Constraint Stabilization:

Apply Baumgarte constraint stabilization Export Baumgarte parameters

Alpha:

I

Beta:

Apply Baumgarte constraint stabilization: select this option to apply Baumgarte constraint
stabilization to your model.

Alpha: enter a value for the derivative gain that is appropriate to your model.
Beta: enter a value for the proportional gain that is appropriate to your model.

Export Baumgarte parameters: select this option to have constants for alpha and beta
included in the generated C code. This allows you change the values of alpha and beta in
the source code. You can then recompile your code and run it to see the effect on your
model.

Generating and Saving the C code

To generate C code
1. In MapleSim, open the model for which you want to generate code.

2. In the Model Workspace, make sure that the components for which you want to generate
code are grouped in a subsystem.

3. Click Templates ( # ) in the Main Toolbar. The Create Attachment window appears.
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4. From the list, select Code Generation.

5. In the Attachment field, enter a name for the template and click Create Attachment.
Your model opens in the Code Generation template in Maple.

6. From the drop down list, select the subsystem for which you want to generate code. The
subsystem and its contents appears in the Subsystem Selection window.

Main ™

7. Click the Load Selected Subsystem located directly below the model diagram. The
subsystem, along with all input and output variables are now loaded into the Code Gen-
eration template.

8. Inthe C Code Generation Options section of the template, choose the solver. By default,
the Euler solver is selected.
9. Choose where you want to save the code and the name of the file. The file is automatically

@ 9 [TPRL)

given a “c” prefix and a “c” extension.

10. Click Generate C Code. After the C code is generated, the code can be viewed in the
View C Code area at the bottom of the template. The C code is also automatically saved
to your specified location.
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* Automatically generated by Maple.
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#ifdef WMI_VINNT
#idefine EZP _ declspec(dllexport)
ficlae
#define EXP
#endif
#include <stdlib.hs
#include <stdio.h>
#include <math.h>
#ifdef FROM MAPLE
#include <mplshlib.hs>
static MEernelVector kv;

EXP ALGEE M DECL 3FetKernelVWector (MEernelWector kv _in, ALGEE args) { Kv=kv_in; ret
#else

#ifdef WMI_VINNT

#define M _DECL _ stdoall

ficlae

fidefine M DECL

#endif

#endif

m
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5.6 Generating a Custom Component from External C
Codel/Library

MapleSim can call external code directly within your model. By using the External C
Code/DLL template you can create a custom component to call external C Code and DLL
functions directly into your model or subsystem. You can access the basic C code, and then
compile and run the code in Maple. Extensions of this code are available for a variety of
software tools as additional Connector toolboxes.

With this template, you can define the external inputs and outputs, specify the function
name and arguments, generate the source code, and choose the format of the resulting
component and library code. You can use any Maple commands to perform task analysis,
assign model equations to a variable, group inputs and outputs, and define additional input
and output ports for variables.

Changes to the parameters, inputs and outputs are remembered when you re-load your system
using the External C Code/DLL template.

The process of creating an external code custom component for a MapleSim model consists
of the following steps:

* Specify the custom component name
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* Specify the location of the external C/library
* Define the external C/Library code options
* Specify the directory of the generated Modelica code

» Generate and save the external code custom component

Opening the External C Code/DLL Template

Click Templates ( # ) in the Main Toolbar and select External C/Library Block. In the
Attachment field, enter a name for the template, and then click Create Attachment. The
template opens in Maple.

Specifying the C/Library Code Location and Options

Use the External C Code/DLL template to define the library code location, and/or validate
and assign the code to a model. You can specify a header file, use an existing C or shared
library file, or create a new C file using the text area.

Specifying a Header file

If required you can select Specify Header File and provide the location of the existing
header file in the Location of Header File text box.

[ Provide External Code using Text Area Specify Header File

[7] attached CjDLL/SO  |Fl.c Refresh Attachments Lisk

Location of CfOLL File: | | [ Select File J
Location of Header File: ” C:/Fath to HeaderFile.h ” l Select File J
l ‘alidate and Save CfLibrary File I { validate and Attach CfLibrary File to MapleSim Model ]

Using an Existing C or Library File

Provide the location of the existing C or Library file in the Location of C/DLL File text
box.

[ Provide External Code using Text Area ] Specify Header File

[] attached CjoLLjSO Fl.c Refresh Attachments List
Location of C/DLL File: ”C:/’Path to C or Library file Hl Select File I
Location of Header File: | ‘ Select File

‘alidate and Save CLibrary File J l ‘alidate and Attach CfLibrary File ko MapleSim Model




5.6 Generating a Custom Component from External C Code/Library « 147

Click Validate and Save C/Library File to verify the validity of the provided C or Library
file.

Click Validate and Attach C/Library File to MapleSim Model to verify the validity of
the provided C or Library file, and attach it to the MapleSim model. The attachment is saved
in the Project > Attachments > Other folder.

Providing External Code in the Text Area

Select Provide External Code using Text Area to expand the text area. Enter the C code
in the text area and specify the file location in the Save to C File text box.

Provide External Code using Text Area Specify Header File

[] Attached CiOLLISC (FLc Refresh Attachments List
Save bo CFile: ”C :/Path to C file.o ” [ Select File ]
Location of Header File: | | Select File
Yalidate and Save CjLibrary File ] [ Yalidate and Attach Cilibrary File ta MapleSin Model ]

Click Validate and Save C/Library File to verify the validity of the C file. The file is
saved to the location specified in the Save to C File text box.

Click Validate and Attach C/Library File to MapleSim Model to verify the validity of
the provided C file and attach it to the MapleSim model. The attachment is saved to the
Attachments > Other subpalette located in the Project tab.

Using an Attached C or Library File

If there is an attached C or Library file you can select Attached C/DLL/SO and then choose
the specific C or Library file from the drop down list.

Provide External Code using Text Area Specify Header File
attached C/OLLS0 |FL.e w | [ Refresh attachments List
Location of CfDLL Fils: ‘ | Select File
Location of Header File: ‘ | Select File

‘alidate and Save ClLibrary File walidate and Attach CfLibrary File to MapleSim Model
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Defining the C/Library Code Location and Options

You can define the external C/Library function name, specify the external C/Library proto-
type, choose the parameter name, data type, whether it is an array, and whether it is an input
or an output of the external function. The specified inputs and outputs form the inputs and
outputs of the custom component.

If necessary click Remove Parameter to remove a parameter by its row ID.

If necessary click Clear Table to reset the parameter table.

Function Name:

External Function Name: l:l

Arguments:

Parameter Mame: Passed By Reference
Data Type: |float - Array?

Add Parameter

Parameter MNarme Data Type Change Row

| |
Remove Parameter Row ID ko Remaove: Clear Table

Output:
Specify whether the external C/Library functien returns a value. If it dees. specify the name of the return parameter and its datatype.

| Return?

Return Type:  float -

For a complete tutorial on how to create an external code custom component and its use,
see Tutorial 6: Using the External C Code/DLL Custom Component Template (page 197).

Generating and Saving the C code

To generate the custom component:

1. Specify where you want to save the generated Modelica custom component code.

Target directory: ‘C:\USEIS\ || Browse |

2. Click Generate External Code Component. After the custom component is generated,
the code can be viewed in the Source Details area at the bottom of the template. The
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template is also automatically saved to the Components palette located in the Definitions
tab.

5.7 Working with Maple Embedded Components

Embedded Components are simple graphical interface elements that you embed into a Maple
worksheet or document to view, edit, create actions, display information, and analyze the
properties of MapleSim models. You can also associate model properties with other Maple
embedded components, including sliders and plots to create custom analysis tools.

For example, you can view and change parameter values using commands in the Document-
Tools package. Model or subsystem equations can be retrieved using commands from the
MapleSim package and you can manipulate your model as a DynamicSystems object to
analyze the model or subsystem behavior using any input functions. Embedded Components
are inserted using the Components palette.

For more information about advanced analysis tasks, first open the Sliding Table example
from the Examples > User's Guide Examples > Chapter 5 palette under the Libraries
tab, and then open the AdvancedAnalysis.mw worksheet attachment (from MapleSim,
under the Project tab, browse to the Attachments > Documents menu).

5.8 Working with a Maple Standard Worksheet

After you create an attachment for your MapleSim model, you can further interact with and
analyze your model in a Maple worksheet by using the application programming interface
(API) commands. The MapleSim API is a collection of specialized procedures for manipu-
lating, simulating, and analyzing a MapleSim model in a Maple standard worksheet.

There are two ways to link to a MapleSim model: linking to a MapleSim model using the
LinkModel command or through the embedded component facility. The LinkModel command
returns a 'connection module' that allows access to a MapleSim model. For more information
on how to use the LinkModel command or the embedded component facility, see MapleSim
Application Programming Interface Overview and the examples section in the LinkModel
description.
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6 MapleSim Tutorials

MapleSim Tutorials help you get started with MapleSim and learn about the key features,
tools, templates and systems available in MapleSim, by leading you through a series of de-
scriptive tasks, problems and examples using best practices. Many of these examples can
be found in the Examples > User's Guide Examples palette in the Libraries tab on the
left side of the MapleSim window, in the order that they are presented in the User's Guide.

In this chapter:

* Tutorial 1: Modeling a DC Motor with a Gearbox (page 151)

* Tutorial 2: Modeling a Cable Tension Controller (page 157)

 Tutorial 3: Modeling a Nonlinear Damper (page 161)

 Tutorial 4: Modeling a Planar Slider-Crank Mechanism (page 169)

* Tutorial 5: Using the Custom Component Template (page 177)

* Tutorial 6: Using the External C Code/DLL Custom Component Template (page 197)
* Tutorial 7: Using the Equations Template (page 202)

* Tutorial 8: Modeling Hydraulic Systems (page 211)

6.1 Tutorial 1: Modeling a DC Motor with a Gearbox

In this tutorial, you will extend a DC motor model and perform the following tasks:
* Add a gearbox to the DC motor model

* Simulate the DC motor with gearbox model

* Group the DC motor components into a subsystem

» Assign global parameters to the model

* Add signal block components and a PI controller to the model

 Simulate the modified DC motor model using different conditions

Adding a Gearbox to a DC Motor Model

In this example, you will build the gearbox by adding and connecting an ideal gearbox
component, a backlash component with a linear spring and damper, and an inertia component
from the 1-D Mechanical library. You can use the selection tool to drag and position com-
ponents in the Model Workspace.

151
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To add a gearbox:

1. In the Libraries tab, expand the Examples > User's Guide Examples > Chapter 1
menu, and then open the Simple DC Motor example.

2. Delete the existing probe from the workspace.
3. Perform the following tasks:

* From the 1-D Mechanical > Rotational > Bearings and Gears menu, add an Ideal
Gear component to the Model Workspace and place it to the right of the Inertia
component.

* From the 1-D Mechanical > Rotational > Springs and Dampers menu, add an
Elasto-Backlash component to the Model Workspace and place it to the right of
the Ideal Gear component.

e From the 1-D Mechanical > Rotational > Common menu, add another Inertia
component to the Model Workspace and place it to the right of the Elasto-Backlash
component.

4. Connect the components as shown in the following figure.

G

1
L . BB, L
;%’m—.i__le_.-_: :—B—e' D P _—ln
EME =7 =7

5. In the Model Workspace, click the Ideal Gear component.

6. In the Inspector tab, change the transmission ratio, r, to 10 and then press Enter to accept
the value.

7. Specify the following parameter values for the other components:
* For the Elasto-Backlash component, in the b field, change the total backlash value
gt Noms
rad
* For the first Inertia component (I,), in the J field, change the moment of inertia value
to 10kgmh’.
» For the second Inertia component (I3), in the J field, change the moment of inertia

value to 1kglh®.

to 0.3rad. In the d field, change the damping constant to 1

» For the Step source, in the height field, change the value to 100.
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Simulating the DC Motor with the Gearbox Model

To simulate the DC motor:
1. From the Model Workspace Toolbar, click Attach Probe ( ).

2. Hover your mouse pointer over the line that connects the Elasto-Backlash component
and the second Inertia component (I3). The line is highlighted.

3. Click the line once, and then click a spot in the workspace to anchor the probe.
4. Select the probe in the Model Workspace.

5. To include the angle (phi), speed (W), acceleration (a), and torque (tau) values in the
simulation graphs, in the Inspector tab, select Angle, Speed, Acceleration, and Torque.

6. Click a blank area in the Model Workspace.

7. Under the Settings tab, set the ty parameter to 10 seconds and press Enter.

8. Click Run Simulation (I ) in the Main Toolbar. When the simulation is complete, the
following graphs appear.
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9. To verify the results, in the Libraries tab, expand the Examples > User's Guide Ex-
amples > Chapter 6 menu, and then open the DC Motor with Gearbox example.
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Grouping the DC Motor Components into a Subsystem
To group the DC motor components:

1. Using the Selection Tool ( k ), draw a box around the electrical components and the
first inertia component.

s
1 I
J_ ——.“1;1\ 2 = ,,ﬂr\"‘n Lf— et | ot I:I ]
B | = 1==1 : b=

2. From the Edit menu, select Create Subsystem.
3. In the Create Subsystem dialog box, enter DC Motor.

4. Click OK. A white block, which represents the DC motor, appears in the Model
Workspace.

5
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‘DC Motor

Tip: To view the components in the subsystem, double-click the DC Motor subsystem in

the Model Workspace. To browse to the top level of the model, click Main (Main ®) in
the Navigation Toolbar.

Assigning Global Parameters to a Model

You can define a global parameter and assign its value to multiple components in your
model.
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To assign global parameters:

1.
2.

Click Main in the Navigation Toolbar to browse to the top level of the model.

From the Navigation Toolbar, click Parameters (|#) to switch to the parameter editor
view.

. In the first row of the Main subsystem default settings table, define a parameter called

Rglobal and press Enter.

. Specify a default value of 24 and enter Global resistance value as the description.
. In the second row of the table, define a parameter called Jglobal and press Enter.

. Specify a default value of 10 and enter Global moment of inertia value as the description.

Main subsystem default settings

Name Type Default Value Default Units Description
Rglobal Real MRP Global rasistance value
Jglodal Feal v| |10 Global moment of inertia value

. To switch to the diagram view, click Diagram (=7]) in the Navigation Toolbar. The

new Rglobal and Jglobal parameters appear in the Inspector tab. You can now assign
these parameter values to other components in your model.

Inspector | Settings

Main

¥ Parameters
Rglobal 24

Jelabal 10

. In the Navigation Toolbar, click Parameters (|-#)).

. In the I3 component table, in the Value field for the moment of inertia parameter, enter

Jglobal and press Enter. The moment of inertia parameter now inherits the numeric
value of the global parameter Jglobal (in this example, 10).

10. Switch to the diagram view and double-click the 'DC Motor' subsystem.

11. In the Navigation Toolbar, click Parameters (|-*)).

12. In the EMF, component table, in the Value field for the transformation coefficient,

enter Rglobal Jglobal and press Enter.

Note: This value is an approximation of the transformation coefficient.

13. In the R; component table, in the Value field for the resistance parameter, enter Rglobal

and press Enter.
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14. Switch to the diagram view and browse to the top level of your model.

15. Save the model as DC_Motor2.msim.

Changing Input and Output Values

In this example, you will change the input and output values of the model to simulate different
conditions.

To change input and output values:

1. Under the Libraries tab, browse to the 1-D Mechanical > Rotational > Sensors menu
and then add the Rotational Speed Sensor component to the Model Workspace and
place it below the gearbox components.

2. Right-click (Control-click for Macintosh) the Rotational Speed Sensor component and
select Flip Horizontal.

3. Delete the connection line between the Step source and the DC Motor subsystem.

4. From the Signal Blocks > Controllers menu, add the PI component to the Model
Workspace and place it to the left of the DC Motor subsystem.

5. From the Signal Blocks > Mathematical > Operators menu, add the Feedback com-
ponent to the Model Workspace and place it to the left of the PI component.

6. Connect the components as shown below.

Probel
! phi, w, a, tau
1
5 P 1] |
f F ! 1 EB, b
L ;: I —;9' L L
— S— ] 31 = [= ‘Y ——
J_ ' . = [
"DC Motor
R3S

A

To draw a perpendicular line, click a point in the Model Workspace to anchor the line and
then move your mouse cursor in a different direction to draw the second line segment.

7. Click the PI component in the Model Workspace.

8. In the Inspector tab, specify a gain of 20 in the k field, and a time constant of 3 seconds
in the T field.
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9. Simulate the model again. When the simulation is complete, the following graphs appear.
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10. Save the model as DC_Motor3.msim.

11. To verify the results, in the Libraries tab, expand the Examples > User's Guide Ex-
amples > Chapter 6 menu, and then open the DC Motor Subsystem with Gearbox
and PI Controller example.

6.2 Tutorial 2: Modeling a Cable Tension Controller

In this tutorial, you will extend the DC motor example to model a cable that is stretched
with a pre-defined tension. The tension is defined by a Constant source and the PI controller
provides the voltage to drive the motor. You will perform the following tasks:

« Build a cable tension controller model

* Specify component properties

< Simulate the cable tension controller model
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Building a Cable Tension Controller Model

In this example, you will build the cable tension controller model using a combination of
1-D mechanical rotational and translational components. You will also group components
into a Gear subsystem and add subsystem ports.

To build the cable tension controller:

1.

Open the DC_Motor3.msim file that you created in the previous tutorial and save the
file as Cable_Tension.msim.

. Delete the probe attached to the line that connects the Elasto-Backlash and Inertia

components.

. Delete the Rotational Speed Sensor component and its connection lines.

. Select the Ideal Gear, Elasto-Backlash, and Inertia components and group them into

a subsystem called Gear Components.

. Add the following components to the Model Workspace:

* From the 1-D Mechanical > Rotational > Bearings and Gears menu, add the Ideal
Gear R 2 T component and place it to the right of the Gear Components subsystem.

e From the 1-D Mechanical > Translational > Sensors menu, add the Force Sensor
component and place it to the right of the Ideal Gear R 2 T component.

* From the 1-D Mechanical > Translational > Springs and Dampers menu, add the
Spring component and place it to the right of the Force Sensor component.

e From the 1-D Mechanical > Translational > Common menu, add the Fixed com-
ponent and place it to the right of the Spring component.

. Right-click (Control-click for Macintosh) the Fixed component in the Model Workspace

and select Rotate Counterclockwise.

. Delete the Step source and replace it with a Constant source from the Signal Blocks >

Sources > Real menu.

Tip: You can connect the Constant source by dragging it onto the unconnected line end.

8.

Double-click the 'Gear Components' subsystem. You will now add a port to connect
this subsystem with other components.

9. Click the negative (white) flange of the Inertia component and drag your mouse cursor

to the boundary that surrounds the subsystem components.
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e

10. Click the line once. The subsystem port is added to the line.

11. Click Main in the Navigation Toolbar to browse to the top level of your model.

12. Connect the components as shown below.

const, Pl IGR2T, FS
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Specifying Component Properties

To specify component properties:

1. In the Model Workspace, double-click the 'Gear Components' subsystem.
2. Specify the following parameter values for the subsystem components:

* For the Ideal Gear component, change the transmission ratio value to 0.01.

* For the Inertia component, change the moment of inertia value to 0.1kgﬂ12.
3. Click Main in the Navigation Toolbar to browse to the top level of the model.
4. Specify the following parameter values for the other components:

* For the Spring component, in the ¢ field, change the spring constant value to

211000° Y|
m
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* For the PI controller, change the T value to 0.1s.

» For the Constant source, change the constant output value k to 77.448.

Simulating the Cable Tension Controller

To simulate the cable tension controller:

1.
2.

Click Attach Probe ().

Click the line that connects the Feedback and PI components and then click the work-
space to position the probe.

. Select the probe in the Model Workspace.
. In the Inspector tab, select the Real quantity and change its name to Error.

. Add another probe that measures the Real quantity to the line connecting the PI compon-

ent and 'DC Motor' subsystem. Change the quantity name to Controller.

Probel Probe2
! Error | Controller
' '

const, : P IGR2T, FS

[ | ,
- | / {1 . . ; A N_E 1
% —
"DC Motor "Gear Components’ [

Figure 6.1: Cable Tension Controller

. Click a blank area in the Model Workspace.
. In the Settings tab, specify the following parameters:

* Set the simulation duration time, tg, to 5.

» Select Variable from the Solver Type drop-down menu.

* Select Rosenbrock (stiff) from the Solver drop-down menu.

. Click the Run Simulation () in the Main Toolbar. When the simulation is complete,

the following graphs appear.
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9. Save the file as CableTension.msim.

6.3 Tutorial 3: Modeling a Nonlinear Damper

In this tutorial, you will model a nonlinear damper with a linear spring. This tutorial builds
upon the concepts demonstrated in the previous tutorials. You will perform the following
tasks:

» Generate a custom spring damper defined by differential equations
* Provide custom damping coefficient values as input signals

* Build the nonlinear damper with linear spring model

+ Assign a variable to a subsystem

* Simulate the nonlinear damper with linear spring model

Generating a Spring Damper Custom Component

This example uses the Nonlinear Spring Damper Custom Component created in Example:
Creating a Nonlinear Spring-Damper Custom Component (page 83) in Chapter 3.

¥ Components

‘ -
{0’.’0

MonlinearSpringDamper
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Providing Damping Coefficient Values

You can provide custom values for interpolation table components that you add to your
model. In this example, you will provide damping coefficient values in an external file.

To create damping coefficient values:

1. Create either a Microsoft Excel spreadsheet (.xls) or comma-separated values (.csv) file
that contains the following values:

A | 8 |

| 1] 0 750
| 2 | 0.05 500
| 3 ] 0.1 250
| 4] 0.2 75
| 5 | 0.25 250
[ 0.3 as0

The first column contains values for the relative displacement of the damper and the second
column contains values for the damping coefficients.

2. Save the file as DamperCurve.xlsx or DamperCurve.csv.

3. In MapleSim, expand the Attachments palette located under the Project tab.
4. Right-click (Control-click for Macintosh) Data Sets and select Attach File.
5

. Browse to and select the Excel spreadsheet or .csv file that you created, and click At-
tach.... The file containing the data set is attached to your model. You will use this file
in the next task.

Building the Nonlinear Damper Model

In this example, you will build the nonlinear damper using components from the component
library.
To build the nonlinear damper:

1. From the Definitions tab, drag the NonlinearSpringDamper custom component into
the Model Workspace.

2. Select the Libraries tab, and then add the following components to the Model Work-
space:
* From the Signal Blocks > Mathematical > Operators menu, add a Gain component
and place it above the NonlinearSpringDamper component.

» From the Signal Blocks > Sources > Real menu, add a Constant component and
place it between the NonlinearSpringDamper and Gain components.
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* From the Signal Blocks > Interpolation Tables menu, add a Lookup Table 1D
component and place it to the left of the Gain component.

* From the 1-D Mechanical > Translational > Sensors menu, add a Position Sensor
component and place it to the left of the Lookup Table 1D component.

3. Connect the components as shown in the following figure.

Ps LT10,
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onlinear3pringDamper

4. Add the following components to the Model Workspace:

e From the 1-D Mechanical > Translational > Common menu, add Mass and Force
components and place them to the left of the Position Sensor component.

* From the same menu, add a Fixed component, place it to the right of the Nonlin-
earSpringDamper component, and then rotate it counterclockwise.

* From the Signal Blocks > Sources > Real menu, add a Step source.

5. Connect the components as shown in the following figure.
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Figure 6.2: Nonlinear Damper Model

6. In the Model Workspace, select the Lookup Table 1D component.

7. Under the Inspector tab, select attachment from the datasource mode list.

Inspector | Settings

Mame LTiDy

Type Lookup Table 1 D

¥ Parameters

data source
datasource |attachment -
modea file

[T]] intine
data  ldtchment p ]

8. Select the attachment you created (either DamperCurve.xlsx or DamperCurve.csv)
from the data list.
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Inspector | Settings

MName LTID;

Type Lookup Table 1 D

¥ Parameters

datasource attachment -
modea

[ MiMo

Attached Data 5et

data DamperCurvey ™|
columns

DamperCurve x
skiprows

9. In the Model Workspace, select the Constant component.

10. In the Inspector tab, in the Name field, change the component name to Stiffness.

Inspector | Settings

Mame Stiffness

Type Constant

11. Select the Step component, and then set height to 100.
12. Select the Mass component, and then change the mass, m, to 100kg.

13. Using the Selection Tool ( k ), draw a box around all of the components in the nonlinear
damper model.
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14. Group the selected components into a subsystem called Nonlinear Damper. The complete
model is shown in the following figure.

5

=3

"Monlinear Damper”

Assigning a Parameter to a Subsystem
To assign a parameter to a subsystem:
1. In the Model Workspace, double-click the '"Nonlinear Damper' subsystem.

2. In the Navigation Toolbar, click Parameters (|-#)).
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3. In the first row of the Standalone Subsystem default settings table, define a spring
constant parameter called Ks, and then press Enter.

4. In the same row, specify a default value of 1000 and enter Spring constant as the de-
scription. You can now assign the parameter value Ks to other components in the Non-
linear Damper subsystem.

Standalone Subsystem default settings

MName Type Default Value Default Units Description

Ks Real ¥ 1000 Spring constant

5. In the Navigation Toolbar, click Diagram (=2)). The Ks parameter appears as a field
in the Inspector tab with the defined default value.

Inspector | Settings

Mame | Nonlinear Damper

Type Standalone Subsystem

¥ Parameters
] 1000

6. Inthe Model Workspace, select the Stiffness component and change the constant output
parameter, Kk, to Ks. This component now inherits the numeric value of Ks (in this ex-
ample, 1000). Therefore, if you edit the numeric value of Ks at the subsystem level, the
k parameter also inherits that change.

Inspector | Settings

Name Stiffness

Type Constant

Slifnass

¥ Parameters
k Kz

Simulating the Nonlinear Damper with Linear Spring Model

To simulate the nonlinear damper:
1. Click Main in the Navigation Toolbar to browse to the top level of the model.

2. From the Model Workspace Toolbar, click Attach probe ( .4 ). The cursor changes to
the probe icon when you move into the workspace.

3. To attach the probe, click the line that connects the Mass component and the Nonlinear
Damper subsystem and then click a spot in the workspace to anchor the probe.

4. In the Model Workspace, sclect the probe.
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5. Under the Inspector tab, select the length, speed, and acceleration quantities.

Inspector | Settings
Probe o &

Probel

Length |s
Speed |v

Acceleration |a

] Force |f

6. Click a blank area in the Model Workspace. The length, speed, and acceleration
quantities (s, v, a) appear beside the probe.

7. Now, navigate to the '"Nonlinear Damper' subsystem: double-click the 'Nonlinear
Damper' subsystem.

8. Add a probe to the line that connects the Gain and NonlinearSpringDamper1 custom
component and then click a spot in the workspace to anchor the probe.

9. In the Model Workspace, select the probe.

10. Under the Inspector tab, select the Real quantity and change its name to Damping.

Inspector | Settings
Probe o &

Probe2

Real Damping

11. Under the Settings tab, set the t4 parameter to 10 seconds.

12. Click Run Simulation (b ) in the Main Toolbar. When the simulation is complete, the
following graphs appear.
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13. Save the file as NonLinearMSD.msim.
6.4 Tutorial 4: Modeling a Planar Slider-Crank
Mechanism

Using components from the Multibody mechanical library, you will model the planar slider-
crank mechanism shown in the following figure.
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Figure 6.3: Planar Slider-Crank Mechanism

This model consists of a revolute joint, 4, which is attached to a planar link. This planar
link is attached to a connecting rod by a second revolute joint, B. The connecting rod connects
to a sliding mass by a third revolute joint, C, and the sliding mass connects to ground by a
prismatic joint. In practice, this mechanism converts rotational motion at the crank to
translational motion at the sliding mass or vice versa. For the system shown in the diagram,
gravity is assumed to be the only external force, acting along the negative Y-axis (the y-
axis for the inertial frame).

In this tutorial, you will perform the following tasks:

* Create a planar link subsystem

* Define and assign subsystem parameters

* Create the crank and connecting rod elements

* Add the fixed frame, sliding mass, and joint elements to the model
* Specify initial conditions

* Simulate the planar slider-crank mechanism

Creating a Planar Link Subsystem

The diagram above shows that the slider-crank has two associated planar links: the crank
(the link from point A to B) and the connecting rod (the link from B to C). In both cases,
these links have their longitudinal axis along their local x-axis (x1 and x2, respectively).
Therefore, you will first create a generic planar link with two ports. The inboard port (base)

L
will be located - > units along the x-axis of the link, and the outboard port (tip) will be

L
located ) units along the x-axis of the link. In this example, L refers to the length of the

link and the center-of-mass is assumed to be in the middle of the link.
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To create a planar link subsystem:

1.
2.

Open a new MapleSim document.

Under the Libraries tab, browse to the Multibody > Bodies and Frames menu, and
then add two Rigid Body Frame components and a Rigid Body component.

. In the Model Workspace, right-click (Control-click for Macintosh) one of the Rigid

Body Frame components, and then select Flip Horizontal.

. Right-click (Control-click for Macintosh) the Rigid Body component, and then select

Rotate Counterclockwise.

. Drag the components in the arrangement shown below.

RBF
RBF

Tt by

: @

Notes:

* Ifyou cannot see the labels for your components, from the View menu, select Show
Labels.

» The labels for your components may differ from the labels in the preceding figure
(that is, RB, RBF, and RBF,). You can change the labels in your model by selecting
the component, and then entering the new label in the Name field under the Inspector
tab. For this tutorial, the labels shown in the preceding figure will be used when refer-
ring to specific components.

. Draw a connection line between the RB component and the right frame of the RBF

component.

RBF
REF 2

sl S

|
@

Draw another connection line between the RB component and the left frame of the RBF,

component.
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REF
RBF 3
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8. Using the Selection Tool ( & ), draw a box around the components.

REBF
RBF 2

 Jms TRRSRE 558

|
e @

9. From the Edit menu, select Create Subsystem.

10. In the Create Subsystem dialog box, enter Link, and then click OK.

You will now add ports to connect this subsystem to other components.

11. Double-click the Link; subsystem.

12. Click the left frame of the RBF component and drag your mouse pointer to the left of
the subsystem boundary.

13. Click the line once. A subsystem port is added.

14. In the same way, using the right frame of the RBF, component, create another port on
the right side of the subsystem boundary.
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Defining and Assigning Parameters

In this task, you will define a subsystem parameter, L, to represent the length of the link
and assign the parameter value as a variable to the parameters of the Rigid Body Frame
components. The Rigid Body Frame components will then inherit the numeric value of L.

To define and assign parameters:
1. If you are not already in the Link; subsystem, click Main in the Navigation Toolbar,

and then double-click the Link; subsystem.

2. Inthe Navigation Toolbar, click Parameters (}-#), or from the Inspector tab click Add
or Change Parameters. The Link subsystem default settings window appears.

3. In the first row of the Link subsystem default settings table, define a parameter called
L, and then press Enter.

4. Specify a default value of 1 and enter Length as the description.

5. Scroll down to the RBF component section.

6. In the Value field for 7XYZ’ specify a position offset of [ - %, 0, 0|, and then select m

from the Units drop-down menu. To enter a fraction, use the forward slash key (/).
7. Scroll down to the RBF, component section.

, and then select m
XY.

from the Units drop-down menu.

8. In the Value field for ¥ 7 specify a position offset of [5, 0,0

9. In the Navigation Toolbar, click Diagram (*2)).
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Creating the Crank and Connecting Rod Elements

In this task, to create the crank and connecting rod elements, you will add a Link subsystem
definition to your model and create Crank and ConnectingRod shared subsystems. You
will also assign a different length value to the connecting rod element.

To create the crank and connecting rod elements:

1.

Click Main in the Navigation Toolbar to browse to the top level of your model. The
Link, subsystem appears in the Model Workspace.

. Right-click (Control-click for Macintosh) the Link; subsystem, and then select Convert

to Shared Subsystem. The Create Shared Subsystem window appears. Click OK. A
Link subsystem definition is added to the Definitions tab and the Link subsystem in
the Model Workspace is converted to a shared subsystem.

. Select the Link; shared subsystem in the Model Workspace and in the Inspector tab,

in the Name field, change the name of the shared subsystem to Crank.

. From the Definitions tab, drag the Link icon to the Model Workspace, placing it to the

right of the Crank shared subsystem.

. In the Model Workspace, select the second copy of the Link shared subsystem.

. In the Inspector tab, change the shared subsystem name to ConnectingRod and change

the value of the Length parameter (L) to 2.

Adding the Fixed Frame, Sliding Mass, and Joint Elements

In this task, you will add a Fixed Frame component, a Rigid Body component to represent
the sliding mass, and the Revolute joint components.

To add the fixed frame, sliding mass, and joint elements:

1.

Under the Libraries tab, expand the Multibody > Bodies and Frames menu, select the
Fixed Frame component, and then place it to the left of the Crank shared subsystem.

. From the same menu, select the Rigid Body component and place it slightly below and

to the right of the ConnectingRod shared subsystem.

. Add the following joints:

* From the Multibody > Joints and Motions menu, add a Revolute joint between the
Fixed Frame component and the crank, a second Revolute joint between the crank
and the connecting rod, and a third Revolute joint between the connecting rod and
the rigid body.

* From the same menu, add a Prismatic joint and place it below the Crank subsystem.

. Select the Rigid Body component in the Model Workspace and rename it SlidingMass.
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5. Right-click (Control-click for Macintosh) the SlidingMass component and select Flip
Horizontal. In the same way, flip horizontally the revolute joint that is located between
the connecting rod and the rigid body.

- o - -

Q[ &

R R

2 - a
= ConnectingRod

7
‘mé/

I

6. Connect the components as shown in the following figure.

FF
1
.

AL

™ R d R d R
"J) Cranik '\-]” ConnectingRod
SlidirigMass

Tip: In this example, the default axes of motion for the revolute and prismatic joints line
up with the desired axes of motion. For example, the revolute joints initially assume that
they rotate about the z-axis of the inboard frame, which always coincides with the inertial
Z-axis for XY-planar systems. If you create nonplanar models, you may need to change
these axes to make sure that they allow motion along or about the correct directions.
Specifying Initial Conditions

You can specify initial condition values for certain components in your model.

To specify initial conditions:

1. For the first revolute joint (R in the preceding figure), in the 0y field, change the initial

angle to % rad.

Tip: To enter «, type pi, press Ctrl + Space (or Command + Shift + Space for Macintosh),
and then select the  symbol from the menu.

2. From the ICy ,, drop-down menu, select Strictly Enforce.
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When MapleSim solves for the initial conditions, the first angle will be set to ~ yad before

4

the angles are set for the other joints.

Simulating the Planar Slider-Crank Mechanism

To simulate the planar slider-crank mechanism:

1.
2.

From the Model Workspace Toolbar, click Attach Probe ( ).

In the Model Workspace, click the white 1-D translational flange (flange b) at the top
right of the Prismatic component icon and position the probe.

. Click the probe in the Model Workspace.
. In the Inspector tab, select the Length quantity to measure the displacement.

. In the same way, add a probe that measures the Angle quantity to the white 1-D rotational

flange (flange b) at the top right of the R; component icon (that is, the revolute joint
between the Fixed Frame and Crank components).

. Click a blank area in the Model Workspace.

. In the Settings tab, expand Simulation and set the t4 parameter to 10 seconds.

. Click Run Simulation (B ) in the Main Toolbar. When the simulation is complete, the

following graphs appear.
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9. Click Play (F) in the 3-D Toolbar to see a video of the simulation in the 3-D Visualiz-
ation Area.

10. Save the file as SliderCrank.msim.

6.5 Tutorial 5: Using the Custom Component Template

This tutorial describes the use of the Custom Component template in various domains in
MapleSim. With this template, you can define system parameters and variables, set the level
of equation optimization, generate the equations, and then further analyze the resulting
equations. You can use any Maple commands to perform detailed equation analysis, assign
model equations to a variable or parameter, and define additional system variables and
parameters. These features are especially useful in generating reusable equations when there

is more than one subsystem.

The Custom Component Templates contain pre-built embedded components that let you
extract, manipulate, and analyze the symbolic system equations generated by any MapleSim
model. Using various components from the library, you will create models, set initial con-
ditions and component properties, and assign new values to parameters and variables.



178 « 6 MapleSim Tutorials

In this tutorial, you will use the Custom Component template to extract the equations for
various models by performing the following tasks:

* Create the model

» Attach a Custom Component template for the model

* Enter your governing equations

 Set initial conditions by specifying the component properties
+ Assign new values to parameters and variables

* Generate the Equations Template

* View, manipulate, and reassign equations

» Simulate and translate an equation to a transfer function

* Map variables from your equations to the ports

 Specify ports for your block

* Create a custom port using the Custom Port template

For a description of the Custom Component Template see Creating Custom Modeling
Components (page 69).

Example: Modeling a Temperature Dependent Resistor

In this tutorial example, you will create a model of an RL circuit using a custom component
for the temperature dependent resistor whose resistance varies as

(T(t) — TO)®

> , where RO, TO, and Tk are parameters.
TK

r(t) =R0-[1 +
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Figure 6.4: Temperature Dependent Resistor

To create the custom component:

1.
2.

Start a new MapleSim model and select Edit > Create Attachment....

Select the Custom Component template and then click Create Attachment. The Maple
Custom Component template is loaded.

. Inthe Equations section, enter in the following system equations to define your compon-

ent. Press Enter at the end of the line.

2
| 4 (1(1) = 10) J

TK?

v(t) = i(t)-r(t), gdot(t) = i(t)-v(t)

. In the Parameters section, click Refresh All.
. Scroll down to the Ports section.

. Click Add Port. A new port appears on the left side. This will become the positive

electrical pin.

. From the Type drop-down list, select Electrical.

. In the drop-down box below the Signal label, select vp(t). This assigns the across variable

of the port.

. The variables of this port are listed. In the list box click Current = unassigned and in

the drop-down list select i(t). This assigns the through variable of the port.
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Signal: |i (t) | Assign

jChoose. .. +-

Voltage = vp(t)

Current = i(t)

10. Click Add Port. A new port appears on the right side. This will become the negative
electrical pin.

11. From the Type drop-down box, select Electrical.
12. Click the Style radio button labeled -. This changes the port style to an unfilled box.

13. In the drop-down box below the Signal label, select vn(t). This assigns the across variable
of the port.

14. The variables of this port are listed. In the list box click Current = unassigned, in the
drop-down box select i(t), and click the +/- button to negate the sign of the signal.

Signal: |—i (t) | Assign
it) v | -

Voltage = vn(t)

Current = -(t)

15. Click Add Port. A new port appears on the top edge. Click and drag it to the center of
the bottom edge.

16. From the Type drop-down box, select Thermal.
17. Select T(t) for the Temperature variable and qdot(t) for the Heat Flow Rate variable.

18. Click any Refresh All button. This updates entries in the Type column of the Variables
table.

19. In the Variables table, the types for r(t) and v(t) are still listed as real. In the table,
change the Type entries for r(t) and v(t) rows to Resistance and Voltage, respectively.
Click Refresh All to ensure these are accepted (if not, they revert to real).

20. In the Parameters table, enter Resistance for the type of RO, and ThermodynamicTem-
perature for both TO and Tk. Assign the Default for TO to 300. (The units are Kelvin.)
Click Refresh All to ensure these are accepted.

Note: You can also find the type names used in the preceding step by expanding the Type
Reference section and searching for the appropriate Domain and Type.

21. Open the Dimensional Analysis section and click Check Dimensions. The message
"no issues found" should appear in the text area.
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2. In the Component Generation section, change the Name to TempResistor.

23. Click Generate MapleSim Component to create your component and to bring you back
into the MapleSim environment. The custom component now appears under the Defini-
tions tab, in the Components palette.

24. Drag the custom component into your model area.

25. Create the model shown in Figure 6.4 with the components and settings specified in
Table 6.1.

Note: When you build the model, make sure to include the two probes that measure the
electrical and thermal quantities.

Table 6.1: Temperature Dependent Resistor Components

Component Symbol Component Location Required Settings
TempResistor . . .
+ >
Custom Component % §) Definitions > Components Use default settings
. ST Libraries > Electrical > Analog .
Sine Voltage r@ﬂ > Common Use default settings
o N s
Ground — Libraries > Electrical > Analog Use default settings
> Common
s ol >
Inductor BT Libraries > Electrical > Analog Use default settings
> Common
Fixed Temperature @ Libraries > Thermal > Sources |Set T = 298K

26. Click Run Simulation (B ) in the Main Toolbar. When the simulation is complete, the
following graphs appear.
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Example: Compliant Contact and Piecewise Functions

In this tutorial example, you will create a model of a bouncing ball using a custom component
to model the compliant ground contact.

®—

Probe1

S - ‘
]

/4

Figure 6.5: Falling Ball
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The prismatic joint in Figure 6.5 models a falling ball by allowing translation of a rigid
body along the vertical y-axis. To change the falling ball into a bouncing ball, a custom
component models the compliant ground contact using a spring-damper arrangement. The
custom component attaches to the 1D translational ports on the prismatic joint with the
following conditions:

» The ball will hit ground at s=0 and cause the spring damper to compress (and hence ball
position will be at s<0).

* The spring-damper will impart a restoring force of F(t) to the ball until it is above at s=0.

Figure 6.6 shows a diagram of this process.

Figure 6.6: Bouncing Ball Dynamics

where

ds(t)

f(x) =Ks(t) +B i

Jif s(t) <0

f(x) =0 if s(t) >0
To create the custom component:

1. Start a new MapleSim model, and then select Edit > Create Attachment....

2. Select the Custom Component template, and then click Create Attachment. The Maple
Custom Component template is loaded.

3. Inthe Equations area, enter in the following equation, parameters, and initial conditions
to define your custom component. Press Enter at the end of the line.

eq = [ s(t) = sa(t) — sb(t), 0 = Fa(t) + Fb(t), Fa(t)
= piecewise(s(t) <0, K-s(t) + B-diff(s(t), t),0)]

4. Scroll down to Ports.

5. Click Refresh All

6. Click Add Port.
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7. Make the left port a Translational type. Use style a (the default). Associate its Position
variable with sa(t) and its Force variable with Fa(t).

8. Add a second port, to the right side.

9. Make the right port a Translational type. Select style b. Associate its Position variable
with sb(t) and its Force variable with Fb(t).

10. Click Refresh All.
11. Scroll up to the Variables table.
12. In the table, change the Type of s(t) to Position. Click Refresh All.

13. Scroll up to the Parameters table, and change the Default value for B to 10 and K to
1000. Leave the types as real, for now.

14. Click Refresh All.

15. Open the Dimensional Analysis section and click Check Dimensions. The following
expression appears:

B % s(t) % + K s(t) m. This indicates that the units (dimensions) are not consistent;

the units associated with each element in the sum are displayed.

16. You can choose to ignore the inconsistency, and the model will work as desired because
MapleSim's engine does not use units. Checking dimensional consistency, however, is
an easy way to avoid simple algebric errors. To eliminate the inconsistency, the proper
types must be added to parameters B and K.

17. In the Parameters table, enter Force/Velocity and Force/Distance for the types for B
and K, respectively. Click Refresh All. The types update to the equivalent dimensional
types, TranslationalDampingConstant and TranslationalSpringConstant.

18. Rerun the dimensional analysis and run Check Dimensions again. "No issues found"
will appear.

19. Click Generate MapleSim Component to create your component and to bring you back
into the MapleSim environment. The custom component now appears in the Definitions
> Components palette.

W Components

:@

custom
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20. Drag the custom component into your workspace and assemble the components shown
in Figure 6.7 using the specified model components and their settings from Table 6.2.
Ensure that the prismatic joint translates along the y direction.

RB
1
®

Probe1

L‘o 'Q.'_
L

custom1

SEEd

Figure 6.7: Bouncing Ball
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Table 6.2: Bouncing Ball Multibody Components

Bodies and Frames

Component Symbol Component Location Required Settings
. fes
Custom | ‘,‘ . Definitions > Components Use default settings
Component e >
s . -
Rigid Body Libraries > Multibody Use default settings

Fixed Frame

Libraries > Multibody >
Bodies and Frames

Use default settings

Prismatic

]
o

Libraries > Multibody >
Joints and Motions

For the prismatic joint to translate along
the y direction, set

e, 1 [0,1,0]

For the prismatic joint to try enforcing
your translational initial conditions, set

IC,, to Treat as Guess

For an initial displacement, the prismatic
joint requires a value > 0. Set

o to 10m

21. Click Run Simulation (p ) in the Main Toolbar. When the simulation is complete, the
Visualization Window opens, displaying the probe plot in the Simulation Results tab.
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Figure 6.8: Bouncing Ball Result
2. To play the animation of the bouncing ball, select the 3-D Playback Window in the

Simulation Results tab, and then click Play (u) in the Playback Toolbar. To create

a smoother animation, set Interpolate Intermediate Frames. For more information,
see Animating a 3-D Model with Interpolated Frames.

Example: Custom Ports

In this tutorial example you will create a pair of custom ports with causal signals, power,
and velocity, that are generated by a dummy vehicle model and combined by a monitor
block that computes the force, using the relation f(t) = pt)

. For the dummy vehicle
V(1)
model we will assume the power is constant, p(t) = P, and the velocity is given by
V(t) = vO + a-t, where P, v0, and a are parameters.
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Create Custom Ports

We need to create two custom ports, an output port named bus_out and an input port named
bus_in.

1.
2.

Start a new MapleSim model and click Edit > Create Attachment....

Select the Custom Port template and then press Create Attachment. The Maple Custom
Port template is loaded.

. In the Signals section, click Add Row twice to add two rows to the table, one for each

signal.

. In the first row, enter p as the Signal, Power as the Type, output in the In/Out/Flow

column and "Vehicle power" in the Description column (be sure to include the double-
quotes).
Tip: You only need to enter the first letter (i/o/f) in the In/Out/Flow column.

. In the second row, enter V as the Signal, Velocity as the Type, output in the

In/Out/Flow column, and "Vehicle velocity" in the Description column.

. Ensure that none of the edited cells are selected (click outside the table), then click Re-

fresh.

. In the Port Generation section, enter bus out in the Name field, vehicle bus port as a

Description, and click the output style radio button.

. Click Generate MapleSim Port to create the output port. You will automatically return

to your MapleSim model.

. Return to the same template to modify it to create the input port. (If the template is closed,

to reopen it, in the Project tab, in the Attachments palette, under Documents, right-
click (Control-click for Macintosh) on CustomPortl.mw and select View.

10. In the Signals section, click Reverse. This changes outputs to inputs, and vice-versa.

11. In the Port Generation section, change bus_out to bus_in and click the input style radio

button.

12. Click Generate MapleSim Port to create the input port. You will automatically return

to your MapleSim model.
The two custom ports you have defined appear in the Components palette of the
Definitions tab. See CustomPortsFigure.
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W Components

bus in bus out

Figure 6.9: Custom Ports

Create Engine Model

1.
2.
3.

We will first create the dummy vehicle model.
In MapleSim, click Edit > Create Attachment....

Select the Custom Component template and then click Create Attachment. The Maple
Custom Component template is loaded.

. In the Equations section, enter in the following system equations to define your compon-

ent. Press Enter at the end of the line.

eq:= [p(t) =P, v(t) =v0+ a-t]

. In the Parameters section, click Refresh All, then change the types for P, a, and vO

to Power, Acceleration, and Velocity, respectively.

. Scroll down to Ports section.
. Click Add Port. A new port appears on the left edge. Drag it to the right edge.
. From the Type drop-down menu, select Custom. (It is at the bottom of the list.)

. In the text area below the Type drop-down menu, enter the custom type name: bus_out.

Click Apply Custom.

10. Using the drop-down menu and list box at the bottom of this section, assign the power

signal to p(t) and the velocity signal to V(t). Figure 6.10 shows the completed Ports
section of the template.



190 « 6 MapleSim Tutorials

Y Ports [
Refresh Al

{ Add Port H Delete Port H Clear All Ports J IconSize: Small @ O © O Llarge

———— 7] Snap to Grid
Type: |Custom = Apply Custom nap to G

[pua_sut |

Styjle: @in O out

Signal: |vtt.J H Assign J

Custom]_i [
=

il

vit) =] [l

v :: Velocity = v(t)

Icon: |Use default -

Figure 6.10: Using a Custom Port
11. In the Dimensional Analysis section, click Check Dimensions. The message no issues
found should appear.
12. In the Component Generation section, change the name to engine. Click Generate
MapleSim Component.
The engine component appear in the Components palette of the Definitions tab.
Create Monitor Model
1. In MapleSim, click Edit > Create Attachment....

2. Select the Custom Component template and then click Create Attachment. The Maple
Custom Component template is loaded.

3. Inthe Equations section, enter in the following system equation to define your compon-
ent. Press Enter at the end of the line.

t
eq = [f(t) = "f((t”
In the Parameters section, click Refresh All.
Scroll down to the Ports section.
Click Add Port. A new port appears on the left edge. This will be the bus input.

From the Type drop-down menu, select Custom (at the bottom of the list).

®© =N ok

In the text area below the Type drop-down menu, enter the custom type name: bus_in.
Click Apply Custom.
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9. Using the drop-down menu and list box at the bottom of this section, assign the power
signal to p(t) and the velocity signal to V(t).

10. Click Add Port. A new port appears on the right edge. This will be the computed force
output.

11. From the Type drop-down menu, select Real Signal. Click the out style radio button.
Assign the value signal to f(t).

12. Click Refresh All In the Variables table, change the type of signal f(t) to Force.

13. In the Dimensional Analysis section, click Check Dimensions. The message
real_o(t) = f(t) N should appear. It indicates that the output port, real_o(t), is a
real signal but is equated to f(t), which has units of force (Newtons).

14. In the Component Generation section, change the name to monitor. Click Generate
MapleSim Component.

Complete Model

1. In MapleSim, drag the engine and monitor models from the Definitions > Components
palette into the workspace.

2. Connect the output of the engine block to the input of the monitor block. Attach a probe
to the output of the monitor block.
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3. Run the simulation. The Simulation Results tab in the Visualization Window shows the
following probe plot:
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Advanced Uses for Custom Components

You can use the entire range of Maple functionality to derive your system equations in the
Custom Component template. This section provides a sample advanced application.

Example: Modeling a Centrifugal Pump from a Head Flow Rate Curve

The following hydraulics example demonstrates how to apply extrapolated data from a
centrifugal pump into a custom component. Creating a centrifugal pump custom component
involves the following tasks.

* Obtain data from a graph
* Generate an equation by fitting the best curve for your data set

» Obtain multi-argument operators
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* Apply operators and generate custom component
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Figure 6.11: Centrifugal Pump Head Flow Rate Curve

Table 6.3: Centrifugal Pump Data

Flow Rate Pressure Head
(cubic meters) (meters)
0.01 0.0098
0.02 0.00874
0.03 0.00725
0.04 0.005
0.05 0.0025
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Table 6.4: Circular Pipe Parameters

Symbol Description Values
D Pipe hydraulic diameter 0.01 m
L Pipe length S5m
€ Height of internal pipe roughness 1.5-10"° m
RelL Maximum Reynolds number in laminar regime 2000
ReT Minimum Reynolds number in turbulent regime 4000
P Fluid density rhoFluid
v Fluid kinematic viscosity nuFluid
Table 6.5: Centrifugal Pump Components
Component| Symbol Component Its Use Required
Location Settings
Libraries > This component defines a base
Atmospheric T Hydraulic > pressure (similar to ground in the | Use default
Pressure = Reference electrical domain) and represents a |settings
Components connection to atmosphere.
All hydraulic models need a
Hydraulic Fluid Properties rhoFluid:
component. Similar to a Parameter kg
block, it is placed in the Model SSOW
Workspace to define the following
Hydraulic Iﬁl}t,);?;ﬁli hydraulic fluid properties: EIFluidS;
Fluid b « rhoFluid: liquid density 8.0x10%Pa
Properties C ¢ Fluid:
omponents + EIFluid: Bulk Modulus defines the | " ¢
. - 2
fluid compressibility 0.000018 mT
* nuFluid: Kinematic Viscosity
defined as dynamic viscosity divided
by liquid density
Cireular Libares > | el e The
Pipe (B | | Hydraulic > Pipes refsure dro yis iven b .the Darc See Table 6.4
P and Valves presst P15& y Y
equation.
Custom % Definitions > ghcllsr:l?ljz:on;ez;rﬁg(:rllednitigif ?aeti: User defined
Component L g Components Y P

properties for the hydraulic line.




6.5 Tutorial 5: Using the Custom Component Template <« 195

Probe

B
=]

4

P

8

Can rﬂ'ﬁ..g:rfPump1

L

AP,

Figure 6.12: Centrifugal Pump Custom Component

To create the custom component:

1.
2.

Start a new MapleSim model and click Edit > Create Attachment....

Select the Custom Component template and then click Create Attachment. The Maple
Custom Component template loads.

. In the Equations section, insert two document blocks (from the main menu, select

Format > Create Document Block twice).

. In the first line you added, place the values from Table 6.3 into the following list, and

then press Enter at the end of the line to register the list.

L= [[0.01, 0.0098], [0.02, 0.00874], [0.03, 0.00725], [0.04,
0.005], [0.05, 0.0025]]

. On the next line, fit a quadratic curve to the data points using the following Maple

command, and then press Enter at the end of the line.

f:= unapply( CurveFitting[ LeastSquares) (L, X, curve = a-x’ + b-x
+c),x)

. Implement the polynomial in a custom component by defining your equations in terms

of the regression curve and parameters for the block. That is, enter in the following system
equations, parameters, and initial conditions to define your component. Press Enter at
the end of the line.

eq = [P(t) = f(Q(t))-p-g, P(t) = Pr(t) — PI(t), p = 1000, g
=9.81]
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7. Scroll down to Ports.

8. Click Add Port to add a port on the left edge. Select the Hydraulic type, and assign the
Pressure variable to Pr(t) and the Volume Flow Rate variable to Q(t).

9. Click Add Port to add a port on the right edge. Select the Hydraulic type, chose style
b, assign the Pressure variable PI(t) and the Volume Flow Rate variable - Q(t) [click
the +/- button to change the sign].

10. Click Refresh All.

11. In the Parameters table, change the default for g to 9.81 and assign its type Acceleration.
For rho, change its default to 1000 and its type to Density.

12 In the Variables table, change the type for P(t) to Pressure.
13. In the Dimensional Analysis section, click Check Dimensions. The following expression

2 6 3
517 — 13 Q(1) m_ LQ“) mT.Thisindicatesadimensional

50000 5 2 5000
inconsistency. Because it is benign we can leave it as is. However, if you prefer to remove

Q(t)
Q1
the parameter Q1 the default value 1 with type VolumeFlowRate and protect it (add an

X to the Protected column).

appears:

the inconsistency, you could replace Q(t) in the original expressions with , assign

14. In the Component Generation section, change the Name to CentrifugalPump.

15. Click Generate MapleSim Component to create your component and to bring you back
into the MapleSim environment. The custom component now appears in the Definitions
> Components palette.

16. Drag the custom component into the Model Workspace and create the model shown in
Figure 6.12 using the specified model components and their settings from Table 6.5.

Tip: To attach the probe on the Circular Pipe component, right-click (Control-click for
Macintosh) on component, select Attach Probe, and then position the probe by clicking
on the workspace.

Note: To display the pressure and volume flow rate quantities for your output, select the
probe, and then select the Pressure and Volume Flow Rate quantities from under the In-
spector tab.

17. Click Run Simulation (B ) in the Main Toolbar. When the simulation is complete, the
following graph appears.
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6.6 Tutorial 6: Using the External C Code/DLL Custom
Component Template

In this tutorial, you will use the External C Code/DLL template to import external C Code
parameters and build your model by performing the following tasks:

* Specify the custom component name

* Specify the location of the external C/library

* Define the external C/Library code options

» Specify the directory of the generated Modelica code

* Generate and save the external code custom component

* Build the Simple External Function model

This model consists of three components, a Step function, a Constant Vector, and an Ex-
ternal C Code/DLL custom component.

The external C Code parameters are defined by a function that takes in
* adouble scalar input
* an input double array of size 2

* an output double array of size 3
and then returns a double scalar

To create the external code custom component:
1. Start a new MapleSim model that will call the external code.

2. Click Templates ( # ) in the Main Toolbar. The Create Attachment window appears.
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3. From the list, select External C/Library Block.

4. In the Attachment field, enter a name for the template and click Create Attachment.
The External C/Library Block template opens in Maple.

5. Provide 'ExternalCode' as a name for the custom component.

Specify the name of the MapleSim custom component to be generated.

Elock Name: Externallode

6. Select Provide External Code using Text Area and specify the location for the external
C/library in Save to C File.

Provide External Code using Text Area Specify Header File

[] Attached CjOLLISO  |Fl.c Refresh attachments List
Save ko C File: |C D\ Temph £1.0 | Select File
Location of Header File: | | Select File

7. For a Windows platform, in the text area, enter the C code using the function declaration
as shown in Figure 6.13. For a Unix platform enter the C code using the function declar-
ation shown in Figure 6.14.

[ ‘alidate and Save Cilibrary File ] [ ‘alidate and Attach Cjlibrary File to MapleSim Model ]

ll."ﬁ‘ﬁﬁ‘ﬁﬁ‘ﬁ‘ﬁﬁ‘ﬁﬁ‘ﬁﬁwTTTTTTTTTTTTTTﬁﬁﬁﬁﬁﬁﬁﬁ'ﬁﬁﬁﬁﬁﬁﬂ‘ﬁﬂ‘ﬁﬂ‘ﬁﬂ‘ﬁﬂ‘ﬁﬂ‘ﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁwtwtwtwtw;

_ declspecidllexport] double  stdeall fl(double a, double *h, double *c)

{
c[0] = a*a;
c[1] = B[0] + b[1]:
c[2] = c[0]*c[1];

return 1.0;
H

ll."ﬁ'ﬁ'ﬁ'ﬁ'ﬁ'ﬁ'ﬁ'ﬁ'ﬁ'ﬁ'ﬁ'ﬁ'***************1€1€1€1€1€1€1€1€1€1€1€1€1€1€ﬂ'ﬂ'ﬂ'ﬂ'ﬂ'ﬂ'ﬂ'ﬂ'ﬂ'ﬂ'ﬂ'ﬂ'ﬂ'ﬂ'ﬂ'ﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁ*********;

Figure 6.13: External C Code Definition for Windows

\talidate and Save Cflibraty File ] [ ‘alidate and Attach ClLibrary File bo MapleSim Model ]

T R A T N T T N A A T A A AN A AT A AR AL AL AR LT RANTSS

double £1(double &, double *h, double *o)

Figure 6.14: External C Code Definition for Unix

8. Click Validate and Save C/Library File.
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9. In the ExternalC/Library Function Name and Definition section, enter 'f1' for the
External Function Name.

Function Name:

External Function Mame:

10. Use the following values for the double scalar input 'a' as follows and then click Add
Parameter. The parameter appears in the Arguments Table as shown in Figure 6.15.

Arguments:

Parameter Name: [ Passed By Reference
Data Type: | Float | [ Array?

Add Parameter

11. Use the following values for the input double array 'b' of size 2 as follows and then click
Add Parameter. The parameter appears in the Arguments Table as shown in
Figure 6.15.

Arguments:

Parameter Mame: l:l || Passed By Reference
Data Type: |float - | Array?

Add Parameter

12. Use the following values for the output double array 'c' of size 3 as follows and then
click Add Parameter. The parameter appears in the Arguments Table as shown in
Figure 6.15.

Arguments:

Parameter Mame: Passed By Reference
Data Type: |Floak - Array?

Add Parameter

Port Name Paott Type Change Row

1 |a Float

z2 b float, 2

3 Float, 3, output

Remove Parameter Row ID to Remove: Clear Tahls
Figure 6.15: Arguments Table




200 « 6 MapleSim Tutorials

13. Use the following values for the C function return parameter.

Output:
specify whether the external C/Library function returns a value. If it does, specify the name of the return parameter and its datatype.

Return?

Return Type: | Float -

14. Specify where you want to save the generated Modelica custom component code.

Target directory: |C:\Temp H Browse I

15. Click Generate External Code Component. In MapleSim, the custom component ap-
pears under the Definitions tab, in the Components palette, on the left side of the
MapleSim window.

[ Generate External Code Component J

To use the external code custom component:

1. Using the specified model components and their settings from Table 6.6 drag the com-
ponents into the Model Workspace and set their values.

Cutput Array
Input Scalar LT value
starfTime=5 s Qutput Scalar
value
inpwt Array

k=[5, 8]
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Note: Ensure that the model component parameter values are set in your model. When you
select a component in the Model Workspace, the configurable parameter values for that
component appear in the Inspector tab located on the right side of the MapleSim window.

Table 6.6 shows the required components and their settings.

Table 6.6: External C Code DLL Custom Components and Required Settings

Component Symbol Component Required Settings
Location
Custom C br | Definitions >

Component | | Components Use default settings

Libraries > Signal

Constant Vector — Blocks > Sources > | Constant output value, set K to [ 5, 8]
Real
Height: 4
Libraries > Signal
Step Blocks > Sources > |Offset: 0
Real
_ To: 5

2. Connect the Step component to custom component input port a.
3. Connect the Constant Vector component to custom component input port b.

4. Attach a probe to the custom component output port ¢ and enter the following values:

Frobe 1] @

Qutput Array

Real wvalue

5. Attach a probe to the custom component output port r and enter the following values:

Probe 1} @

Qutput Scalar

J| Real walue
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6. Click Run Simulation (b ) in the Main Toolbar. When the simulation is complete, the
following graphs appear.
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7. To verify the results, in the Libraries tab, expand the Examples palette, expand the
User's Guide Examples menu, and then open the Simple External Code Function
example.
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6.7 Tutorial 7: Using the Equations Template

In this tutorial, you will use the Equations template to extract the equations for a Spring
Damper model by performing the following tasks:

* Create the model

» Generate the Equations Template

» View, manipulate, and reassign equations

The Equations Template contains pre-built embedded components that lets you extract,
manipulate, and analyze the symbolic system equations generated by any MapleSim model.
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With this template, you can define system parameters and variables, set the level of equation
optimization, generate the equations, and further analyze the resulting equations. You can
use any Maple commands to perform detailed equation analysis, assign model equations to
a variable, and define additional system variables and parameters. These features are useful
in generating reusable equations when there is more than one subsystem.

Template Description

The Equations Template is a collection of pre-built controls and procedures associated with
specific Maple commands to easily generate equations from MapleSim models. When you
simulate a model, all parameter units convert to SI units, allowing you to select more than
one system of units for parameter values throughout the model.

The Equations Template consists of two main arecas, Equation Display and Equation
Manipulation.

Equation Display Area

The Equation Display area consists of three sections, Subsystem Selection, Parameter
and Variable Manipulation, and View Equations. Use this section to extract the equations
for an entire model or one of its subsystems.

Subsystem Selection

This section loads the MapleSim model and shows all subsystems and their components.
From the toolbar you can select a subsystem and load its subsystem equations.

If no subsystem is selected, equations for the whole model will be loaded when you click
Load Selected Subsystems.
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Step 1: Subsystem Selection

Main ™ -

m

£ 77

Load Selected Subsystem. Extracts the model equations and loads the system parameters
and variables.

Parameter and Variable Manipulation

In this area you can customize and define parameter and DAE variables for the generated
equations.
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DAE Variables:

[ Clear Filters ] ’ Reset Substitutions

‘ Variables New Name Filter ‘
Parameters:

[ Toggle Symbolic ] ’ Clear Filters

‘ Parameters Mew Name Value Symbolic Filter |

[] 5implify returned equations (may take time for large equations) [ Save new names for variables and parameters in the madel

Reassign Equations

DAE Variables

You can rename the DAE variables by specifying a new variable name in the New Name
column. For example, variable s(t) can be changed to x(t).

Variables. Contains the model DAE variables.

New Name. Provide a new name for the DAE variable.

Filter. Select the equations with the specified variable.

Clear Filters. Clears all selections to show all of the equations.

Reset Substitutions. Resets all changes made in the New Name columns for the DAE
Variables and Parameters sections.

Parameters

You can rename the parameters in the New Name column. By default, all equation parameters
are substituted by their numeric values. You can manually select which parameters you
want to leave in the symbolic form by entering “X” under the Symbolic column beside the
parameter of interest. In the Filter column only equations with the selected variable or
parameter are shown. Alternatively, if you want all the parameters in symbolic form, select
Toggle Symbolic. An “X” will appear beside every parameter. After a symbolic parameter
is selected for filtering, it will appear in symbolic form.

Parameters. Contains the model parameters.
New Name. Provide a new name for the model parameter.
Value. Displays the new parameter value as specified in MapleSim.

Symbolic. Enter "X" to select which parameters you want to leave in the symbolic form.
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Filters. Select the equations by the specified parameter.
Toggle Symbolic. Switches the parameter symbolic setting selection to all or none.
Clear Filters. Clears all selections to show all of the equations.

Simplify returned equations. Invokes the appropriate simplification procedures, rules and
symbolic algorithms to reduce the index of the equation, and searches for function calls,
square roots, radicals, and powers. For more information, see the GetEquations help page.

Save new names for variables and parameters in the model. Select this option to store
the substitutions made in the New Name columns in the MapleSim model.

Reassign Equations. Click Reassign Equations to update the new equation names and
show the changes to the variables and parameters.

View Equations

This area shows the system of equations in symbolic form with the assigned parameters.
You can select which equations you want to look at by selecting one of the equation types
(DAEs, Definitions, Relations, Events, ODEs, AEs). These equations are automatically as-
signed to their respective equation variables and can be manipulated in the main body of
the Maple worksheet. DAEs are assigned to DAEs, Definitions are assigned to Definitions,
and so forth. For more information about equation types, in Maple, enter ?GetEquations
at a prompt in a worksheet.

Step 2: View Equations

Equations:

Equations Types: (@ DAEs Definitions Relztions Events ODEs AEs

[ DAEs |

Equation Manipulation Area

You can also use this template to manually generate additional equations using the
GetEquations command to get active MapleSim subsystem equations. For additional
equation extraction options see the GetEquations help page. Equations in the template are
automatically assigned to the variable DAEs, allowing them to be manipulated in the main
body of the Maple worksheet.

Note: Maple applies simplification rules to equations stored in their respective equation
types by using Maple's simplify command if the simplify option is set to true. For large
sets of equations this can take significant amounts of time and memory. For these situations
set this option to false.
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Generating the Equations for the Spring Damper

This model consists of a prismatic joint (also called a slider or translational joint) attached
to a rigid body, both from the Multibody library. The prismatic joint connects to the Fixed
Frame and allows one translational degree of motion along the Y-axis. For this system,
gravity is assumed to be the only external force, acting along the Y-axis. You will group
these components into a subsystem, define the system parameters and reference the subsystem
parameters. For the purpose of this tutorial, you will generate sample equations with pre-
defined differential equations.

Ensure that the model component parameter values are set in your model. When you select
a component in the Model Workspace, the configurable parameter values for that component
appear in the Inspector tab located on the right side of the MapleSim window.

Table 6.7 shows the required components and their settings.

Table 6.7: Spring Damper Components and Required Settings

Component Symbol Library Location Required Settings
Libraries >
Fixed Frame ﬁ—u Multibody > Bodies | Use default settings
and Frames

Libraries >
Multibody > Bodies |Mass, set mtol kg

Rigid Body o

and Frames
Translational axis in the y direction, set élto
- a Libraries > [01,0]
Prismatic ‘ Multibody > Joints

Spring constant, set K
and Moments pring S

Damping constant, set K d

Generating the System Equations

To generate the system equations:

1. Create the following model using the specified model components and their settings
from Table 6.7 .
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L —r
v I

2. Place the Prismatic joint and Rigid Body in a subsystem called sub. This allows the
Equation Template to generate equations specifically for the selected subsystem.

3. Click Templates ( @ ) in the Main Toolbar and select the Equations template.

4. In the Attachment field, provide a worksheet name and click Create Attachment. Your
MapleSim model opens in a Maple worksheet, with the Subsystem Selection window.
The toolbar shows all of the subsystems.
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Main ® -

Main ™ l -

m
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5. From the toolbar select the sub subsystem. The sub subsystem components appear.

Main ®» sub P -

m

4 2

6. Click Load Selected Subsystem. The sub component parameter and variables load
automatically in the Parameter and Variable Manipulation areas.
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View Equations Area
The system equations appear in the View Equations area.

Step 2: View Equations

Equations:
Equations Types: (@ DAEs () Definiions () Relations () Events () ODEs () AEs
H L d [i "Main.sub RBJ..U"({)] + 1 [i [i "Main.sub RB1 zeta ({)}] sin Mainsub RBl.aa’(1)) ;
10000 dr | dr 10000 | d | dr El
+ 10[1}00 [% "Mainsub RBI zem'(()} [% "Mainsub RBI eta (1)] cos( ‘MainsubRBI eta’(1)) =0,
[ 10[1}00 % [ % ‘Main.sub RBI zeta (1) ]J cos( Mainsub RBI xi'(t)) cos( Mainsub RBI eta’(t))
— 10[1}00 [% 'Mam.sué.RBI.zem'(r)J [% "Mainsub RBJ.:G"({]] sin( "Mainsub RBI.xi'(t)) cos( MainsubRBI.
eta’(t))
— 10[1}00 [% ‘Main sub RBI zeta (1) | cos| Mainsub RBI i (1)) [ % "Mainsub RBI eta ‘(r]] sin( Mainsub RBI.
eta’(t)) + 10[1}00 [% [ % '}.fam.sub.RBJ.em‘[r]D sin( Mainsub RBI.xi (1))
10&!00 % 'Mam.suaRBI.em'(f)] [E "Main.sub RHJ._U"({]] cos( Mainsub RBI.xi' (1)) = U]: )
1t 44 s

Manipulating the Equations for the Spring Damper

By default the above equations are automatically stored in the variable DAEs. In the example
below, only part of the equation is shown in the Equation Manipulation section.

[The above equations are automatically stored in the corresponding variables. Uncomment (remove # at the
beginning of the line) the variable that you want to see,
> Vector (DAE=) ;

#Vector (Definitions) ;

#Vector (Relations) ;

#Vector (Events) ;

#Vector (ODEs) ;

#Vector (AE=) ;

For more control, use the GetEquations command directly:

> A := MapleSim:-LinkModel () :
ret := A:-GetEquations ('output' = 'all', 'filter' = {}, 'simplify' = true):
DAEs := ret[l]:
Definitions := ret[2]:
Relations := ret[3]:
Events := ret[4]:

Functions := ret[5]:

> DAEs;

> A:-GetVariables ('daeonly') ;
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6.8 Tutorial 8: Modeling Hydraulic Systems

This tutorial provides you with a basic description of hydraulic systems and helps you un-
derstand how to model these systems in MapleSim. Using components from the Hydraulic
library, you will create models, set initial conditions and component properties, and assign
new values to parameters and variables.

The hydraulic components are designed primarily to convert hydraulic flow into mechanical
motion, but can also be used to model pure hydraulic circuits.

In this tutorial, you will perform tasks based on the following basic principles and concepts:
» Basic Hydraulic Library Components

* Basic Hydraulic Equations

* Analysis of Simple Hydraulic Networks

* First Principles Modeling

* Mechanical and Hydraulic Systems

The following sections provide conceptual models that you can build using the hydraulic
library components.

* Controlling Hydraulic Flow Path

* Actuating Multibody Systems with Hydraulic Components
* Compressibility of Hydraulic Liquids

* Fluid Inertia Models

* Water Hammer Models

* Hydraulic Custom Components

Computational Issues

Hydraulic networks tend to be numerically stiff. Generally, the stiff rosenbrock solver is
recommended.

Basic Hydraulic Library Components

This tutorial uses the following basic Hydraulic library components.
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Table 6.8: Basic Hydraulic Library Components

Fixed Pressure
Source

Libraries > Hydraulic >
Sources

Component Symbol Library Location Its Use
Atmospheric T Libraries > Hydraulic > This component defines a base pressure
Pressure L Reference Components (similar to ground in the electrical domain)
P and represents a connection to the atmosphere
All hydraulic models need a Hydraulic Fluid
Properties component. Similar to a Parameter
block, it is placed in the Model Workspace
to define the following hydraulic fluid
. properties:
Elyq;aullc Libraries > Hydraulic > . . .
ud- Reference Components|® rhoFluid: fluid density
Properties
¢ EIFluid: Bulk Modulus is the fluid
compressibility
* nuFluid: Kinematic Viscosity is the dynamic
viscosity divided by liquid density
Hydraulic
Motor ° Actuators convert hydraulic flow into the
Libraries > Hvdraulic > motion of a mechanical body. MapleSim
Actuators Y offers a Hydraulic Cylinder (for translational
motion) and a Hydraulic Motor (for rotational
Hydraulic motion).
Cylinder
l;g;er(i:low You can specify either the flow rate or the

pressure of the hydraulic source (with
MapleSim calculating the other quantity). If
a Pressure Source is used, then MapleSim
balances the load in the hydraulic system
against the pressure source to find the flow
rate, and vice-versa.

Circular Pipe

.@?ﬁ-u
Gy
O
S

Libraries > Hydraulic >
Pipes and Valves

The circular pipe introduces a pressure drop
in a hydraulic line. The pressure drop is given
by the Darcy equation, with the friction factor
being determined by using predefined
equations.
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Basic Hydraulic Equations

The Bernoulli and the Darcy equations are the fundamental equations necessary to analyze
hydraulic systems and define the fluid pressure and flow rate characteristics for any point
along a flow. This tutorial uses the following basic fluid equations.

* Bernoulli Equation
* Darcy Equation

¢ Friction Factor

Bernoulli Equation

The Bernoulli Equation defines the pressure and flow rate characteristics of incompressible
fluid flow in a pipe. For any point along a streamline, the following relationship applies.

2
P + L + z = constant

pg 29
Darcy Equation

For an incompressible fluid flowing through a pipe with a constant diameter, the pressure
drop due to pipe friction is given by the Darcy equation.

2
LV
AP=f
fD-Z-g
Hence
2 2
bV +z4f LVZ _ constant

p-g ‘g D-2-g
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Table 6.9: Bernoulli and Darcy Equation Notation

Symbol Description Units
P Pressure Pa
. k
p Density —i
m
o m
g Gravitational constant Zz
\Y Velocity m
s
z Elevation m
L Pipe length m
D Pipe diameter m
f Friction factor dimensionless

Hence pressure must be applied to overcome internal frictional effects within the liquid (in
laminar flow), and the effect of the surface roughness of the pipe (in turbulent flow). Fric-
tional losses (and any other loads in the system) have to be balanced against the applied
pressure to determine the flow rate.

In MapleSim’s mechanical-hydraulic systems, the vertical displacement z is insignificant
compared to the other terms, and is ignored.

Friction Factor

In laminar flow, the internal frictional (f) effect is determined by the following equations:

_ 64

f_Re

Re:M
v

where

f is the internal friction
Re is the Reynolds number
D is the pipe diameter
V is the fluid velocity and

v is the dynamic viscosity
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In turbulent flow, the frictional effects of the surface roughness of the pipe are characterized
by the Haaland Equation.

2
6.9 . 1.11]]
[1.8 logIO[ 2 4 [ 3.7.Dj

The Reynolds number (Re) indicates whether flow in a pipe is in laminar or turbulent flow,
or is in transition between the two. For example, the circular pipe parameters in Table 6.10
gives the Reynolds number for laminar (ReL) and turbulent (ReT) flow. Between these
two parameters, the friction factor is determined by linear interpolation.

Table 6.10: Circular Pipe Parameters

Symbol Description Values
D Pipe hydraulic diameter 0.01 m
L Pipe length Sm
€ Height of internal pipe roughness 1.5-10"° m
Rel Maximum Reynolds number in laminar regime 2000
ReT Minimum Reynolds number in turbulent regime 4000
P Fluid density rhoFluid
v Fluid kinematic viscosity nuFluid

Analysis of Simple Hydraulic Networks

This section simulates a simple hydraulic system and analyzes the results from first principles
and explains how to:

* Create a simple laminar pipe flow hydraulic system
* Analyze the governing equations by applying various laws (for example, conservation

of mass, Bernoulli Equation, Darcy Equation)

Flow Through a Pipe

Figure 6.16 analyzes pressure and laminar flow rate characteristics through a pipe when
pressure is applied to overcome internal frictional effects.

To analyze flow through a pipe:

1. Create the following model using the specified model components and their settings
from Table 6.11.
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Tip: To attach the probe on the Circular Pipe component, right-click (Control-click for
Macintosh) on the component, select Attach Probe, and then position the probe by clicking
on the workspace.

Probe1
1 Re.p, g
FP2 i
© <
i'F’l C‘F’I
L L
AP AP

Figure 6.16: Flow Through a Pipe

Table 6.11: Hydraulic Components and Required Settings

Component | Quantity | Symbol Library Location Required Settings
Atmospheric 2 IL Hydraulic > Reference Use default settings
Pressure Components

. kg
rhoFluid: 850—
m
Hydraulic Fluid 1 Hydraulic > Reference . s
Properties Components ElFluid: 8.0x10° Pa
2
nuFluid: 0.000018 e
Fixed Pressure . .
1 ._®_u Hydraulic > Sources | Use default settings
Source =
o
Circular Pipes 1 =B Sﬁzmw Pipes and .. Table 6.10

2. Click the probe and select the Real (the instantaneous Reynolds number), Pressure, and
VolumeFlowRate probe parameters.
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3. Click Run Simulation (b ) in the Main Toolbar. When the simulation is complete, the
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Confirming the Modeling Results from First Principles

When analyzing the system shown in Figure 6.16, apply the Darcy Equation,

AfP_f_L-VZ
p-g D2g

Assuming that the system is in laminar flow, then

_ 64

f= Re
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Hence
Lo 645V
850 x 9.81 0.01 x V 0.01 2 x 9.81
0.000018
0.0001199256461 = 2.935779816 V
Where

m
V =0.0000408 s
Using V in the flow rate equation yields the following result

2 3
Q = 4i Vr D? = 0.0000408 x % =3.2x100

This is the same value given by MapleSim. Using the calculated value of V gives Re=0.02.
This is far less than the critical value of 2000, and hence the system is in laminar flow.

Overview of Controlling Hydraulic Flow Path

A spool valve has a sharp-edged variable area orifice that enables or partially restricts flow
in a pipe, and can assist in switching flow from one part of a hydraulic network to another.
A spool valve has three ports.

Table 6.12: Spool Valve

Spool Valve Name Description ID
inp Port4 Upstream port portA
¥ PortB Downstream port portB
;] i ]
portA ports inp Input signal inp

The top port (inp) accepts a signal input that is equal to the open valve area. By regulating
the valve area, flow switches on or off. The left and right ports (portA and portB) are hy-
draulic connectors. In the following diagram, the model switches flow from the top leg to
the bottom leg when the simulation time reaches five seconds. That is, initially, the top
spool valve is open and the bottom is closed. After 5 seconds, the top spool valve closes,
and the bottom opens.
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Figure 6.17: Controlling Flow Path

Mechanical and Hydraulic Systems

In the following examples you will use multidomain components to simulate translational
motion in mechanical and hydraulic models with the following sources:

« Fixed Flow Rate Source

¢ Fixed Pressure Source

Simulating Translational Motion with a Fixed Flow Rate Source

The following model converts flow from a fixed flow source to translational motion using
the components and their settings from Table 6.13.



220 « 6 MapleSim Tutorials

3

Figure 6.18: Fixed Flow Rate Source

Probe1
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Table 6.13: Translational Motion with Fixed Flow Rate Sources

Component Quantity Symbol Library Location Required Settings
Atmospheric T Hydraulic > Reference .
Pressure 1 L Components Use default settings

. kg
rhoFluid: 850 —
m
Hydraulic Fluid 1 Hydraulic > Reference . s
Properties Components EIFluid: 8.0x10° Pa
—_ 2
nuFluid: 18 x1076 mT
Fixed Flow . .
>
Source 1 -—@—n Hydraulic > Sources Use default settings
Hydraulic - a . .
: >
Cylinder 1 mﬁ' Hydraulic > Actuators Use default settings
|
Mass 1 - I-D Me(fhanlcal ” Use default settings
Translational > Common
—
Translational 1-D Mechanical > .
Fixed 1 Translational > Common Use default settings

Note: The Hydraulic cylinder has a cross-sectional area A of 1 mz, while the Fixed Flow

m3
Source has a flow Q of 1 T

The cylinder pushes the sliding mass at a speed of

vy Q_1m’st _m
A 1"’12 S

This is confirmed by running the simulation and probing the speed of the sliding mass.
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Simulating Translational Motion with a Fixed Pressure Source

Replace the Fixed Flow Source with the Fixed Pressure Source component shown in
Figure 6.19 and Table 6.14. The following model converts flow from a fixed pressure
source to translational motion.

Probe
S 5 v, a
.
Fi F’1 s
{.J
HE, n
. i . R
(- L= )
—
m=1 kg
F
1
=
L rpz

AP

Figure 6.19: Translational Motion with Fixed Pressure Source
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Table 6.14: Translational Motion with a Fixed Pressure Source
Required Settings

Component Symbol Library Location

Fixed Pressure -—@—n Hydraulic > Sources Use default settings

Source
-

The force on the Sliding Mass is equal to the cross-sectional area of the hydraulic cylinder
A multiplied by the pressure P of the hydraulic fluid.

F=A-P=1m*-1Pa=1N
The acceleration of the Sliding Mass is giving by
F=m-a=1m"-1Pa=1N
1N=1kg-a
Therefore
m
a=1—
SZ

By probing the acceleration, speed, and displacement of the Sliding Mass, these values are

confirmed with the results in Figure 6.20.
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Figure 6.20: Fixed Pressure Source Results

Overview of Actuating Multibody Systems with Hydraulic Components

In the following model connect the 1-D translational port on the hydraulic cylinder to the
1-D translational port on the multibody prismatic joint using a Translation Fixed flange and
a Rigid Body mass from Table 6.15.

T
i T
i /4

Figure 6.21: Translational Fixed Flange Hydraulic component
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Similarly in the following model, connect the 1-D rotational port on the hydraulic motor to
the 1-D rotational port on the multibody revolute joint using a Rotational Fixed flange and
a Rigid Body mass from Table 6.15.

)

EESEEEaamEs :Q} e @

:,r:.rf.rf.r
s
e

Figure 6.22: Rotational Fixed Flange Hydraulic component

Table 6.15: Actuating Multibody Components

Component Symbol Library Location Required Settings
Fixed Flow . .
Source "O" Hydraulic > Sources Use default settings
Rotational Fixed 1-D Mechanics > Rotational .
Flange 77;7 > Common Use default settings
Translational 1-D Mechanics > )
Fixed Flange Translational > Common Use default settings

Atmospheric Hydraulic > Reference Use default settings
Pressure Components

Hy@rauhc Hydraulic > Actuators Use default settings
Cylinder

777
1
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Component Symbol Library Location Required Settings

Hydraulic Motor "(g) © | |Hydraulic > Actuators Use default settings
u [u}

. . Multibody > Joints and .
Prismatic ‘ Motions Use default settings
Rigid Body ==t | [Multibody > Bodies and Use default settings
Frame Frames

. - .

Rigid Body o I Multibody > Bodies and Use default settings

Frames
(=] [

Revolute u:@ MulFlbody > Joints and Use default settings
Motions

Fixed Frame §—U Multibody > Bodies and Use default settings
Frames

Pascal's Principle

Pascal's Principle states that pressure applied to a closed hydraulic system is transmitted
everywhere equally. This principle shows that an applied force can be amplified to move
loads that would otherwise not be possible.

The model in Figure 6.23 demonstrates a simple example of Pascal's Principle. A 1 N force

(acting on a 0.1 m? hydraulic cylinder) transmits hydraulic pressure to a 1 m? hydraulic
cylinder, which lifts a 1kg load vertically. Normally, a 9.81 N force maintains the height
of a 1 kg force, but this simple hydraulic system multiplies the magnitude of a 1 N load by

1
a factor of 10 or m 5 -
0.1 m
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Figure 6.23: Pascal's Principle Example

Overview of Compressibility of Hydraulic Liquids

The compliant cylinder and constant volume chamber components (Table 6.17) model the
compressibility of hydraulic liquids under high pressure. The compliant cylinder component
also models pipe wall compliance. Both have to be attached to a node between pipes or in-

ertias as shown in Figure 6.24.

Probe

1

f

startTime=0.05s

Figure 6.24: Hydraulic Liquids Compressibility



228 « 6 MapleSim Tutorials

Table 6.16: Hydraulic Liquids Compressibility Components

Component Symbol Library Location Required Settings
Fixed Pressure —{ }a | |Hydraulic > Sources Use default settings
Source Y &

-—

Atmospheric T Hydraulic > Reference .
Pressure = Components Use default settings
Llne?ar 'Ef' Hydraulic > Pipes and Use default settings
Resistance PN Valves

Table 6.17: Confined Hydraulic System Components

Component | Quantity | Symbol Library Location Required Settings
Compliant . .
. 1 Hydraulic > Chambers | Use default settings

Cylinder
Constant . .

1 Hydraulic > Chambers | Use default settings
Volume

Overview of Fluid Inertia Models

The Fluid Inertia component models the inertia of liquid accelerating or decelerating in a
pipe and is analogous to mechanical inertia. Fluid Inertia can be significant for large diameter
pipes and when the acceleration/deceleration is large. This component is useful when
modeling water hammer.

Table 6.18: Fluid Inertia

Component | Quantity | Symbol Library Location Required Settings
Fluid Inertia 1 pp— }\{/;%r;u}lc > Pipes and Use default settings
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System Without Fluid Inertial

Figure 6.25 shows a system without fluid inertia.

il

starfTime=1 s Praobe 1 Prabe 2
value 1 q
n 1
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Figure 6.25: System Without Fluid Inertia

System With Fluid Inertial

Figure 6.25 shows a system with fluid inertia.

.

Probe 1 Probe 2

startTime=1 s
value ' q
i
1
— e 1)
U — Rl

Figure 6.26: System With Fluid Inertia

Figure 6.27 shows typical system flow rates with (green) and without (red) fluid inertia.

Introducing fluid inertia adds a lag into the system.
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Figure 6.27: System With and Without Fluid Inertia

Overview of Water Hammer Models
Water hammer occurs when a valve suddenly stops (or significantly restricts) flow in a pipe,
resulting in a pressure surge due to a momentum change in the fluid inertia. This pressure

surge bounces off the closed valve and travels up and down the pipe, potentially causing
significant damage to the entire pipe. Water hammer is traditionally modeled by the numer-

ical solution of the following equations.

avixt) 1 (dP(x 1))  fV(x O|V(x 1)
dt P dt 2D

1 dP(xt) _

avix t)
dx Ks dt
1
K =
"1, D
K Et

Where
V(x,t) is the pipe velocity

P(x,t) is the pipe pressure

p is the liquid density
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D is the pipe diameter
t is the pipe wall thickness
K is the liquid bulk modulus

E is Young’s modulus for the pipe

f is the friction factor

These equations (with the appropriate boundary and initial conditions) are typically solved
numerically, requiring custom code to solve the equations using the method of characteristics.

Example: Water Hammer

Another method of simulating water hammer involves building a lumped parameter pipeline
model. The pipeline model includes effects such as flow inertia, flow resistance (through
pipe friction), pipe compliance, and fluid compressibility.

The following figure shows a discretized pipeline with inertial and resistive properties, ini-
tially pressurized at one end to create flow. After two seconds, a valve at the other end is
closed, resulting in a pressure surge.

/_\B_* H ! )H !
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J 1 2
P‘:rjm:'rms =2 H“ )’%7 *)' )ﬁ o —
Hfmumcapcr.m HydraulicPipeline,, HydmulicPipeling,, HydrulcPipetine, , HydrulcPipetine.

starfTime=2s  T=001s

J J J | “
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1 1 1 1 T
HydmulcPipetre, — HydmuicPipeline, ~ HydmulicPipsine,  HydrmulicPipsiine, .~ Hydwoicrpsiins, : sv,
|
: Probe1
O

p.a
Figure 6.28: Water Hammer

Each subsystem consists of a compliant cylinder, a pipe, and a fluid inertia component as
shown in Figure 6.29. A pipeline (of total length L and volume V) with N segments has

N + 1 pipes, each with a length,
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L
N+1

N+1 fluid inertia components, each with a length,

L
N+1

N constant volume chambers, each with a volume,

4
N

ﬁ
cP Fi

Figure 6.29: Discretized Pipeline Segment

To build the water hammer model:

1. Build the model with the components and connections shown in Figure 6.28 and
Figure 6.29.

2. Configure the Fluid Properties component with the values specified in Table 6.19.

Table 6.19: Fluid Properties Values

Parameter Symbol Description Value
Name
rhoFluid P Fluid density 1000 kg m™
ElFluid K Fluid Bulk Modulus 200 10° Pa
nuFluid v Fluid kinematic viscosity 1073 m
rhoFluid s

3. Configure the parameter block with the parameters and values shown in Table 6.20.
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Table 6.20: Water Hammer Parameters

Parameter Name Description Value
N Number of pipe segments 20
Dia Pipe hydraulic diameter (D) 0.1m
Len Pipe Length 25m
Em Pipe Young's Modulus (E) 70 10° Pa
ef Pipe internal roughness 0.0001 m
thickness Pipe wall thickness (t) 0.001 m

4. For the Fixed Pressure component (FP, in Figure 6.28), set the pressure, P, to 500kPa.

5. Configure the Circular Pipe components in Main and the HydraulicPipeline shared
subsystem with the following settings.

Parameter Setting
Name
D Dia
L Len
N+1
€ ef
Re; 2000
Rer 4000
p rhoFluid
v nuFluid

6. Configure the Fluid Inertia components in Main and the HydraulicPipeline shared
subsystem with the following settings.

Parameter Setting
Name
A 1
i
2" Dia
L Len
N+1
P rhoFluid

7. Configure the Compliant Cylinder component in the HydraulicPipeline shared subsys-
tem with the following settings.
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Parameter Setting
Name
o 0
L Len
N
D Dia
D, Dia + 2*thickness
Em Em
v nuFluid
El ElFluid

8. For the First Order component, set T to 0.01s and yO0 to 0.01.
9. Configure the Step component with the following settings.
» For height, enter -0.009999.
* For offset, enter 0.01.
» For T, enter 2s.
10. Under the Settings tab, configure the following Simulation parameters.
» For tg, enter 3s.
» For Solver Type, select Variable.

» For Solver, select Rosenbrock (stiff).

Figure 6.30 plots the pressure and flow rate at the end of a pipe for a valve that rapidly
closes after 2 seconds.
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Figure 6.30: Water Hammer Pressure Flow Rate

The maximum pressure is about 5 x 10%Pa, with the liquid reaching a flow rate of 0.099 mT .

The maximum pressure can also be calculated using the Joukousky equation,

AQ
AP=pc=-=

Ke
c= | —
p
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1
1, D
7+7
K ' Et

Ke =

If you substitute the parameters from Table 6.19 and Table 6.20 into the preceding equations,
and then assume

3
AQ=0.099 mT
you get
AP = 5x10°Pa
This result agrees with the MapleSim model.

Example: Attenuating Water Hammer with an Accumulator

A hydraulic accumulator is a reservoir, often located near a valve, that stores non-compress-
ible hydraulic fluid under pressure. An accumulator acts as a safety valve by allowing fluid
to enter the reservoir when the pressure increases beyond a certain threshold value. This
action attenuates the magnitude and frequency of the pressure waves.

MapleSim does not have a built-in Accumulator block, but this functionality is easily
modeled with the Custom Component template using the following equations. For a complete
description on how to create custom components, see Creating Custom Modeling
Components (page 69).

Ks p(t) p(t) < ppr
=1 Vpr+ (k-(p(t) — ppr)) ppr < p(t) p(t) < pmax
Vmax + (Ks (p(t) — pmax)) pmax < p(t)

K= (Vmax — Vpr)
(pmax — ppr)

params := [Vmax =0.1, ppr = 105, pmax = 3-106, Ks = 4-10_10,
Vpr = 0]
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initialconditions := [ VF(0) = 0]

Table 6.21: Accumulator Parameters Custom Component

Description Values
Vmax 0.1 m
ppr 100000
Pmax 3000000
Ks 10x10719m
Vpr 0

The following figure shows the same pipeline with a pressure accumulator. After two
seconds, a valve at the other end is closed, resulting in a pressure surge. Figure 6.31 shows

the pressure surge at the end of a pipeline with an accumulator.
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Figure 6.31: Pressure Surge With an Accumulator

Overview of Hydraulic Custom Components

Two examples of hydraulic custom components are centrifugal pumps and vertical pipes.
For a complete description on how to create custom components see Creating Custom

Modeling Components (page 69).

Centrifugal Pumps
Typically, manufacturers provide head flow rate charts for centrifugal pumps, as shown in

Figure 6.32.
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Figure 6.32: Head Flow Rate

Data from these charts is easily implemented into a custom component.

To implement chart data:
1. Read several sets of head flow rate points from the plot.
2. Fit these data points to a polynomial using the Maple curve-fitting functionality.

3. Implement the polynomial into a custom component. Figure 6.33, for example, shows
the custom component equations for a centrifugal pump (including the best-fit parameters).

Note: Since the equation is a polynomial, several solutions may exist.

eg=[P(t)=(d+c Q1) + 5Q(1)* + a Q(t)’) p-g P(¢) = Pr(1r) — Pi(1)] -
params == [a=-3352110"%, b=-0.0000039589, c = 0.009948, d = 35.04, p = 1000, g = 9.81] -
initialconditions == [ | :

Figure 6.33: Centrifugal Pump Custom Component Equations

Note: Assigning the value rhoFluid to the Density parameter sets the density to be the value
defined in the Hydraulic Fluid Properties component.

Vertical Pipes

Since gravity head is usually insignificant in mechanical-hydraulic systems, the base pipe
component in MapleSim does not model vertical pipe travel. For low-pressure systems,
gravity head can be significant. Figure 6.34 shows the custom component equations to
simulate gravity head.
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eg = [dP(t) =rho-g-z Pin(t) — Powt(t) = dP(1), Qin(t) = Qouz(1), ] :
params = [z=0,tho=1000,g=9.81]:
initialconditions = [ ] :

Figure 6.34: Gravity Head Custom Component Equations
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Table 7.1: Opening, Closing, and Saving a Model

Task

Windows and Linux

Macintosh

Create a new model

Ctrl + N

Command + N

Open an existing model

Ctrl+ O

Command + O

Close the active document

Ctrl + F4 (Windows)

Ctrl + W (Linux)

Command + W

Save the model as an .msim file

Ctrl + S

Command + S

Table 7.2: Building a Model in the Block Diagram View

Task

Windows and Linux

Macintosh

Cancel operation while drawing a
connection

Esc

Esc

Rotate the selected modeling

. + +
component 90 degrees clockwise Ctrl+R Command + R
Rotate the selected modeling
component 90 degrees Ctrl+ L Command + L

counter-clockwise

Flip the selected modeling component
horizontally

Ctrl+ H

Command + K

Flip the selected modeling component

. Ctrl+ F Command + F
vertically
Group the se}ected modeling Ctrl+ G Command - G
components into a subsystem
Reroute the selected connections Ctrl+D Command + D
Reroute all connections Ctrl + A Command + A
Create subsystem Ctrl+ G Command + G

Table 7.3: Browsing a Model in the Block Diagram View

Task

Windows and Linux

Macintosh

View the selected modeling
component or subsystem in detail

Ctrl+ M

Command + M

Zoom into the model workspace

Ctrl + numeric keypad plus
key, or

Ctrl and move the mouse
wheel forward

Command + numeric keypad
plus key, or

Command and move the mouse
wheel forward

Zoom out from the model workspace

Ctrl + numeric keypad
minus key, or

Command + numeric keypad
minus key, or

241
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Task

Windows and Linux

Macintosh

Ctrl and move the mouse
wheel backward

Command and move the mouse
wheel backward

Scale the model diagram to fit in the
model workspace

Ctrl+T

Command + T

Reset zoom factor to the default zoom
factor (100%)

Ctrl + 0 (zero)

Command + 0 (zero)

Table 7.4: Browsing a Model in the 3-D View

Task Windows and Linux Macintosh
Connect ports Ctrl + Shift + C Command + Shift + C
Move the camera around a 3-D model | Ctrl + left mouse button Command + mouse click and
in the perspective view click and drag drag
Panning a 3-D model Sl.lift * left mouse button Shift + mouse click and drag
click and drag

Zoom into or out from the 3-D
workspace

Alt + left mouse button click
and drag, or move the mouse
wheel forward (zoom in), or
backward (zoom out).

Alt + mouse click and drag, or
mouse wheel

components or connections to exclude

selection from the next simulation

Refresh 3-D view Shift + F5 Shift + F5
Table 7.5: Simulating a Model
Task Windows and Linux Macintosh
Run simulation F5 F5
View Visualization window (with
Simulation Results tab selected) if
main MapleSim window is in focus,
or
F6 Fo
bring MapleSim window into focus if
another window such as the
Visualization window is currently in
focus
Toggle enable/disable selected Ctrl + E Command + E
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Table 7.6: Modifying the Plot Window Layout

Task Windows and Linux Macintosh
Tile plot windows Shift + T Shift + T
Cascade plot windows Shift + C Shift + C
Fit plots in plot window. Shift + F Shift + F
Automatically adjust row heights to
fit all plots in a plot window in the
available vertical space.

Table 7.7: Miscellaneous
Task Windows and Linux Macintosh

Start Maple from MapleSim

F10

F10

For keyboard shortcuts for 2-D math notation, refer to Using MapleSim > Building a
Model > Annotating a Model > Key Combinations for 2-D Math Notation.
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Glossary

Term

Description

2-D math notation

Formatting option that allows you to enter mathematical
text, such as superscripts, subscripts, and Greek characters.

3-D workspace

The area of the MapleSim window in which you can build
and edit a 3-D model.

Shapes that you can display in a 3-D model to create a
realistic representation of a system model. Attached shapes

Attached shapes include cylinders, trace lines, and CAD geometry that you
import from another file.
Camera The point of view from which a 3-D scene is viewed.

Camera tracking

The process by which a camera follows the movement of
a target 3-D component that you select. The target
component is centered in the 3-D playback window during
an animation.

Custom component

A user-defined component that you can create and add to
a MapleSim model using the Custom Component Template.

Custom library

A collection of modeling components and subsystems that
can be saved in a user-defined palette and used in a future
MapleSim session.

Embedded component

Configurable graphical controls, buttons, meters, and other
interactive components that you can add to a Maple standard
worksheet to analyze, manipulate, and visualize equations
and Maple commands.

Default cylinders and spheres that are displayed in a 3-D

Implicit geometry model to represent modeling components.
A collection of routines or commands that can be used in
Maple package Maple. Most Maple packages provide a set of commands

for a particular mathematical or scientific domain, or field
of study.

MapleSim component library

The default collection of domain-specific modeling
components included in MapleSim. These modeling
components can be found in the gray palettes in the
Libraries tab.

The area of the MapleSim window in which you can build

Model workspace and edit a model in a block diagram view.
A type of 3-D view that uses parallel projection and displays
Orthographic view lines in the view plane at their "true length." In MapleSim,

you can view a model from front, top, and side orthographic
views.

Perspective view

A 3-D view that allows you to examine and browse a model
from any direction in 3-D space.
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Term

Description

Probe

The tool used to identify quantities of interest in order to
simulate a MapleSim model.

Shared subsystem

A subsystem copy that shares the same configuration as
other subsystems. All shared subsystems are linked to a
particular subsystem definition, which defines the
configuration.

Standalone subsystem

A subsystem that is not linked to a subsystem definition
and can be edited and manipulated independent of other
subsystems in a model.

Subsystem

A collection of modeling components grouped in a single
block.

Subsystem definition

A subsystem block that defines the configuration for a series
of shared subsystems.
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Symbols

2-D math notation, 59

3-D animation, 127

3-D display controls
3-D manipulators, 117
adding a trace, 116
Attached shapes, 114, 119
Implicit geometry, 113
Initial conditions, 126
Trace lines, 115

3-D model construction, 117

3-D Playback Window, 108

3-D view navigation, 111

3-D views
Orthographic, 111
Perspective, 111

3-D workspace, 110
axis designation, 111

A

Acausal Mapping, 77
Acausal modeling, 2, 5, 7
Across Variables, 3

Custom components, 78
Adding a Probe, 12
Advanced Simulation Settings, 96
Alpha, 97
Animating the 3-D Model, 127
Annotations, 57
API commands, 149
Arrow convention, 63, 65
Attaching Files to a Model, 54
Attachments palette, 54

B

Baumgarte, 97
Alpha, 97
Beta, 97

Best Practices, 67

Building 1-D Translational Models, 65
Building Electrical Models, 63
Building Hydraulic Models, 67
Building Multibody Models, 66
Enforcing Initial Conditions, 68
Laying Out and Creating Subsystems, 62
Simulating and Visualizing a Model, 128
Beta, 97
Building a Model
Adding and Moving Objects in the 3-D
Workspace, 120
Assembling a 3-D Model, 118
Displaying Attached Shapes as You Build
a 3-D Model, 119
Moving Objects in the 3-D Workspace,
117
Using the Unenforce Constraints Button,
119

C

CAD Geometry, 119
Causal modeling, 2, 5, 7
Code generation
C code, 137
initialization, 139
subsystem, 138
Compile optimized, 99
Compiler, 99
Connection lines, 23
Colors, 23
Connection ports, 23
Conserved Quantity Flow
arrow convention, 16, 65, 94
Constraint Handling Options, 142
Constraint projection, 97, 142
During event iterations, 98
Iterations, 97
Tolerance, 97
Constraint stabilization, 97
Construct mode, 117
Custom components
Defining equations, 85
Defining ports, 85

247



248 + Index

Editing, 83
External C Code/DLL, 147, 201
modeling from extrapolated data, 192
template, 195
Understanding Custom Components, 71
Custom libraries, 54
Custom plot window, 102

D

DAE Variables, 205
Data sets
creating in Maple, 61
generating for model, 54
Debugging console, 37
Diagnostic Messages, 7, 63
Differential algebraic equations, 1
Drawing, 57

E

Embedded components, 149

EMI Component Options, 141

Equations
Retrieving, 132
template, 209

Error tolerance, 95

Event hysteresis, 98

Event Iterations, 98

Event Projection, 98

Examples
Adding Attached Shapes to a Double
Pendulum Model, 115
Adding Text Annotation to a Model, 58
Assigning a Subsystem Parameter to a
Shared Subsystem, 42
Building a Double Pendulum Model in
the 3-D Workspace, 120
Copying and Pasting a Standalone Subsys-
tem, 38
Creating a Custom Library from an Exist-
ing Model, 55
Creating a Data Set in Maple, 61
Creating a Parameter Override, 50

Creating a Subsystem, 27
Creating and Using a Parameter Block,
44
Defining and Assigning a Global Paramet-
er, 40
Editing Shared Subsystems that are
Linked to the Same Subsystem Definition,
32
Nonlinear Spring-Damper Custom Com-
ponent, 89
Plotting Multiple Quantities in Individual
Graphs, 103
Plotting One Quantity Versus Another,
105
Removing the Link Between a Shared
Subsystem and its Subsystem Definition,
36
Resolving Warning Messages in the De-
bugging Console, 37

External C Code/DLL
custom components, 147, 201

F

Fixed time step, 95
Flow direction, 3

G

Global parameters, 154
Grid
3-D grid, 119
using CAD geometry, 119

H

Help pane, 18
Hydraulic Systems, 239
basic hydraulic equations, 213
basic hydraulic library components, 211,
215
Bernoulli Equation, 213
compressibility, 227
custom component, 236, 238
Darcy Equation, 213
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fluid inertia, 228 MapleSim Window, 6
Friction Factor, 214 Minimize events, 98
Joukousky equation, 235 Model tree, 19
multibody hydraulic, 224 Model Workspace, 7
multidomain, 219 Modelica, 91
Pascal's principle, 226 Modelica Custom Component, 71
spool valve, 218 Modeling components
translational motion, 222 Connecting, 10
water hammer, 230 Models
Building, 8
| Multibody
Implicit geometry, 113 Best Practices for building multibody
Index 1 error control, 98 models, 66
Index 1 tolerance, 98 Multibody Parameter Values, 110

Initial conditions, 50
Best practices for enforcing initial condi- P

tions, 68 Palettes, 7, 17
overrides, 53 Parameter block, 43
specifying, 25 Parameter optimization, 135
Specifying How Initial Conditions Are Parameter Override, 50
Enforced, 26 Parameter Sets, 48
Initial hysteresis, 98 Parameter values, 11
Initialization, 139 Parameters
Interpolation tables, 162 Advanced Parameter Settings, 42, 49
Advanced Variable Settings, 49
J Global parameters, 40
Jacobian, 97 Parameter sets, 99
Parameter values, 24
K Subsystem parameters, 42
Keyboard Shortcuts, 241 iiys%cai Cor(rilplonents, 7
Kinematic Constraints, 119 ysieal moce’s
Analyzing, 129
Navigating, 21
L Plot events, 99
Latest results Plot points, 96
From simulation, 101 Plot Windows, 107
Linear systems Plots
Analyzing, 133 Add Second Variable to Graph, 103
Set X-Axis Variable, 105
M Port and Parameter Management, 140
MapleSim component library, 5, 7, 17 Probes, 93
MapleSim Model Adding, 12

Embedded components, 149 arrow convention, 16, 65, 94
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Probes palette, 99 Subsystem
Progress information messages, 100 code generation, 138
Projection, 97 Subsystem(s)
Projection Iterations, 97 Adding a Port, 158
Projection Tolerance, 97 Adding Multiple Copies of a Subsystem
to a Model, 29
S Adding Subsystem Definitions and
Scaling, 98 Shared Subsystems to a Model, 31
Settings Creating and Managing, 27, 154
Advanced Simulation, 96 definition, 30
Simulation, 94 Editing multiple instances, 32
Sign convention, 3 linking, 30
Signal Flow, 77 parameters, 42
Simulating, 99 shared, 30
Simulation standalone, 37
Initial Conditions, 101
Simulation duration time, 95, 97 T
Simulation Graphs, 107 Templates
Simulation parameters Code Generation, 137
Compiler, 99 Custom Component, 84
Settings, 94 Equation Analysis, 132
Simulation results Linear System Analysis, 133
Clear message console, 100 Parameter Optimization, 135
Comparing, 101 Understanding Custom Components, 72
Exporting graph data, 103 Through Variables, 3
Managing, 101 arrow convention, 16, 65, 94
Progress Messages, 100 custom components, 78
Snapshots, 101 Time
Storing, 101 Simulation duration, 95, 97
Viewing, 101 Simulation end, 95, 97
Simulation settings, 94 Simulation start, 95, 97
Simulation start time, 95, 97 Time step, 95
Snapshots, 101 Trace lines, 108, 114, 115, 116, 117
Using, 97 Tutorials, 151
Solver, 95 Basic Tutorial: Modeling an RLC Circuit
Solver diagnostics, 98 and DC Motor, 15
Solver type, 95
Specifying Component Properties, 11 U
Standalone subsystem, 37 Units
State, 101

i Specifying Parameter Units, 24
Step size, 96

Stored results
From simulation, 101
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Vv

Variable scaling, 98
Variable time step, 95
Visualization, 108
transparency, 108
Visualization parameters
Settings, 108
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